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行政院及所屬各機關出國報告提要 

 

出國報告名稱：赴加拿大參加發電機組模型參數定期量測與確認訓練課程 

頁數 145 含附件□是■否 

出國計畫主辦機關／聯絡人／電話：臺灣電力公司／陳德隆／23667685 

出國人員姓名／服務機關／單位／職稱／電話： 

江榮城 綜合研究所 電機工程師 02-2360-1203 

廖清榮 

台灣電力公司 

綜合研究所 電機工程師 02-8078-2267 

出國類別：□1.考察 □2.進修 □3.研究 �4.實習 □5.其他： 

出國期間：99 年 08 月 19 日至 99 年 09 月 01 日    出國地區：加拿大 

報告日期：99 年 10 月 19 日 

分類號／目 

關鍵詞：電力系統(POWER SYSTEM),發電機參數(Generator parameters),

穩定度(Stability) 

內容摘要： 

一. 為貫徹 099 年第 06 次經營會議中，指示嚴謹修訂與確認發電機組模型參數

之標準作業程序，考慮經由訓練交流或其他方式取得正確量測技術。故為建

置發電機組控制系統參數驗證技術與貫徹經營會議決議事項，擬派員至加拿

大 PLI 公司進行發電機組模型參數定期量測與確認之應用研習，因 PLI 在上

述研究領域已有豐富之經驗，有鑑於此如何引進相關之系統分析技術，為本

計畫出國之主要任務。 

二. 加拿大 PLI 公司開發之電力系統分析商業套裝程式，電力系統動態安全分析

程式（Dynamic Security Assessment, DSA）具有 On-line 功能，擬至加拿大

PLI 研習 On-line 發電機參數測量之技術與可行性評估，以因應公司加速既

有發電機參數確認與更新工作，針對系統影響較大機組，優先進行 On-line

參數測量之構想。 

三. 針對今年 11 月本公司排定明潭電廠#3 機協和電廠#4 機兩部機組參數測量工

作中窒礙難行之項目提出討論，並尋求解決方案。 

 

 

 

 

本文電子檔已傳至出國報告資訊網（http://open.nat.gov.tw/reportwork）
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壹壹壹壹、、、、    心得與建議心得與建議心得與建議心得與建議 

一、 引進參數量測分析技術，建置參數驗證平台 

台電系統在經歷 1999 年 729 及 921 大範圍停電事件後，針對「如

何穩定電力系統」供電穩定度進行檢討與改善，為此本公司除落實電

力系統的基礎建設外，亦藉由系統模擬分析，建置特殊保護系統

(Special Protection System, SPS)以強化系統對擾動的免疫力，防止大

停電事故發生。然電力系統模擬分析之準確性與所建構系統模型之電

力參數息息相關，如何取得正確之系統參數，為系統分析準確與否之

必要條件。為貫徹 099 年第 06 次經營會議中，指示嚴謹修訂與確認

發電機組模型參數之標準作業程序，考慮經由訓練交流或其他方式引

進建立正確量測技術。為建置發電機組控制系統參數驗證技術與貫徹

經營會議決議事項，派員至加拿大 PLI 公司進行發電機組模型參數定

期量測與確認之應用研習，因加拿大 PLI 公司在發電機組參數量測已

有相當經驗，目前 WECC 之發電機參數量測部份委由 PLI 執行。其

量測設備及分析技術成熟，藉由技術合作或研究計畫，引進發電機量

測與分析技術，進而建立自主之參數驗證技術平台，以確保系統模擬

之真實性，進一步防範系統大停電事故之發生，為刻不容緩之要事。 

 

二、 訂定參數驗證準則，建立參數驗證機制 

美國西岸在 1996 年經歷了兩次嚴重大停電事故後，調查報告提

出了許多建議，其中強調發電機相關控制系統模擬模型及數據驗證之

重要性，並針對發電機參數進行普查與測試驗證建立相關之機制，以

便確保系統模擬之準確度，藉以採取有效之防範措施；為此北美電力

可靠度委員會（NERC）要發電設備所有權業者至少每 5 年須測試發

電機參數，修正發電機模型參數確保模擬準確度。台電系統並不如北

美等聯網大系統而是單獨系統，因此發電機組或發電機群對全系統比

重較重。各發電機控制系統，平常運轉情況下對系統事故發生時維持

系統穩定條件上所負之責任比較大。另台灣獨立發電業 (IPP)發展快
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速，直接參與連接至輸電幹線之發電業逐漸增加。因此，眾多之發電

機組其相關控制是否妥善，將直接會影響電力系統之穩定問題。藉由

參考國際上之標準訂定參數驗證準則，並建立發電機參數驗證機制為

刻不容緩之事項，以確保系統分析結果之可信度，針對系統弱點進一

步採取相關之措施，以增進系統穩定度。 

 

三、 藉由相量量測資料，驗證系統動態參數 

電力系統各母線電壓是電力系統的狀態相量，它是描述電力系統

最重要的基本物理量、檢驗運轉方式計算結果的最直接資料、評價電

網靜態運轉能力的基本指標、也是評價電網動態過程穩定性的最基本

指標。它們的大小和相位能直接反應電力系統的實際運轉狀態，特別

是節點電壓相位之間的關係，對即時判斷電力系統穩定性及進行相對

應穩定控制有著十分重要的意義。 

台電綜研所已利用同步相量量測技術，建置台電電網即時狀態監

視系統，進而評估系統監測性能與系統保護功能之應用，並且可做長

期電力系統電壓相量監錄，統計與分析電壓相量變化之趨勢，提供系

統規劃與運轉控制策略之應用。如何運用此資料進一步做為驗證系統

動態參數之準確性，為一重要且值得進一步探討之課題。 

 

四、 以 TSAT 之 UDM 建構參數，修正 PSSE 自訂 UDM 參數 

PLI 之 TSAT 軟體提供由使用者自訂動態參數之簡易操作介面，

包括調速機、勵磁機、電力系統穩定器、特性保護系統等，其操作介

面較 PSSE 之自訂動態參數介面簡單，不需另外再撰寫程式，易於進

行相關參數之修改與驗證。本公司目前之特殊保護系統（SPS）之決

策表，即利用此軟體模擬所得，其中非 PSSE 標準之動態參數模型，

即利用此軟體之 UDM 功能建構完成動態參數模型。 

本年度預計進行之明潭 G1 發電機參數量測工作，因其所使用之

勵磁機係以 PSSE 之自訂動態參數模型方式，取代原來未自定模組前

之 PSSE SCRX 標準模型。  
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在進行參數驗證先前模擬時，擬以 PSSE 標準之勵磁機模型取代

該模型，然並無法找到適合之模型加以取代，故乃以 TSAT 之 UDM

介面建構 PSSE 自訂勵磁機動態參數模型，以建構單機無限匯流排之

電力潮流基本案例，進行相關之參數模擬驗證分析。 

 

五、 以 PSSE 標準動態模型，取代 PSSE 之自訂模型 

本年度預計進行之協和 G4 發電機參數量測工作，其原本所使用

之勵磁機模型及電力系統穩定器模型均已更換，並以 PSSE 之自訂動

態參數模型方式，取代原來之模型，做為系統穩定度模擬之動態檔。 

在進行參數驗證事先模擬時，以 PSSE 標準之勵磁機模型 EXBAS

及電力系統穩定器模型 ST2CUT 取代，並以 TSAT 之 UDM 介面建構

PSSE 自訂勵磁機及電力系統穩定器動態參數模型，驗證與所建立之

PSSE 模型獲得一致之響應，並利用此模型建構單機無限匯流排之電

力潮流基本案例，進行相關之參數模擬驗證分析。 

 

六、 整合公司人力資源，推動參數驗證工作 

電力系統模擬分析之準確性與所建構系統模型之電力參數息息

相關，如何取得正確之系統參數（發電機、負載模型、輸電線路、勵

磁控制系統與調速器系統等參數），為系統分析準確與否之必要條件。 

藉由本出國計畫，赴加拿大 PLI 公司研習發電機組參數量測相關

技術，進而訂定發電機相關參數驗證程序，並建立自主之參數驗證技

術平台，然如何整合公司相關人力與資源，成立專責之驗證組織，具

實推動相關之驗證程序，以確保系統模擬之真實性，進一步防範系統

大停電事故之發生，為刻不容緩之課題。 

 

七、 整合產官學界資源，研發線上量測技術 

發電機組量測最主要的三個部分 :發電機、激磁機及原動機，

On-line 參數測量也是相同，由於這三個部分其時間響應速度不同，

因此必須分開考慮。本次前往 PLI 研習的重點之一就是借助 PLI 的經
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驗評估台灣電力系統建構 On-line 發電機參數測量之技術與可行

性，依據 PLI 馮博士的說明，PLI 目前並無執行發電機 On-line 參數

測量之經驗，但是他們也有注意其相關技術之發展。雖然目前 On-line

參數測量技術尚不足已取代 Off-line 參數測量，但是 On-line 量測具

有許多執行量測上的優點，值得整合產官學界資源，投入研究的一個

領域。 
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貳貳貳貳、、、、    出國緣由出國緣由出國緣由出國緣由：：：： 

為貫徹 099 年第 06 次經營會議中，指示嚴謹修訂與確認發電機

組模型參數之標準作業程序，考慮經由訓練交流或其他方式取得正確

量測技術。故為建置發電機組控制系統參數驗證技術與貫徹經營會議

決議事項，派員至加拿大 PLI 公司進行發電機組模型參數定期量測與

確認之應用研習，因 PLI 在上述研究領域已有豐富之經驗，有鑑於此

如何引進相關之系統分析技術，為本計畫出國之主要任務。 

一、 實施要領實施要領實施要領實施要領：：：：  

1. 學習 98 年 10 月本所測量觀二#3 機組參數驗證。 

2. 學習 98 年 10 月本所測量大林#4 機機組參數驗證。 

3. 學習 99 年 11 月本所排定明潭電廠#3 機組參數測量工作之

試驗前驗證方法。 

4. 學習 99 年 11 月本所排定協和電廠#4 機組參數測量工作之

試驗前驗證方法。 

5. 學習台灣電力系統建構 On-line 發電機參數測量之技術與

可行性評估。 

二、 預期成果預期成果預期成果預期成果：：：：  

1. 完成觀二#3 與大林#4 機組參數驗證成果報告。  

2. 完成 99 年 11 月即將進行之明潭電廠#3 與協和電廠#4 機

組參數試驗前驗證報告。 

3. 探討台灣電力系統建構 On-line 發電機參數測量之技術與

可行性評估。 
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參參參參、、、、    出國行程出國行程出國行程出國行程 

本出國計畫，自 99 年 08 月 19 日起，至 99 年 09 月 01 日止，前後十

四天，詳細行程如下表所示。 

 

日期 起訖地點 工作紀要 

08/19 台北－溫哥華  去程 

08/20~09/30 加拿大 PLI 參加「發電機組模型參數定

期量測與確認」訓練課程 

08/31~09/01 溫哥華－台北  返程 

 

肆肆肆肆、、、、    訓練課程介紹訓練課程介紹訓練課程介紹訓練課程介紹 

 

一、 針對 98 年 10 月本所測量觀二#3 機組參數驗證不清楚項

目進行實習。 

二、 針對 98 年 10 月本所測量大林#4 機機組參數驗證不清楚

項目進行實習。 

三、 針對今年 11 月本所排定明潭電廠#3 機組參數測量工作

之試驗前驗證進行實習。 

四、 針對今年 11 月本所排定協和電廠#4 機組參數測量工作

之試驗前驗證進行實習。 

五、 實習台灣電力系統建構 On-line 發電機參數測量之技術

與可行性評估。 
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伍伍伍伍、、、、    「「「「發電機組模型參數驗證技巧發電機組模型參數驗證技巧發電機組模型參數驗證技巧發電機組模型參數驗證技巧」」」」心得與建議心得與建議心得與建議心得與建議 

5.1 參數驗證項目 

5.1.1 概述  

本章利用加拿大 PLI 開發之 DSA tool 暫態模擬分析，對發電機相關參

數驗證程序與內容進行說明，包括發電機參數之量測、激磁系統參數之測

試與調速機之測試等章節，針對各項測試之程序與相關之問題如下所示可

依負載或設備分成兩型態類別，並分節進行探討暫態模擬檔(*.tsa)、電力

潮流資料檔(Power flow data)、動態資料檔(Dynamic data)、UMD(User 

Defined Models)、監視資料檔(Monitor data)、切換資料檔(Switching data)，

四種資料檔之模擬與驗證技巧，詳細建檔步驟、主要內容與實例應用，如

下面各節介紹。 

5.1.2 負載型態分類  

一、 發電機無載試驗   

1. 開回路特性(飽和)測試(Open circuit saturation test)  

2. 磁場短路(T′do)測試(T′do Test)  

3. 電壓調整器(AVR)步階響應測試  

4. V/Hz 限制器測試  

5. 緩衝壺(Dashpot)時間常數測試(僅適用於水力機組)  

 

二、 發電機有載試驗  

6. d 軸參數測試(MVAr 卸載試驗)  

7. q 軸參數測試(部份 MW 卸載試驗一)  

8. 部份負載卸載試驗(部份 MW、 MVar 卸載試驗二)  

9. 無效功率電流補償(電壓低垂，線路壓降補償)測試  

10. 最低勵磁限制器(Under(Minimum) Excitation Limiter)測試  

11. 最高勵磁限制器(Over(Maximum) Excitation Limiter)測試  

12. 電力系統穩定器(Power System Stabilizer, PSS)測試  

13. 部份卸載試驗(同發電機參數量測，但記錄不同參數信號)  

14. 調速機步階響應測試  
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15. 水始動時間測試(只有水力機組適用)  

16. 調速機速度低垂(droop)測試(僅適用於水力機組)  

17. 蒸氣室(Steam chest)時間常數測試(僅適用於汽渦輪機組)  

18. 無效功率容量測試  

5.1.3 設備型態分類 

一、 發電機參數量測 

1. 開回路特性(飽和)測試(Open circuit saturation test)  

2. 磁場短路(T′do)測試(T′do Test)  

3. d 軸參數測試(MVar 卸載試驗)  

4. q 軸參數測試(部份 MW 卸載試驗 1)  

5. 部份負載卸載試驗(部份 MW、 MVar 卸載試驗 2)  

 

二、 勵磁系統參數測試  

6. 電壓調整器(AVR)步階響應測試  

7. 無效功率電流補償(電壓低垂,線路壓降補償)測試  

8. V/Hz 限制器測試  

9. 最低勵磁限制器(Under(Minimum) Excitation Limiter)測試  

10. 最高勵磁限制器(Over(Maximum) Excitation Limiter)測試  

11. 電力系統穩定器(Power System Stabilizer, PSS)測試  

 

三、 渦輪與調速機測試  

12. 部份負載卸載試驗(同發電機參數量測，記錄不同參數信號)  

13. 調速機步階響應測試  

14. 水始動時間測試(只有水力機組適用)  

15. 調速機速度低垂(droop)測試(僅適用於水力機組)  

16. 緩衝壺(Dashpot)時間常數測試(僅適用於水力機組)  

17. 蒸氣室(Steam chest)時間常數測試(僅適用於汽渦輪機組)  

18. 無效功率容量測試  

 

5.2 建立暫態模擬檔(*.tsa) 

進行發電機組模型參數測試前之模擬或測試後之驗證程序，皆須建立

暫態模擬檔(*.tsa)，建立暫態模擬檔之資料可分必要資料(Mandatory data)
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與選舉資料(Optional data)兩種，必要資料一定要輸入，選舉資料只供參

考，不一定要輸入。如圖 5.1 所示暫態模擬檔流程與觀二#3 之 q 軸參數

測試實例，其他模擬驗證暫態模擬檔(*.tsa)實例，請参考公司發電機參數

量測小組編輯之『發電機組模型參數定期量測與確認作業程序書』。暫態

模擬檔(*.tsa)主要讀入電力潮流資料檔(Power flow data)、動態資料檔

(Dynamic data)、UMD(User Defined Models)、監視資料檔(Monitor data)、

切換資料檔(Switching data)四種資料檔。暫態模擬檔(*.tsa)之建檔與編輯步

驟流程於下面中說明。 

  

圖 5.1 暫態模擬檔流程與觀二#3 實例 

暫態模擬檔暫態模擬檔暫態模擬檔暫態模擬檔(*.tsa)建檔技巧與步驟流程建檔技巧與步驟流程建檔技巧與步驟流程建檔技巧與步驟流程 

一、 進入 TSAT 

File→New→Next 
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二、 Edit *.tsa 
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5.3 建立 Power flow data 檔(*.raw) 

暫態模擬檔在完成方案名稱、作者說明與設定最大發電機速率變動

後，首先，讀入電力潮流資料檔(*.raw)，如圖 5.2 所示電力潮流資料檔流

程與表 5.1 觀二#3 電力潮流資料實例(Takuan-G3-DX.raw)，其他模擬驗證

原始模擬檔(*.raw)實例，請参考『發電機組模型參數定期量測與確認作業

程序書』。詳細內容依據與建檔技巧分別於下面中說明。 

 

圖 5.2 電力潮流資料檔流程 
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表 5-1 觀二#3 電力潮流資料實例(Takuan-G3-DX.raw) 

 

建立建立建立建立 Power flow data 檔建檔技巧與步驟流程檔建檔技巧與步驟流程檔建檔技巧與步驟流程檔建檔技巧與步驟流程 

 

一、 於 PSAT 作業系統中建立單機無限匯流排的基本架構 

File → new project，按兩下 AC Bus→ Edit → Insert New Raw 建立無限

匯流排→確定→ Add，選擇 Generator，按 OK (在無限匯流排掛上發電

機)。 
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二、 設定發電機基本資料 

選擇新增的發電機後，按 Properties (設定發電機)，輸入下列資料後按確

定，按 Close。 

  

三、 建立單機匯流排 

 

 

Edit → Insert New Raw (建立單機匯流排)，根據下列資料: 
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1. 同步發電機 

• 額定容量 280 MVA 

• 額定電壓 16,500 V (16.5 kV) 

2. D 軸試驗在實際打開主斷路器前，發電機的實際運行狀況如下： 

• 有效功率輸出 8.28 MW  

• 無效功率輸出 -47.09 MVAr(欠勵) 

• 發電機端電壓 16.10 kV ( 16.1/16.5 = 0.9758 p.u.) 

按確定後，按 Add，選擇 Generator，按 close 

四、 新增的發電機設定 

選擇新增的發電機後按 Properties (設定發電機)，輸入下列資料後按確

定，按 Close。Base MVA 一定是用發電機的額定容量。(0.0015 及 0.192) 
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五、 建立變壓器資料  

接著輸入單機及無限匯流排間的變壓器，按兩下 Adjustable 

Transformer Edit → Insert New Row (建立變壓器)。按兩下 INF BUS 進

入設定畫面後，輸入下列資料後，按確定。 
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按確定後，Solution->Solve 執行電力潮流計算，計算完後，File→Save 

Powerflow 儲存 pfb 檔。 

 

 

5.4 建立動態資料檔(*.dyn) 

暫態模擬檔之內容即為『發電機組模型參數定期量測與確認』計畫之

主要測量驗證之目的，包括發電機參數、激磁系統參數、調速機與 PSS

等參數。如表 5-2 所示為觀二#3 動態檔實例(Takuan-G3-PSSE.dyn)，圖 5-3

所示為動態資料檔之建檔流程圖。其他模擬驗證動態資料檔(*.dyn)實例，

請参考附件 11a3-Talin-G4 與 Takuan-G3 模擬驗證檔 dyn。詳細內容依據

與建檔技巧將分別於下面各節中說明。以上資料檔之建立操作手冊。 

表 5-2 觀二#3 動態檔實例(Takuan-G3-PSSE.dyn) 

/                T'do  T"do  T"qo   H      D   Xd     Xq   X'd     X"d    Xl   S1.0   

S1.2 /  

/0703 'GENSAL' 3  13.9  .051  .112   4.575 1   1.08  .64   .29    .203   .1   .136   .463 / 

Database  

/0703 'GENSAL' 3  13.9  .051  .112   4.685 1   1.08  .64   .29    .203   .1   .136   .463 / 

Document  

/  

 0703 'GENSAL' 3  15.4  .035  .05    5.54   1   1.21  .41   .24    .16    .1  .215   .404  / 

Validated  

/  

/              I UEL VOS  Tr    Vimax  Vimin  Tc    Tb    TC1  Tb1  Ka     Ta     

Vamax   
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Vamin   Vrmax  Vrmin  Kc    Kf   Tf  KLr  ILr   

 703 'ESST1A'  3 3   1    0.02  15.0  -15.0   2.99  14.95 1.0  1.0  500.0  0.003  15.0  -15.0    

5.1   -4.9    0.09  0.0  2.0 0.0  999.0  /Validated Takuan - Unitrol 5000 Settings  

/  

/              I  Tr    Vimax  Vimin   Tc    Tb     Ka   Ta     Vrmax    Vrmin   Kc    

Kf   Tf  

/ 0703 'EXST1'  3  0.02  15.0  -15.0  2.99  14.95  500  0.003    5.1     -4.9    0.09  0.0  2.0 / 

Validated Takuan - Unitrol 5000 Settings  

/ 0703,'SCRX',3,.607,.824,192.2,.011,-4,4.4,0,10/ TAKUAN #3  Existing  

/  

/IBUS          I  IC1   ICS2  M  N  Tw1   Tw2  T6   Tw3  Tw4  T7   KS2   KS3  T8   

T9   KS1   T1    T2    T3     T4     VSMX   VSMN/  

0703  'PSS2A'  3  1  0  3  0  5  1  2.0   2.0  0.0  2.0  0.0  2.0  0.25  1.0  0.5  0.1  12.0  

0.12  0.04  0.28   0.04   0.1   -0.1/  

/  

/               I  TREG    REG      KP      KI    KD    TA    TB    VELMX   

VELMN   GATMX  GATMN  TW    PMAX  PMIN    D    G0     G1    P1   G2    P2    

P3 /  

 0703 'WPIDHY'  3   1.5   -0.031   9.5    1.14   2.0   0.1  0.05  0.045   -0.045     1.0    

0.0   1.48   1.0   0.0    0.0   0.14  0.35  0.31  0.72  0.75  0.86  / Validated by 40 MW Online 

Step  

/ 0703 'WPIDHY'  3   1.5    -0.031   8.5    1.9     2.0   0.1  0.05  0.045   -0.045   1.0    

0.0   1.48   1.0   0.0    0.0   0.14  0.35  0.31  0.72  0.75  0.86  / Validated by Load Rejection 1  

/ 0703 'WPIDHY'  3   1.5    -0.031   8.5    1.9     2.0   0.1  0.05  0.045   -0.045   1.0    

0.0   1.91   1.0   0.0    0.0   0.14  0.35  0.31  0.72  0.75  0.86  / Full Load  

/  

/0703,'HYGOV',3,.056,.328,6,.05,.5,.167,.893,0,1.5,1.2,0,.08/ TAKUAN #3 Existing one (Full Load)  

/0703,'HYGOV',3,.056,.328,6,.05,.5,.167,.893,0,1.16,1.2,0,.08/ TAKUAN #3 Existing one  (Tw Test Laod)  

/                R    r   Tr Tf  Tg Velm Gm Gn Tw At   Dt Qnl     

/0703,'HYGOV',3,.0386,.13, 8,.05,.5,.04,.92,0,1.5,1.18,0,.14/ TAKUAN #3 Validated  

/  

/0703,'IEEEST',3,3,0,0,0,0,0,0,0,0,.02,.11,.33,.5,.5,-.5,.05,-.05,0,0/ TAKUAN #3  

/  

20000  'GENCLS'  1  9999.6   99.2 / 

 

1.  建立建立建立建立 發電機參數發電機參數發電機參數發電機參數

2.設定激磁系統參數設定激磁系統參數設定激磁系統參數設定激磁系統參數

3.讀入調速機與水輪機參數讀入調速機與水輪機參數讀入調速機與水輪機參數讀入調速機與水輪機參數

4.讀入讀入讀入讀入 PSS 模型參數模型參數模型參數模型參數

1.  建立建立建立建立 發電機參數發電機參數發電機參數發電機參數1.  建立建立建立建立 發電機參數發電機參數發電機參數發電機參數

2.設定激磁系統參數設定激磁系統參數設定激磁系統參數設定激磁系統參數2.設定激磁系統參數設定激磁系統參數設定激磁系統參數設定激磁系統參數

3.讀入調速機與水輪機參數讀入調速機與水輪機參數讀入調速機與水輪機參數讀入調速機與水輪機參數3.讀入調速機與水輪機參數讀入調速機與水輪機參數讀入調速機與水輪機參數讀入調速機與水輪機參數

4.讀入讀入讀入讀入 PSS 模型參數模型參數模型參數模型參數4.讀入讀入讀入讀入 PSS 模型參數模型參數模型參數模型參數
 

圖 5-3 動態資料檔流程圖 

經對暫態模擬檔所須要參數內容，進行整理分類，完成表 5-3 所示模

擬動態資料檔(.dyn)所須要參數項資料，期待能加強初學者學習成效。 
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表 5-3 模擬動態資料檔(.dyn)須要參數項 

所需資料檔與驗證參數 參數項 

試驗項目 發電機 勵磁機 調速機 PSS 有無負載 主要驗證參數 

1.磁場短路試驗 √ UDM × × 無載 T′do(d 軸開路時間常數) 

2. AVR 步階響應試驗 √ √ × × 無載 TE(TR)、TA、KA(KR) 

3. d 軸測試(卸虛功率) √ UDM √ √ 有載 Xd、、X′d、X′′d、T′do、T′′do、

kd 

4. q 軸測試(卸時功率) √ UDM √ √ 有載 Xq、X′q、T′qo、H、Gov 

5.水始動時間測試

WSTC 

√ √ √ √ 有載 Tw(水啟動時間常數) 

6.蒸氣室時間常數測試

SCTC 

√ √ √ √ 有載 T4(高壓汽機反應時間常數) 

7.部份卸載試驗 LD √ √ √ √ 有載 H、R、Tg、QNL、調速機參數 

8.調速機速度低垂測試

LDC 

√ √ √ √ 有載 Xcomp、勵磁機參數 

9.電力系統穩定器 PSS √ √ √ √ 有載 PSS 參數 

註： 

1. 磁場短路試驗與 d 軸試驗所求得之 T′do 相同，皆為開路下條件下求得。 

2. 在 AVR 步階響應試驗中最主要之參數為勵磁機反驗時間 TE。在某些勵磁機常用

TR 來取代 TE，在 AVR 步階響應試驗中，主要功能為用來表達 If響應速度與大小。 

 

5.5 UMD 檔(*.dat) 

UMD 檔是使用者依功能需要自建之動態檔，為了與*.dyn 動態資料檔

區別，擴展檔名採*.dat。以觀二#3 機磁場短路實驗的 User Define Model

之檔名 Takuan-G3-FSC-EXUDM.dat 為例，其動態資料檔建檔流程與觀二

#3 UMD檔內容如圖 5-4 所示。詳細內容依據與建檔流程如下面推導說明。 

1. 建立建立建立建立UMD新檔新檔新檔新檔

2. 加入加入加入加入 Model data

3. 輸入輸入輸入輸入Block Type與與與與Parameter

4. 建立建立建立建立Input Model

5. 建立建立建立建立End Block

6. Link與與與與Save

1. 建立建立建立建立UMD新檔新檔新檔新檔1. 建立建立建立建立UMD新檔新檔新檔新檔

2. 加入加入加入加入 Model data2. 加入加入加入加入 Model data

3. 輸入輸入輸入輸入Block Type與與與與Parameter

4. 建立建立建立建立Input Model4. 建立建立建立建立Input Model

5. 建立建立建立建立End Block5. 建立建立建立建立End Block

6. Link與與與與Save6. Link與與與與Save   

[DSA 8.0 UDM]

/UD EXC STARTS
703,'EXCUDM','3 '/DEVICE 
IDENTIFICATION

0/REMOTE BUS
0 0 0/REMOTE BRANCH
/BLOCK DATA STARTS

1,'YREAD','DLB','udmyread','Takuan-G3-
FSC-VF.txt'/
2,'EMESOUT','E34',999.0,-999.0,1.0,0.0,0.0/

/BLOCK DATA ENDS
1,2/BLOCK INTERCONNECTION
1,'REF',1.0, 1,'TIME',1.0/BLOCK INPUT
/UD EXC ENDS

 

圖 5-4 動態資料檔流程與觀二#3 UMD 檔內容 
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觀二觀二觀二觀二#3 機磁場短路實驗的機磁場短路實驗的機磁場短路實驗的機磁場短路實驗的 User Define Model 建檔技巧與步驟流程建檔技巧與步驟流程建檔技巧與步驟流程建檔技巧與步驟流程 

注意事項 1：記得將 DSA Tools 9.0\MODEL\udmyread.dll 拷貝至

\DSATools_9 \Tsat\bin 下，才能在 TSAT 下執行。 

注意事項 2：udmyread.dll，該模型檔之功能為將 UMD 檔 Parameter-List

填入隨時間而變之資料轉為動態陣列之運算，作為下一運算方

塊圖之輸入，只要輸入資料格式正確可運用於任何發電機組。 

 

一、 建立 UMD 新檔 

File->New，按 OK，選擇 Exciter 後按右鍵選擇 Add Model 

 

     

 

二、 填入觀二#3 (Bus 703) 3 號機(ID 3)，按 OK。 
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三、 輸入 Block Type 與 Parameter-list 

打開 Control Block，選擇最後一個 Dynamically Linked Control Block，

於 Block Type 輸入 udmyread，Parameter-list 輸入實驗量測檔

akuan-G3-FSC -VF.TXT(實測檔)，按 OK。 

 

 

 

四、 建立 Input Model 

分別在 Input 中選擇 REF, Time 加入 Model，Gain 都選 1 
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五、 建立 End Block 

在 End Block 中按兩下增加輸出，輸入 Vrmax 999，Vrmin -999，ETV = 1 

 

 

六、 Link 與 Save 

按 Link 後，開始連結 

 

 

連接完後 

 

 

 

File->Save Takun3FSC.dat 

其他 UDM 動態資料檔(*.dat)實例，請参考附件附件 11c--Takuan-G3 

與 Talin-G4(UDM)比較.ppt。 
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5.6 建立監視資料檔(*.mon) 

監視資料檔是使用者依模擬驗證與撰寫報告所需要設定監視資料內

容，擴展檔名採*.mon。圖 5-5 所示為建檔流程圖，其他監視資料檔(*.mon)

實例，如表 5-4 所示為觀二#3 監視資料檔 (Takuan-G3.mon)與大林

#4(Talin-G4.mon)監視資料檔內容。 

表 5-4 觀二#3 與大林#監視資料檔內容 

[TSAT 7.X Monitor]

{Additional Quantities}

generator, Mechanical torque

generator, Field current

{End Additional Quantities}

{Generator}

1104, '4'

{End Generator}

{Bus}

1104

{End Bus}

{UDM}

1104, 'GOVUDM', '4', 'Gain'

1104, 'GOVUDM', '4', 'YREAD'

1104, 'GOVUDM', '4', 'T20'

1104, 'PSSUDM', '4', 'YREAD'

1104, 'PSSUDM', '4', 'TW1'

1104, 'PSSUDM', '4', 'KS2  T7'

1104, 'PSSUDM', '4', 'TW2'

1104, 'PSSUDM', '4', 'TW3'

1104, 'PSSUDM', '4', 'KS3'

1104, 'PSSUDM', '4', 'T8 T9'

1104, 'PSSUDM', '4', 'T9-2'

1104, 'PSSUDM', '4', 'T9-3'

1104, 'PSSUDM', '4', 'T9-4'

1104, 'PSSUDM', '4', 'T9-5'

1104, 'PSSUDM', '4', 'SUM2'

1104, 'PSSUDM', '4', 'KS1'

1104, 'PSSUDM', '4', 'T1 T2'

1104, 'PSSUDM', '4', 'T3 T4'

1104, 'PSSUDM', '4', 'VSTLIM'

1104, 'EXCUDM', '4', 'SUM'

1104, 'EXCUDM', '4', 'END E6'

{End UDM}

[TSAT 8.X Monitor]

{Additional Quantities}

generator, Mechanical torque

generator, Field current

{End Additional Quantities}

{Generator}

703, '3 '

{End Generator}

{Bus}

703

{End Bus}

{UDM}

703, 'GOVUDM', ' 3', 'BLK1    '

703, 'GOVUDM', ' 3', 'BLK2    '

703, 'GOVUDM', ' 3', 'BLK4    '

703, 'GOVUDM', ' 3', 'BLK3    '

703, 'PSSUDM', ' 3', 'Input'

703, 'PSSUDM', ' 3', 'Output'

{End UDM}

Takuan-G3.mon Talin-G4.mon

[TSAT 7.X Monitor]

{Additional Quantities}

generator, Mechanical torque

generator, Field current

{End Additional Quantities}

{Generator}

1104, '4'

{End Generator}

{Bus}

1104

{End Bus}

{UDM}

1104, 'GOVUDM', '4', 'Gain'

1104, 'GOVUDM', '4', 'YREAD'

1104, 'GOVUDM', '4', 'T20'

1104, 'PSSUDM', '4', 'YREAD'

1104, 'PSSUDM', '4', 'TW1'

1104, 'PSSUDM', '4', 'KS2  T7'

1104, 'PSSUDM', '4', 'TW2'

1104, 'PSSUDM', '4', 'TW3'

1104, 'PSSUDM', '4', 'KS3'

1104, 'PSSUDM', '4', 'T8 T9'

1104, 'PSSUDM', '4', 'T9-2'

1104, 'PSSUDM', '4', 'T9-3'

1104, 'PSSUDM', '4', 'T9-4'

1104, 'PSSUDM', '4', 'T9-5'

1104, 'PSSUDM', '4', 'SUM2'

1104, 'PSSUDM', '4', 'KS1'

1104, 'PSSUDM', '4', 'T1 T2'

1104, 'PSSUDM', '4', 'T3 T4'

1104, 'PSSUDM', '4', 'VSTLIM'

1104, 'EXCUDM', '4', 'SUM'

1104, 'EXCUDM', '4', 'END E6'

{End UDM}

[TSAT 8.X Monitor]

{Additional Quantities}

generator, Mechanical torque

generator, Field current

{End Additional Quantities}

{Generator}

703, '3 '

{End Generator}

{Bus}

703

{End Bus}

{UDM}

703, 'GOVUDM', ' 3', 'BLK1    '

703, 'GOVUDM', ' 3', 'BLK2    '

703, 'GOVUDM', ' 3', 'BLK4    '

703, 'GOVUDM', ' 3', 'BLK3    '

703, 'PSSUDM', ' 3', 'Input'

703, 'PSSUDM', ' 3', 'Output'

{End UDM}

Takuan-G3.mon Talin-G4.mon
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1.  Additional Quantities

2.設定設定設定設定Generator data

3.設定設定設定設定 Bus data

4.讀入讀入讀入讀入 UDM 監視內容監視內容監視內容監視內容

1.  Additional Quantities

2.設定設定設定設定Generator data2.設定設定設定設定Generator data

3.設定設定設定設定 Bus data3.設定設定設定設定 Bus data

4.讀入讀入讀入讀入 UDM 監視內容監視內容監視內容監視內容4.讀入讀入讀入讀入 UDM 監視內容監視內容監視內容監視內容
 

圖 5-5 監視資料檔(*.mon)流程圖 

 

詳細內容依據與建檔流程如下面推導說明。 

一、 建立*.mon 

按 Create 產生.mon 檔，選擇 BUS→Add，將觀二#3 機所在匯流排加入後

按 OK。  

 

  

 

二、 選擇監看 Voltage Frequency, Voltage Frequency Rate 按 OK，儲存

MON 檔。 
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5.7 建立切換資料檔(*.swi) 

切換資料檔(Switching data)是使用者依模擬驗證與撰寫報告所需要設

定取樣密度、分析時間與印出解析度，擴展檔名採*.swi。圖 5-6 所示為

建檔流程圖與觀二#3 磁場短路測試切換檔內容，其他監視資料檔(*.swi)

實例，請參考附件 11a6-Talin-G4 與 Takuan-G3 模擬驗證檔 swi.ppt。詳細

內容依據與建檔流程如下面推導說明。 

1.設定總模擬時間設定總模擬時間設定總模擬時間設定總模擬時間

2.設定繪圖解析度設定繪圖解析度設定繪圖解析度設定繪圖解析度

3.設定輸出資料解析度設定輸出資料解析度設定輸出資料解析度設定輸出資料解析度

4.設定運算邏輯設定運算邏輯設定運算邏輯設定運算邏輯(RK4)

1.設定總模擬時間設定總模擬時間設定總模擬時間設定總模擬時間

2.設定繪圖解析度設定繪圖解析度設定繪圖解析度設定繪圖解析度2.設定繪圖解析度設定繪圖解析度設定繪圖解析度設定繪圖解析度

3.設定輸出資料解析度設定輸出資料解析度設定輸出資料解析度設定輸出資料解析度3.設定輸出資料解析度設定輸出資料解析度設定輸出資料解析度設定輸出資料解析度

4.設定運算邏輯設定運算邏輯設定運算邏輯設定運算邏輯(RK4)4.設定運算邏輯設定運算邏輯設定運算邏輯設定運算邏輯(RK4)
    

DESCRIPTION FSC TEST /

SIMULATION FOR 39.98333 SECONDS /

PLOT           10 TIME STEPS /

REPORT         10 TIME STEPS /

STEP SIZE      0.001 SECONDS /

INTEGRATION    RK4 /

NOMORE /

END /

Takuan-G3-FSC.swi

DESCRIPTION FSC TEST /

SIMULATION FOR 39.98333 SECONDS /

PLOT           10 TIME STEPS /

REPORT         10 TIME STEPS /

STEP SIZE      0.001 SECONDS /

INTEGRATION    RK4 /

NOMORE /

END /

Takuan-G3-FSC.swi

 

 

圖 5-6 切換資料檔(*.swi)流程圖與觀二#3 磁場短路測試切換檔內容 

 

SWI 檔建檔技巧與步驟流程檔建檔技巧與步驟流程檔建檔技巧與步驟流程檔建檔技巧與步驟流程 

按 Create 產生 SWI 檔，按 OK 編輯 Contingency，按 Add 建立 Switching 
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Commands→ OK，再按 OK，儲存 SWI 檔。 

 

  

 

 

5.8 大林勵磁機之勵磁機時間參數 TE之實測估算實例建議 

由於大林#4 機採用無刷勵磁機，主發電機的激磁量不可量測，因此，

可藉由量測勵磁機之勵磁機的激磁電壓與激磁電流間接推算估算相近主

發電機的激磁量模擬曲綫。下面為大林#4 勵磁機之勵磁機時間參數 TE之

實測估算實例演算過程。 

一、 估算法概述 

根據 PLI 的經驗，Vef 與 Ief存在如圖 5-7 所示之響應增益關係。 

 

 

圖 5-7  Vef 與 Ief 響應增益關係 

由電壓調整器(AVR)步階響應測試中取出實測 Vef 與 Ief，以實測 Vef

當做輸入，製作一個 UDM 模型，利用調整 TE以模擬輸出 Ief，然後找出

跟實測 Ief 最相似之 Ief，對應該 Ief 之 TE即為所求之勵磁機時間常數 TE。 
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二、 建立 UDM 模型檔 

首先於 dsa-tool 之 UDM  Editor 作業模式下開啟一新檔，取名為

Talin-G4-TE-UDM.dat ，其完成後之響應增益方塊圖與參數設定值，如圖

5-8 所示，詳細架構說明如下。 

 

 

圖 5-8 響應增益方塊圖與參數設定值 

圖 5-8 中第一個增益方塊為 Data for control type，選 Dynamically 

Linked control Block (DLB)，其中有三個空格，第一個空格為 Block Name，

可任意命名，第二為 Block Type，填入自建之運算模式 udmyread.dll，該

模型檔之功能為將第三個空格Parameter-List填入隨時間而變之Vef資料轉

為動態陣列之運算，作為下一運算方塊圖之輸入，第三個空格為

Parameter-List，讀入實測 Vef (Talin-TE-VF.txt)。 

圖 5-8 中第二個增益方塊為依據圖 5-7  所示 Vef 與 Ief響應增益關係，

選定 Data for control type 中較合適之 Lead/Lag With Limits (LL)模型，其中

Block Name 可任意命名，Parameter-List 依圖 5-7 所示 Vef與 Ief 響應增益

關係，微調 k 與 TE(T2)，其他無關參數值設為零。註：k 參數用來調 Ief響

應上下 offset，典型值為 1，T2就是 TE值，用來調 Ief 響應高度，該例驗證

出之 TE值為 0.935。圖中第三個增益方塊為 End Block 為激磁機模型，我

們的目的在 Ief 響應輸出，不是圖 5-8 之 EFD輸出，故參數值可為任意值。

最後將檔名儲存成 Talin-G4-TE-UDM.dat。 
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三、 建立暫態模擬檔(*.tsa) 

先輸入大林#4 機暫態模擬檔 Talin4-EX5-TE.tsa，在 Dynamic Data File 

利用 Browse 選 Talin-G4-TE-UDM.dat 取代原有模擬的激磁機，接著選擇

Monitor Data→ Edit → UDM→…→ BLK1，如此就可以輸出 UDM 模型

BLK1 的資料，在 Talin4-EX5-TE.tsa 按 Run→Basecase Analysis 後按 View 

Results，選擇 Output of EXCUDM block 繪出結果，接著按 Data→Import 

TXT 選擇輸入實測 Ief (Talin-TE-IF.txt)做為比較→ OK→是，將輸入資料繪

出與模擬結果比較以調整 TE 值(本例 TE 值為 1)，(注意: Bus 及 ID 要與掛

上去的發電機相同)。詳細推導如圖 5-9 ~圖 5-11 所示說明。 

 

圖 5-9 選 Talin-G4-TE-UDM.dat 取代原有模擬動態檔 
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圖 5-10 選擇 Output of EXCUDM block 繪出結果 

TE(實測)

TE=0.5(模擬)

TE=0.935(模擬)

10

15

20

25

30

35

40

0 2 4 6 8 10 12 14 16 18 20

時間 (秒)

Ie
f 

(A
)

TE(實測)

TE=0.5(模擬)

TE=0.935(模擬)

 

圖 5-11  Ief 實測與模擬值比較(k=0.935) 

 

由圖 5-11 所示 Ief 實測與模擬值比較得知當 k=0.935 與 TE=0.935，Ief

實測與模擬值最為相近，故可視為參數 TE驗證結果。 
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陸陸陸陸、、、、    大觀大觀大觀大觀#3 發電機參數實測分析發電機參數實測分析發電機參數實測分析發電機參數實測分析 

6-1 發電機基準值     

表 6-1 與圖 6-1 為大觀三號機之發電機組基準值與其模型(GENSAL)

參數內容。這些基準值由發電機銘牌額定數據及現場實驗結果導出。此發

電機組配備靜態激磁系統。激磁電壓與激磁電流基準值皆由無載飽和實驗

結果導出。發電機激磁電流基準值定義為發電機端電壓之氣隙線達額定值

時的激磁電流。發電機激磁電壓基準值定義為激磁電流基準值與轉子繞組

在無載飽和實驗中的平均電阻之乘積。 

 

表 6-1 發電機基準值 

機組功率機組功率機組功率機組功率

(MVA) 

定子電壓定子電壓定子電壓定子電壓

(kV) 

定子電流定子電流定子電流定子電流

(Amps) 

激磁激磁激磁激磁電壓電壓電壓電壓

(Volts) 

激磁激磁激磁激磁電流電流電流電流 

(Amps) 

280 16.5 9798 102.8 
(1)

 570 

註: (1) 校正到滿載運行時對應的轉子繞組溫度。  

 

圖 6-1 凸極式發電機模型參數內容 
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6-2 模型參數驗證摘要     

表 6-2~表 6-4 為大觀三號機實測後之同步發電機模型參數、激磁系統

模型參數與水輪機及調速機模型參數驗證摘要，包含 (PSS/E 模型、台電

各單位現有採用數據、實測驗證後數據與參數驗證方法說明，詳細比較如

下列各表。 

表 6-2 同步發電機模型參數 

模型參數 

(PSS/E 模型

GENSAL) 

現有數據 
 

(1) 

驗證後數據 
(2) 

參數驗證方法說明 

電抗(標么 pu) 

Xd (不飽和) 1.08 1.21 

X'd (不飽和) 0.29 0.24 

X"d (不飽和) 0.203 0.16 

 

d 軸試驗比對實測與模擬值擬和求得 

(參閱 6-5 d 軸參數測試) 

Xq (不飽和) 0.64 0.41 

X'q (不飽和) - - 

X"q (不飽和) - - 

 

q 軸試驗比對實測與模擬值擬和求得 

(參閱 6-6 q 軸參數測試) 

Xl 0.1 0.1 
(漏抗不可測，採用採用原廠提供設定值 

(但注意 Xl < X"d = Xl + …) 

X2 - - 採用原廠提供設定值 

X0 - - 採用原廠提供設定值 

繞組電阻值 (歐姆) 

定子繞組 

(每相) 
- - 

用廠商的值 

轉子繞組 - 0.1803 
(3)

  

激磁繞組時間常數(秒) 

T'do 13.9 14.8 
(4)

 

T"do 0.051 0.035 

d 軸試驗比對實測與模擬值擬和求得 

(參閱 6-5 d 軸參數測試) 

T"qo 0.112 0.05 
q 軸試驗比對實測與模擬值擬和求得 

(參閱 6-6 q 軸參數測試) 

其它參數 

H (kW•Sec/ 

kVA) 
4.575 5.54 

q 軸試驗，發電機頻率變化斜率計算值或

比對實測與模擬值之擬合結果(參 6-6 節) 

D 1.0 1.0 
根據 PLI 經驗，D 值水力發電機組設為 0，

火力發電機組設為 0.9 

S1.0 0.136 0.215 

S1.2 0.463 0.404 

開路特性(飽和)測試得到(參閱 6-3 開路飽

和試驗) 
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註:  

(1) 現有電網運行規劃模型數據 

(2) 由試驗驗證的發電機模型數據 

(3) 發電機滿載時測得的轉子繞組的電阻值並假設碳刷壓降為 1.5 伏   

(4) 校正到發電機滿載時對應的轉子繞組溫度 

 

表 6-3  激磁系統模型參數 

模型參數 驗證後數據 
(1)

 參數驗證方法說明 

激磁系統模型參數(PSS/E 模型 ESST1A) 

UEL 3 
UEL 比對 ABB Unitrol 5000 模型及 ESST1A 得到

= 3 % (參閱 6-7 電壓調整器步階響應測試) 

VOS 1 
VOS 比對 ABB Unitrol 5000 模型及 ESST1A 得到

= 1 % (參閱 6-7 電壓調整器步階響應測試) 

TR 0.02 TR  = ABB TR (典型值) 

VIMAX 15 

VIMIN -15 

參閱 6-7 電壓調整器步階響應測試 

TC 2.99 TC = ABB TC1 

TB 14.95 TB = ABB TB1 

TC1 1.0 TC1 = ABB TC2 

TB1 1.0 TB1 = ABB TB2 

KA 500 KA = ABB 之 KR 整流器壓降係數 

TA 0.003 TA = ABB TS  整流橋反應時間 

VAMAX 15 

VAMIN -15 

參閱 6-7 電壓調整器步階響應測試 

VRMAX 5.1 

VRMIN -4.9 

VRMAX 可用 Vr 變化觀察，或用激磁機規格計算

(參閱 6-7 電壓調整器步階響應測試) 

KC 0.09 KC 典型值(整流係數) 利用 ToolBox(參閱 6-7) 

KF 0.0 KF = 0 沒有 feed back 

TF 2.0 TF 因為 KF = 0 ， TF的值沒有作用 

KLR 0.0 
KLR = ABB KID，因為 ILR = 999 ， KLR 的值沒有

作用 

ILR 999 ILR = 999  除去 IFD的作用(等於 IFD無輸入) 

無效功率電流補償(PSS/E 模型 COMP) 

XE 0.0(2) 
XE  利用線路壓降補償測試， XE = dV/Is  Is 斷

開前的定子電流(參閱 6-8)  

註: 

(1) 經由模擬與電壓調整器步階響應試現場試驗結果比對驗證得出 

(2) 由模擬無效功率電流補償(電壓低垂，線路壓降補償)測試結果比對驗證得出，並

與 UNITROL-5000 控制器實際設定值相符 
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表 6-4 水輪機及調速機模型參數 

模型參數 

(PSS/E 模型 

WPIDHY) 

 

PSS/E 典型值 

 

驗證後參

數 
(1)

 

參數驗證方法說明 

TREG 0.05 ≤ TREG < 5.0 1.5 TREG  (1.0~1.5 間)參閱 6-10 節 

REG 0. < REG < 0.1 -0.031 REG = droop = R 參閱 6-9 節 

KP 

0. ≤ KP ≤ 10. 
8.5 

KP  (LR TEST, gov step response 

test 擬合) 參 6-10 節 

KI 

0. ≤ KI ≤ 5. 
1.9 

KI   (LR TEST, gov step response 

test 擬合) 參 6-10 節 

KD 
0. ≤ KD ≤ 5. 

2.0 
KD  (LR TEST, gov step response 

test 擬合) 參 6-10 節 

TA 4. × DELT < TA ≤ 2. 0.1 TA  (廠家給定值) 

TB 
4. × DELT < TB ≤ 2. 0.05 TB  (廠家給定值) 

VELMX 
0. ≤ VELMX ≤ 1. 0.045 VELMX 同汽輪機 Uo 參 6-10 節 

VELMN 
–1. ≤ VELMN ≤ 0. -0.045 VELMN 同汽輪機 Uc 參 6-10 節 

GATMX 

0.3 ≤ GATMX ≤ 1. 
1.0 

GATMX 水門開度 = 1 表示直

接 pass 

GATMN 
0. ≤ GATMN ≤ 0.5 

0.0 
GATMN 水門開度= 0 表示直接
pass 

TW 
0.5 ≤ TW ≤ 3.0 

1.92 
(2)

 
TW用水門開度輸入(1-TWs) 

/(1+TWs)輸出比對 Pm(Pe) 

PMAX 

0.5 ≤ PMAX ≤ 1.1 
1.0 

PMAX 功率限制 = 1 表示直接

pass 

PMIN 

0. < PMIN < 0.5 
0.0 

PMIN    功率限制 = 0 表示直接

pass 

D 
0. < D < 0.5 0.0 D = 0 表示不考慮水輪機阻尼 

G0 
G0 ≤ G1 ≤ G2 0.14 

G1 
G0 ≤ G1 ≤ G2 0.35 

P1 
P1 ≤ P2 ≤ P3 0.31 

G2 
G0 ≤ G1 ≤ G2 0.72 

P2 
P1 ≤ P2 ≤ P3 0.75 

P3 
P1 ≤ P2 ≤ P3 0.86 

根據測試時記錄得到輸出功率與閥門開

度之數據，如表 6-6。 

發電機輸出功率 (P) 

MW pu 

閥門開度 

Gate (%) 

0 0 14 

86.9 0.310357 34.8 

167.8 0.599286 58.8 

209 0.746429 72 

240 0.857143 92.5  

註:   

(1) 由試驗驗證的水輪機與調速機之模型數據，僅適用于發電運行 

(2) 校正到對應於滿負荷時的水門開度（92%） 
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6-3 開路飽和試驗(Open circuit saturation test)     

一、 測試說明 

開路特性(飽和)測試在發電機組運轉在額定轉速沒有負載(主斷路器

開路)情況下進行。對於本發電機之靜態激磁系統，在磁場閃激後，發電

機端電壓從接近額定值先被降至使發電機端電壓降至額定電壓的 30%以

下，直至激磁系統尚可維持正常運行的最低機端電壓。然後機組磁場電壓

可以向高調昇，使發電機端電壓逐步上升(每個步階約 1000V)，直到機組

最大的容忍極限，表 6-5 為開路特性(飽和)測試結果。 

 

表 6-5 開回路飽和測試數據 

發電機端電壓

V t(kV) 

發電機端電壓 

V t(pu) 

激磁場電流  

IF(A) 

發電機轉速

(Hz) 

3.07 0.18607 103.7 60.00 

4.08 0.24738 139.5 59.80 

5.12 0.31057 175.9 59.68 

5.98 0.36255 206.1 59.48 

7.03 0.42596 244.5 60.28 

8.03 0.48659 278.2 60.10 

8.94 0.54202 316.4 59.86 

10.02 0.60728 354.6 60.38 

11.10 0.67295 399.5 59.88 

11.96 0.72486 442.2 59.98 

12.95 0.78500 486.0 60.20 

14.03 0.85019 535.6 60.22 

14.98 0.90788 589.9 59.88 

15.81 0.95821 651.1 60.08 

16.41 0.99469 689.9 60.34 

17.04 1.03271 733.2 60.32 

 

二、 測試目的 

此測試目的被用於確定 

1. 發電機激磁電流基準值 

2. 發電機激磁電壓基準值以及導出 
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3. 發電機無載飽和係數 S1.0 與 S1.2 

 

三、 求解過程 

依據表 6-5 繪製出圖 6-2，因此可得出氣隙線並利用二次曲線得到發

電機端電壓 1.2(pu)時之激磁電流值。 

V
t
(p
u
)

 

圖 6-2 發電機開回路飽和特性 

1. 發電機激磁電流基準值 = 發電機端電壓之氣隙線達額定值時的

激磁電流 = 570 (A) 

2. 發電機激磁電壓基準值=激磁電流基準值×轉子繞組=570×0.1803 

= 102.771 (V) 

3. 發電機無載飽和係數 S1.0 與 S1.2 (由圖形計算) 
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發電機無載飽和係數 S1.0與 S1.2 (由公式計算) 

 

(僅適用於二次曲線模型) 

其中，E：發電機端壓(Vt)，A、B：運算常數 

1) 選擇飽和起始點: Vt = 0.6, 因為飽和起始點，飽和係數 S 為 0 

 

所以 A =0.6  

2) 選擇穿越點: Vt = 0.90788,   

 

所以 B = 1.3401 

 

 

 

無載飽和實驗中的平均轉子繞組 Rf 
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6-4 磁場短路(T’do)測試 (Field Short-Circuit Test)  

一、 測試說明 

磁場短路(T’do)測試用於確定發電機激磁繞組時間常數 T’do。在機組

運轉在額定轉速沒有負載(主斷路器開路)情況下，在接近 100%額定發電

機端電壓時，打開磁場斷路器移除機組之激磁電壓。因發電機激磁繞組的

去磁電阻很小，磁場斷路器打開後激磁繞組形同短路。依據放電電阻的

V-I 特性和發電機機端電壓變化情況，T’do 時間常數可經由模擬磁場短路

試驗來求得。圖 6-3 顯示記錄到的試驗中發電機機端電壓的變化。圖中一

併給出使用現有參數及新驗證的參數的模擬結果。新模擬結果是由假設發

電機轉子繞組開路時間常數為 15.4 秒所得。因此，這樣也就驗證了發電

機的轉子繞組開路時間常數應為 15.4 秒（對應于發電機無載時轉子的電

阻值為 0.1736 Ω）。 
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圖 6-3 磁場短路(T’do)測試之發電機端電壓 

二、 求解目的  

此測試結果被用於確定 

1. 發電機激磁繞組時間常數 T’do 

2. 發電機無載時轉子的電阻值 



 - 41 - 

三、 求解過程  

1. 利用圖 6-3求取發電機激磁繞組時間常數T′do如圖 6-4可得為 1.68秒。 

2. 若利用模擬比較的方式，如圖 6-5 及圖 6-6 可得時間常數 T′do = 15.4 

(sec)為模擬所得最接近的曲線(Vf 基底值為基底值為基底值為基底值為 98.157 V)。 

3. 利用本測試之測試前激磁電壓、電流平均值(如圖 6-7 所示)，即可計算

發電機無載時轉子的電阻值 

  

4. 根據 PLI 的報告，無載測試均須依實測之激磁場電壓、電流平均值重

算場電壓基準值。 

5. 在此次測試中因 T’’do 的區塊不易辨別，所以導致 T’do 的區塊不易區

分出來，故建議採用擬合法求解。 
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圖 6-4 利用圖解法求取激磁繞組時間常數 
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圖 6-5 利用模擬比較求取激磁繞組時間常數 
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圖 6-6 利用模擬比較求取激磁繞組時間常數 



 - 43 - 

0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5

x 10
5

-100

0

100

200

300

400

500

600

700

 

圖 6-7 磁場短路測試之磁場電壓、電流變化 

 

6-5 d 軸參數測試(MVar 卸載試驗) 

一、 測試說明 

發電機直軸試驗用於驗證發電機直軸電抗值及時間常數。機組要先並

聯入電力系統，調整有效功率輸出盡可能接近為 0 MW，並且大約輸入30%

額定進相無效功率(超前功率因數)，激磁系統使用手動控制模式，然後打

開發電機組主斷路器。這個測試結果將被用來推導發電機 d 軸的穩態、暫

態、次暫態電抗和時間常數。 

d 軸參數試驗在打開機組主斷路器前，發電機的實際運行狀況如下： 

1. 有效功率輸出 8.28 MW  

2. 無效功率輸出 -47.09 MVAr(欠勵) 

3. 發電機端電壓 16.10 kV 

圖 6-8 顯示本試驗中發電機機端電壓的變化。圖中一併給出使用現有
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參數及新驗證的參數的模擬結果。由圖可見，新驗證參數的模擬結果與現

場測量結果符合得非常好。通過此試驗，發電機的直軸電抗值及時間常數

得到了驗證。顯然，新驗證的參數在計算機模擬中提供比現有參數更接近

實際測量的模擬結果。 

值得指出的是，在此試驗時，儘管發電機的激磁控制置於手動控制（在

ABB UNITROL-5000 控制器中，手動實際對應的是激磁電流控制），在發

電機的主斷路器打開後，發電機的激磁電壓並不能夠維持不變，而是由於

電樞反應的結果，發電機的激磁電壓錄到了相當大的暫態的下跌。因此在

做上述試驗模擬時，將所記錄到的激磁電壓波形直接輸入到了模擬軟體以

比對輸出之激磁電流波形。此外，在模擬此試驗時，發電機的轉子繞組開

路時間常數假設為 15.4 秒，與磁場短路試驗一致。 
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圖 6-8 發電機直(d)軸試驗中之發電機端電壓 

二、 欠激與之測試條件說明 

在發電機參數測試中無效功率輸出皆採進相欠激負值之運轉條件，主

要原因在當發電機之負載主開闢打開後，發電機端壓(Vt)，才不會異常上

升，如圖 6-9 所示發電機輸出 Q 欠激與過激比較，得知當發電機之 Q 為

負(-89.54MVAr 與-113.39MVAr)時，(d)軸試驗中之洩 Q 後發電機端電壓急

速下降。相反地，當發電機之 Q 為正(43.01MVAr)時，(d)軸試驗中之洩 Q
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後發電機端電壓急速上升，如圖 6-10 所示發電機端電壓欠激與過激比較。 
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(a) 發電機之 Q 為負(-89.54MVAr)(進相欠激) 
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(b) 發電機之 Q 為負(-113.39MVAr)(進相欠激) 
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(c) 發電機之 Q 為正(43.01MVAr)( 遲相過激) 

圖 6-9 發電機輸出 Q 欠激與過激比較 
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圖 6-10 發電機端電壓欠激與過激比較 

 

三、 求解目的 

此測試目的被用於確定發電機 d 軸的 

1. 穩態電抗 Xd 

2. 時間常數 T"do 

3. 次暫態電抗 X"d 

4. 時間常數 T'do 

5. 暫態電抗 X'd。 

四、 求解過程 (發電機端電壓基底值必須 13.8kV) 

1. 將圖 6-10 局部放大如圖 6-11，調整穩態電抗 Xd使其如穩態時(斷

路器尚未打開)。Xd過大，模擬之發電機電壓將上升，Xd過小，模

擬之發電機電壓將下降。 

2. 調整時間常數 T"do 使其能符合斷路器剛打開時，發電機端電壓最

陡的壓降部分。T"do過大，模擬之發電機電壓將上升，T"do 過小，

模擬之發電機電壓將下降。 

3. 調整時間常數 T'do使其符合圖 6-12 的壓降部分。T'do過大，模擬之
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發電機電壓將上升，T'do過小，模擬之發電機電壓將下降。 
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圖 6-11 發電機直(d)軸試驗中之發電機端電壓局部放大 
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圖 6-12 發電機直(d)軸試驗中之發電機端電壓局部放大 



 - 48 - 

6-6 q 軸參數測試(部份 MW 卸載試驗) 

一、 測試說明 

發電機 q 軸試驗用於驗證發電機 q 軸電抗值及時間常數。機組要先並

聯入電力系統，調整有效功率輸出及無效功率輸出使發電機電流與 q 軸對

準。在這種運行方式下發電機電流僅有 q 軸分量。在激磁系統使用手動控

制模式時打開發電機組的主斷路器，發電機機端電壓的變化受 q 軸發電機

電抗及時間常數的影響。這個測試結果將被用來推導 q 軸的暫態、次暫態

阻抗和時間常數。 

q 軸參數測試在打開機組主斷路器前，發電機的實際運行狀況如下： 

1. 有效功率輸出 53.34 MW  

2. 無效功率輸出 -4.46 MVAr(欠勵) 

3. 發電機端電壓 16.52 kV 

圖 6-13 顯示本試驗中發電機機端電壓的變化。圖中一併給出使用現

有參數及新驗證的參數的模擬結果。由圖可見，新驗證參數的模擬結果與

現場測量結果比使用現有參數符合得好。通過此試驗，發電機 q 軸電抗值

及時間常數得到了驗證。新驗證的參數在計算機模擬中提供比現有參數更

接近實際測量的模擬結果。同樣地，與模擬 d 軸試驗類似，在處理此 q 軸

試驗時，現場記錄到的激磁電壓波形直接輸入到模擬軟體中進行模擬。 
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圖 6-13 發電機交(q)軸試驗中之發電機端電壓 
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二、 測試目的 

此測試目的被用於驗證發電機的參數為 

1. q 軸的時間常數 T"qo 

2. 阻抗 Xq 

3. 慣性係數 H 

三、 求解過程 

1. 將圖 6-13 局部放大如圖 6-14，調整時間常數 T"qo使其能符合斷路

器剛打開時，發電機端電壓最陡的壓降部分。T"qo 過大，模擬之

發電機電壓將上升，T"qo過小，模擬之發電機電壓將下降。 

2. 調整 q 軸的阻抗 Xq 使其能符合電壓上升部分。Xd 過小，模擬之

發電機電壓將上升，Xd過大，模擬之發電機電壓將下降。 

3. q 軸參數驗證可達需求。 
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圖 6-14 發電機交(q)軸試驗中之發電機端電壓局部放大 
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圖 6-15 發電機交(q)軸試驗中之發電機頻率 

 

4. 根據 q 軸試驗中發電機頻率的變化，如圖 6-15 所示發電機交(q)

軸試驗中之發電機頻率可以利用下列公式求出發電機慣性係數

H。 

 

當穩定時 Pm = Pe = 53.34MW(基準值 280MW)，而打開斷路器，進行卸

載時，Pe =0，假設 Pm 仍等於穩態之 Pe 。 
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6-7 電壓調整器步階響應測試 

一、 測試說明 

電壓調整器步階響應測試用於驗證發電機激磁系統的模型及參數。試

驗在發電機運行在無載額定轉速時進行。發電機主斷路器保持在開路狀

態。試驗的核心是在電壓調整器的電壓參考點(無論是虛擬、實際信號還

是數位值) 上施加一步階信號以觀察發電機機端電壓之變化。對於本機組

使用的 ABB UNITROL-5000 數位式電壓調整器，步階信號是通過改變控

制軟體中的電壓參考值來實現。 

圖 6-16, 6-17 分別示出在 5% 和 10%的現場步階響應試驗中， 測量

到的發電機機端電壓與激磁電壓和計算機模擬結果之比較。計算機模擬使

用新驗證的發電機參數及新驗證的激磁系統參數。由圖中所示，新驗證的

模型參數可以很恰當地表示本發電機組的激磁系統，包括數位式電壓調整

器以及相關的矽整流設備。 
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(a) 發電機機端電壓比較 
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（b）發電機激磁電壓比較 

圖 6-16 電壓調整器 5%步階響應試驗中之發電機端電壓及激磁電壓 
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(a) 發電機機端電壓比較 
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（b）發電機激磁電壓比較 

圖 6-17 電壓調整器 10 %步階響應試驗中之發電機端電壓及激磁電壓 

二、 求解目的 

此測試結果被用於確定激磁機的相關參數。 

 

三、 求解過程 

1. UEL : 比對 ABB Unitrol 5000 模型及 ESST1A 得到 = 3 

2. VOS : 比對 ABB Unitrol 5000 模型及 ESST1A 得到 = 1 

3. TR = ABB Unitrol 5000 模型 TR (典型值) 

4. TC = ABB Unitrol 5000 模型 TC1 

5. TB = ABB Unitrol 5000 模型 TB1 

6. TC1 = ABB Unitrol 5000 模型 TC2 

7. TB1 = ABB Unitrol 5000 模型 TB2 

8. KA = ABB Unitrol 5000 模型 KR (整定值) 

9. TA = ABB Unitrol 5000 模型 TS (整流橋反應時間) 

10.  KC   典型值(反應整流係數)，假設激磁機變壓器阻抗 6% 
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11.  KF = 0  因為沒有 feed back 

12.  TF : 因為 KF = 0 ， TF的值沒有作用 

13.  KLR = ABB Unitrol 5000 模型 KID，因為 ILR = 999，KLR 的值沒有

作用 

14.  ILR = 999，除去 IFD的作用(等於 IFD無輸入) 

 

 

6-8 無效功率電流補償(電壓低垂，線路壓降補償)測試 

一、 測試說明 

線路壓降補償通常用來補償機組昇壓變壓器的部分阻抗並且調節發

電機端之外的某點的電壓。該補償也用於單一發電機經長輸電線接至系統

或幾個並聯發電機共用一台升壓變壓器的系統情形以解決無效功率在機

組間的分配衝突。無效功率電流補償(電壓低垂，線路壓降補償)測試通過

無效功率卸載來進行。發電機主要帶無效功率，電壓調整器設置在自動方

式。本測試在打開機組主斷路器前，發電機的實際運行狀況如下： 

1. 有效功率輸 5.29 MW  

2. 無效功率輸出-49.88 MVAr(欠勵) 

3. 發電機端電 16.02 kV 

圖 6-18 給出記錄到的發電機機端及激磁電壓。計算機模擬結果也標

於圖中供比較。此試驗結果驗證了該發電機組的線路壓降補償系數為零。

這與 UNITROL-5000 控制器中實際的設定值相符。 
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（a）發電機機端電壓比較 
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（b）發電機勵磁電壓比較 

圖 6-18 無效功率電流補償(電壓低垂，線路壓降補償)測試中之發電機電壓 

二、 測試目的 

此測試結果被用於確定激磁機的 XE參數。 

 

三、 求解過程 

激磁機模型 ESST1A 無此參數可供調整模擬。 
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6-9 部分負載卸載試驗 

一、 測試說明 

部分負載卸載試驗用於驗證發電機組的慣性時間常數 H 以及部分調

速機模型參數。在發電機帶部分負載，打開機組主斷路器後，發電機轉速

的變化被用來驗證機組慣量及調速機的響應。 

在打開機組主斷路器前發電機的運行狀況如下： 

1. 有效功率輸 86.92 MW  

2. 無效功率輸出 -28.06 MVAr(欠勵) 

3. 發電機端電 16.37 kV 

二、 測試目的 

此測試結果被用於確定發電機的 

1. 慣性係數 H 

2. 調差率 REG 

三、 求解過程 

1. 根據發電機頻率的變化，可以利用公式求出發電機慣性係數 H，如同

q 軸試驗。 

2. 將發電機頻率及其對應的實功輸出繪製成圖 6-19，計算其斜率得 
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圖 6-19 發電機頻率及其對應的實功輸出 

6-10 在線調速機步階響應試驗 

一、 測試說明 

在線調速機步階響應試驗用於進一步驗證調速機的速度調節率及模

型參數。當機組在線運行並帶有較重的負載情況下，在調速機負載/轉速

整定點加上一步階信號致使發電機有效出力變化。機組輸出變化的動態響

應可用來驗證水輪機及調速機模型參數。此步階信號的作用的等讓調速機

測到了電網頻率的變化，因而調速機應按設定的控制規律產生相應的動作

來增加或減小機組的出力，從而得到抑制電網頻率的變化之目的。 

在三號機調速機上，做了兩次步階響應試驗，並取得了相似的結果。

圖 6-20 給出了在 40.1 MW 步階響應試驗中測量到的有效功率與模擬實驗

中所得到的發電機有效功率變化。由圖可見，所選定的水輪機及調速機模

型參數可以較好地描述該原動機與調速系統。而現有模型與實際測量結果

差異較大。 
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圖 6-20 在線調速機步階響應試驗之發電機有效功率 

二、 求解過程 

該測試之模擬圖型(圖 6-21)與圖 6-20 完全不同，而且 Excel 檔中無該

測試資料。 
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圖 6-21 在線調速機步階響應試驗之發電機有效功率(模擬) 
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6-11 水始動時間常數試驗 

一、 測試說明 

水輪機的水始動時間常數定義為在額定水頭和進水閥門全開的情況

下，壓力鋼管中的水從靜止到額定流速時所需的時間。此時間常數為描述

水輪機動態特性最爲重要的一個參數。對於規則的供水系統，水始動時間

常數可以根據供水管道系統的幾何尺寸直接計算出來。用大觀電廠提供的

三號機的非規則管道系統的數據，粗略地估計，此時間常數為約為 1.8 秒。 

水輪機的水始動時間常數通常也可通過試驗來求得，在試驗過程中，

用水門限制器快速地降低水輪機的水門開度，待功率平穩後，在用水門限

制器將水門開到大約一半的位置。 

圖 6-22 給出在試驗中測得的發電機有效功率與水門開度的變化。圖

6-20 進一步給出水門開始減小時前 10 秒内錄到的有效功率變化。圖中同

時將計算機模擬結果和現場測量結果畫在一起供比較。由圖可見，新驗證

的模型較現有模型模擬結果更接近現場測量的結果。在模擬計算中，對應

於試驗時的水門起始開度為 71%，新模型假設水輪機的水始動時間常數為

1.48 秒，而現有模型假設水輪機的水始動時間常數為 1.16 秒。 
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圖 6-22 水始動時間常數試驗發電機有效功率之比較 
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圖 6-23 水始動時間常數試驗發電機有效功率之比較（局部） 

 

二、 測試目的 

此測試結果被用於確定水輪機的 1. 水始動時間常數 TW。 

 

三、 求解過程 

1. 調整 UDM 中的 TW，模擬出適當水始動時間常數 TW，如圖 6-24

所示。 
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圖 6-24 不同水始動時間常數時發電機有效功率之比較（局部） 

該測試之模擬圖型(圖 6-21)與圖 6-20 完全不同，而且 Excel 檔中無該

測試資料。 

 (秒)  
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6-12 其它參數求取 

一、 測試說明 

除了上述實驗可以求取的參數外，有些因應模型需要需要從上述測試

中另外找到的參數，這些參數整理如下: 

 

二、 求解過程 

1. 根據測試時記錄得到輸出功率與閥門開度之數據，如表 6-6。 

 

表 6-6 輸出功率與閥門開度(額定功率 280MW) 

發電機輸出功率 (P) 

MW pu 

閥門開度 

Gate (%) 

0 0 14 

86.9 0.310357 34.8 

167.8 0.599286 58.8 

209 0.746429 72 

240 0.857143 92.5 

 

2. 根據表 6-6 可得 G0, G1, P1, G2, P2, P3 參數，G0 是發電機輸出

0MW(P0 = 0)時的最小閥門開度，P3 為發電機最大允許輸出功

率，雖然當時的閥門開度不是最大(100%)，但是當作已經飽和，

即閥門開度到 100%時，P3 還是 240MW，如圖 6-25 所示。 

 

3. 輸出功率與閥門開度是於各項測試中手抄記錄得到，爾後測試時

請專人負責抄錄。 
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圖 6-25 輸出功率與閥門開度關係圖 
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柒柒柒柒、、、、    大林大林大林大林#4 發電機參數實測分析發電機參數實測分析發電機參數實測分析發電機參數實測分析 

 

7-1 大林#4發電機基值與模型 
 

表 7-1 與表 7-2 所示為大林電廠四號發電機之基本額定資料與

GENROU 發電機參數內容。這些基值由發電機銘牌額定數據及現場實

驗結果導出。激磁電壓與激磁電流基值皆由無載飽和實驗結果導出。由

於此發電機配備無刷激磁系統，主發電機的激磁電壓與激磁電流均不可

量測。因此，主發電機的激磁基準值由相應的旋轉交流激磁機的激磁量

來給定, 並假設在穩態運行時，主發電機的激磁電壓與激磁電流分別與

無刷交流激磁機的激磁電壓與電流在標么值下相同。這樣的假設被普遍

地採用，其根據是在發電機的正常運行狀態下，交流激磁機應運行在其

綫性段，遠未達到飽和的程度。激磁機的激磁電流基值定義為發電機端

電壓據氣隙線達額定值時的激磁電流。激磁機的激磁電壓基值定義為其

激磁電流基值與激磁機轉子繞組在無載飽和實驗中的平均電阻的乘積。 

 

表 7-1: 大林電廠四號發電機基值 

機組功率機組功率機組功率機組功率

(MVA) 

定子電壓定子電壓定子電壓定子電壓

(kV) 

定子電流定子電流定子電流定子電流

(Amps) 

激磁機激磁激磁機激磁激磁機激磁激磁機激磁電壓電壓電壓電壓

(Volts) 

激磁機激磁激磁機激磁激磁機激磁激磁機激磁電流電流電流電流 

(Amps) 

442 17 15,011 23.7
 (1)

 22.1 

註: (1) 對應于無載飽和實驗中的激磁機轉子繞組的溫度。 
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表 7-2 GENROU 發電機參數內容 

 

其中 IBUS 為發電機所在系統之 BUS #，1104；I 為發電機之 Unit #，

4。下列各節將進行此發電機參數實測模擬比較與求算說明。表 7-4 所

示為驗證此發電機參數所使用之單機無限匯流排電力潮流基本案例檔

(Talin-G4-DX.raw)。 

表 7-3  單機無限匯流排電力潮流基本案例檔(Talin-G4-DX.raw) 
0, 100.0/RAWD VER 30 

THIS CASE WAS SETUP FOR MODELING Talin-G4-DX 

 

 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.9142,8.199487E-02,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.9635645,   0.0000,  1 

  0 

 1104,'4 ',     2.017,     -72.205,   999.00,  -999.00,0.9142,8.199487E-02,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  

100.0,   999.00,     0.00,  1, 1.0 

 20000,'1 ',     -2.017,     76.10685,   999.00,  -999.00,0.9635645,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   

0.00000,1.00000,1,  100.0,   999.00,     0.00,  1, 1.0 

 0 

20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 

  0.0,  0.0625 

1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 

 1.00000, 0. 

 0 

    1,     0,     0.00,     1.00,'Area 1      ' 

 0 / END OF AREA DATA 

 0 

 0 / END OF VSC 

 0 

 0 

    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 

0 

  1, 'Owner1      ' 

 0 /END OF OWNER DATA 

0 / 
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7-2 大林#4模型參數驗證摘要 

發電機參數有其固定之範圍，如依水力機組(Hydraulic units)與火力機組

(Thermal units)分類，其發電機機模型參數典型值如表 7-4 a~c 所示。 

 

表 7-4a 同步發電機模型參數 

模型參數 

(PSS/E 模型

GENROU) 

現有數據 
 

(1) 

驗證後數據 
(2) 

參數驗證方法說明 

電抗(標么 pu) 

Xd (不飽和) 1.56 
(3)

 1.62 

X'd (不飽和) 0.393 0.346 

X"d (不飽和) 0.306 0.245 

d 軸試驗比對實測與模擬值擬和求得 

(參閱 7-5 d 軸參數測試) 

Xq (不飽和) 1.42 1.42 

X'q (不飽和) 0.80 0.80 

X"q (不飽和) 0.306
 (4)

 0.245
(4)

 

因發電機激磁量不可量測，Q 軸參數無

法驗證(參閱 7-6 q 軸參數測試) 

Xl 0.21 0.21 
漏抗不可測，採用採用原廠提供設定值 

(但注意 Xl < X"d = Xl + …) 

X2 - - 採用原廠提供設定值 

X0 - - 採用原廠提供設定值 

繞組電阻值 (歐姆) 

定子繞組 

(每相) 
- - 用廠商的值 

轉子繞組 - -  

激磁繞組時間常數(秒) 

T'do 4.17 4.65 
(5)

 

T"do 0.06 0.06 

d 軸試驗比對實測與模擬值擬和求得 

(參閱 7-5 d 軸參數測試) 

T'qo  1.5 1.5 

T"qo 0.112 0.112 

因發電機激磁量不可量測，Q 軸參數無

法驗證 (參閱 7-6 q 軸參數測試) 

其它參數 

H (kW•Sec/ 

kVA) 
4.45 4.45 

q 軸試驗，發電機頻率變化斜率計算值

或比對實測與模擬值之擬合結果(參閱

7-6 q 軸參數測試) 

D 1.0 1.0 
根據 PLI 經驗，D 值水力發電機組設為

0，火力發電機組設為 0.9 

S1.0 0.07 0.167 

S1.2 0.28 0.387 

開路特性(飽和)測試得到(參閱 7-3 開

路飽和試驗) 
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註:  

(1) 現有電網運行規劃模型數據 

(2) 由試驗驗證的發電機模型數據 

(3) 製造廠提供的同步發電機之飽和電抗(短路比 0.64 的倒數) 

(4) X"q 假設等於 X"d 

(5) 對應于磁場短路(T’do)測試時發電機轉子繞組的溫度。 

 

表 7-4b  激磁系統模型參數 

模型參數 驗證後數據 
(1)

 參數驗證方法說明 

激磁系統模型參數(PSS/E 模型 ESAC6A) 

TR 0.02 
(2)

 典型值 

KA 165 
利用激磁機步階響應，擬和比較發電機端電壓

的上升速度(參閱 7-7 激磁機步階測試) 

TA 20 胡課長的整定值 

TK 1.5 胡課長的整定值 

TB 0.0667 
(3)

 胡課長的整定值 

TC 1.0 胡課長的整定值 

VAMAX 7.1 
(4)

 VAMAX = VRMAX / 1 (s=0) 

VAMIN -6.1 
(5)

 VAMIN = VRMIN / 1 (s=0) 

VRMAX 7.1 
(4)

 可用 Vr 變化觀察，或用激磁機規格計算 

VRMIN -6.1 
(5)

 可用 Vr 變化觀察，或用激磁機規格計算 

TE 1.0
 (6)

 
利用 Ief輸入 1 /(1+TEs)輸出比對 Vef (參閱 7-7 激

磁機步階測試) 

VFELIM 99. 
OEL 限制器參數，沒裝直接 Pass 過去，給很大

的值 99 

KH 0.0 
OEL 限制器參數，沒裝直接 Pass 過去，給 0 等

同斷路 

KHMAX 99. OEL 限制器參數，沒裝直接 Pass 過去 

TH 0.0 OEL 限制器參數，沒裝直接 Pass 過去 

TJ 0.0 OEL 限制器參數，沒裝直接 Pass 過去 

KC 0.173 典型值(反應整流係數) 

KD 0.39 
(7)

 
去磁參數，d 軸試驗比對實測與模擬值擬和求得

(參閱 7-5 d 軸參數測試) 

KE 1.0 典型值 

E1 5.55 
(8)

 E1 = E2 * 0.75 

SE1 0.044 
(8)

 假設值(交流激磁機飽和特性不詳) 

E2 7.4 
(8)

 假設值(交流激磁機飽和特性不詳) 

SE2 0.214 
(8)

 假設值(交流激磁機飽和特性不詳) 

無效功率電流補償(PSS/E 模型 COMP) 

XE 0.0
(9)

 
XE  利用線路壓降補償測試， XE = dV/Is  Is 

斷開前的定子電流(參閱 7-8)  

註: 
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(3) 經由模擬與電壓調節器步階響應試現場試驗結果比對驗證得出 

(4) 典型參數 

(5) TB = 0.01+0.05+0.0067 = 0.0667 秒，詳見[1] 

(6) 估算的電壓調節器最大輸出 VAMAX =VRMAX =1.35*Vac/Vf-base = 1.35*125 V / 

23.7 V = 7.1 pu (假設三相可控橋最小觸發角 0 度) 

(7) 估算的電壓調節器最小輸出 VAMIN =VRMIN =1.35*Vac/Vf-base * Cos(150o) = 

1.35*125 V *(-0.866) / 23.7 V = -6.1 pu (假設三相可控橋最大觸發角 150 度) 

(8) 經由電壓調整器步階響應測試結果估算出 

(9) 由發電機直(d)軸試驗結果擬合而出 

(10) 假設值(交流激磁機飽和特性不詳) 

(11) 由模擬無效功率電流補償(電壓低垂，線路壓降補償)測試結果比對驗證得出，並

與實際設定值相符 

 

 

表 7-4c 汽輪機及調速機模型參數 

模型參數 

(PSS/E 模型

IEEEG1) 

 

PSS/E 典型值 

 

驗證後參數 
(1)

 參數驗證方法說明 

K 5.0 ≤ K ≤ 30. 9.0 

調差率的倒數，利用部分負載

卸載試驗擬和比對發電機頻

率穩態值(參閱 7-9 部分負載

卸載試驗) 

T1 0. ≤ T1 < 5.0 0.1 

調速器的控制時間常數 (機

械式，故無法由現有實驗得

到) 

T2 0. ≤ T2 < 10.0 0.0 

調速器的控制時間常數 (機

械式，故無法由現有實驗得

到) 

T3 4.( DELT < T3 ≤ 1.0 0.2 
伺服馬達時間常數 (機械

式，故無法由現有實驗得到) 

UO 0.01 ≤ Uo ≤ 0.3 0.025 

閥門的開啓速率無法由現有

實驗得到，假設與閥門的關閉

速率相同 

UC –0.3 ≤ Uc < 0. -0.025 

閥門的關閉速率，利用部分負

載卸載試驗擬和比對發電機

頻率變化部分(參閱 7-9 部分

負載卸載試驗) 

PMAX 0.5 ≤ PMAX ≤ 2.0 1.0 
PMAX  = 1 等於最大，不限制

輸出 

PMIN 0. ≤ PMIN < 0.5 0.0 
PMIN  = 0 等於最小，不限制

輸出 
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T4 0. < T4 ≤ 1.0 0.4 

用 First Stage 壓力輸入

1/(1+T4s)輸出比對 Pm(Pe) 

(參閱 7-10 蒸氣室時間常數

測試) 

K1 –2.0 ≤ K1 ≤ 1. 0.3811
(2)

 HP 的出力占總出力的百分比 

K2 K2 = 0. 0.0 典型值 

T5 0. ≤ T5 < 10.0 10.5 
典型值，配合蒸氣室時間常數

測試擬合 

K3 0. ≤ K3 < 0.5 0.1632 
(2)

 IP 的出力占總出力的百分比 

K4 0. ≤ K4 < 0.5 0.0 典型值，假設無作用 

T6 0. ≤ T6 < 10.0 0.4 
典型值，配合蒸氣室時間常

數測試擬合 

K5 0. ≤ K5 < 0.35 0.4557 
(2)

 
LP 的出力占總出力的百分比 

(K1 + K3 + K5  = 1) 

K6 0. ≤ K6 < 0.55 0.0 典型值，假設無作用 

T7 0. ≤ T7 < 10.0 0.0 典型值，假設無作用 

K7 0. ≤ K7 < 0.3 0.0 典型值，假設無作用 

K8 0. ≤ K8 < 0.3 0.0 典型值，假設無作用 

註:  

(1) 由試驗驗證的汽輪機與調速機之模型數據 

(2) 由大林電廠熱力工程師根據汽輪機的熱平衡圖計算而得 
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7-3 大林#4發電機開路飽和試驗(Open circuit saturation test) 

一、 測試說明 

開路飽和試驗於發電機組運轉在額定轉速沒有負載(主斷路器開路)情

況下進行。對於本發電機之無刷式旋轉交流激磁系統，發電機端電壓從接

近額定值先被降至接近零，然後用電壓調節器的手動控制方式增加磁場電

壓，使發電機端電壓逐步上升(每個步階約 1000V)，直到機組最大的容忍

極限。由於主發電機的激磁電壓與激磁電流均不可量測。因此，在試驗中，

只對旋轉交流激磁機的激磁電壓與激磁電流進行了量測。表 7-5 為由激磁

機激磁電流確定的發電機開路回路飽和特性測試結果。此測試結果被用於

確定激磁機激磁電流和激磁電壓的基準值以及導出發電機的無載飽和係

數 S1.0與 S1.2。 

表 7-5 大林電廠四號發電機開路飽和試驗實測參數資料 

Vt (kV) IF (A) VF (V) F (Hz) 

0.991 0.594 0.288 59.931 

2.039 2.027 1.390 59.950 

2.889 3.192 2.639 59.917 

3.959 4.380 4.329 59.935 

4.959 5.782 5.842 59.921 

6.189 7.808 7.850 59.909 

6.881 8.611 8.783 59.912 

8.005 10.256 10.450 59.918 

9.089 11.935 12.246 59.909 

9.920 12.829 13.304 59.916 

10.962 14.309 14.884 59.929 

11.935 15.742 16.483 59.915 

12.969 17.392 18.262 59.890 

13.684 18.425 19.521 59.916 

14.323 19.635 20.799 59.898 

14.815 20.511 21.800 59.900 

15.402 21.694 23.142 59.885 

15.884 22.663 24.211 59.893 

16.373 23.787 25.546 59.885 

16.955 25.279 27.156 59.900 
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17.454 27.073 29.053 59.887 

17.751 27.898 30.108 59.882 

二、 求解目的 

此測試結果被用於確定 

1. 發電機激磁電流基準值和 

2. 發電機激磁電壓基準值以及導出 

3. 發電機無載飽和係數 S1.0 與 S1.2。  

三、 求解過程  

求算 S1.0與 S1.2 前，利用式(7-1)~式(7-3)分別推算出發電機激磁場電

流基準值(IFB)、發電機端壓(Vt)與場電流(IF)之斜率(slope)、發電機激磁場

電阻測量平均值(Rf(average))與發電機激磁場電壓基準值(VFB)。發電機激磁場

電流基準值(IFB)定義為在額定轉速(Rated speed)下於發電機氣隙線產生額

定端壓基準值(VtB)之電流值，如式(7-1) 所示。 

發電機激磁場電壓基準值(VFB)定義為發電機激磁場電流基準值(IFB)

乘於發電機激磁場電阻測量平均值(Rf(average))，如式(7-3) 所示，測量平均

值為 1.0699 Ω。詳細如下面定義與推算。 

 

A 79.21
783836.0

17
===

slope

V
I tB

FB            (7-1) 

Ω==   0699.1)(

F

F
averagef

I

V
R            (7-2) 

V 23.31A 79.12  0699.1)( =×Ω=×= FBaveragefFB IRV     (7-3) 

其中， 

IFB：發電機激磁場電流基準值(A) 

VFB：發電機激磁場電壓基準值(V) 

VtB：發電機端壓基準值(V) 

IF：發電機激磁場電流測量值(A) 
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VF：發電機激磁場電壓測量值(V) 

slope：發電機端壓(Vt)與場電流(IF)之斜率 

Rf(average)：發電機激磁場電阻測量平均值(Ω) 

發電機端壓(Vt)與場電流(IF)之斜率(slope)，由實測之 Vt 與 IF，經線

性(Linear)迴歸分析，取未飽和線性值求得斜率為 0.783836，如圖 7-2 所示。 

參考PTI手冊Program application guide (Volume II ) 146頁之公式配合

發電機實測資料可求出 A、B 常數，並推算出 S1.0 與 S1.2，如下計算： 

E

AEB
S

2)( −
=              (7-4) 

其中，E：發電機端壓(Vt)，A、B：運算常數 

y = 0.783836x
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圖 7-2 Vt 與 IF 分布之線性(Linear)迴歸分析 

將圖 7-2 線性氣隙線(Air-gap line)、實測值(Data)與推算模式值(fitting 

model)比較所示之實測值(Data)飽和起始點(Best fit model : starting at Vt，

Vt
0 
= 0.691)與穿越點(passing through，Vt

1 
= 0.99736)，代入式(7-4)，可得

下列聯立方程式，並求算出 A、B： 

(1)、 飽和起始點(Best fit model : starting at Vt，Vt
0 
=0.691，因為飽和起始

點，飽和係數 S 為 0)  

⇒ 
691.0

)691.0()(
0

2

0

20 AB

vt

AvtB −
=

−
=   

(2)、 穿越點(passing through，Vt
1 
= 0.99736，由圖 7-3 氣隙線、實測值與



 - 73 - 

模擬值比較所示得 Vt
 
= 0.99736 對應 IF=1.16558 求得

S=(IF/Vt)-1=0.169)  

⇒ 
997.0

)997.0()(
169.0

2

1

21
AB

vt

AvtB −
=

−
=   

(3)、 由前兩項求得 A = 0.701、B = 1.9152，代入式(7-4)，可得下列聯立

方程式，求算出 S1.0與 S1.2，計算如下： 

⇒ 
387.0

2.1

)2.1(
 

 171.0
0.1

)0.1(

2

2.1

2

0.1

=
−

=

=
−

=

AB
S

AB
S

  

 

圖 7-4 所示為發電機開回路飽和特性比較圖，圖中繪出發電機端電壓

與激磁機激磁電流之關係。由現有及新導出的飽和係數計算得到的飽和曲

線在圖中一併繪出以供比較。很顯然，測得的飽和特性比由現有飽和係數

所求得的特性飽和程度更爲嚴重。而用新飽和係數計算出的特性與實際測

量結果更爲接近。在此是用測得的交流激磁機激磁電流來確定發電機的無

載飽和係數，所根據的假設是在開回路飽和試驗中，交流激磁機遠未達到

飽和的程度。即主發電機的激磁電流與無刷交流激磁機的激磁電流成正

比，它們在標么值下相同。這樣的假設在工程中被普遍地認爲可以接受。 
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圖 7-3 線性氣隙線、實測值與推算模式值比較 
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圖 7-4 大林電廠四號發電機開回路飽和特性比較圖 
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7-4 發電機激磁場短路試驗(Field Short-Circuit (T
′
do) Test) 

一、 測試說明 

發電機磁場回路短路試驗主要用於確定發電機激磁繞組時間常數

T′do。在機組運轉在額定轉速沒有負載(主斷路器開路)情況下，在接近

100%額定發電機端電壓時，打開激磁機磁場斷路器移除機組之激磁電

壓。此時由測量到的發電機機端電壓的衰減曲綫即可確定 T′do 時間常數。 

二、 求解目的 

此測試結果被用於確定發電機激磁繞組時間常數 T′do。 

三、 求解過程  

1. 利用模擬比較求解 

圖 7-5 所示為本試驗中發電機端電壓的變化情形，圖中一併繪出使用

現有參數及新驗證參數的模擬結果。新模擬結果是由假設發電機轉子繞組

開路時間常數 T′do 為 4.65 秒，和交流激磁機時間常數 TE為 1.0 秒所得。

因爲，發電機機端電壓的衰減既取決於 T′do，也和 TE 有關。在模擬驗證

過程中，交流激磁機時間常數 TE 首先由電壓調節器步階相應試驗結果求

得，驗證技巧如上述第五章、發電機組模型參數驗證技巧介紹。此外，在

模擬此試驗時，同時用到了新驗證的發電機與交流激磁機模型和參數（不

含電壓調節器部分）。模擬驗證方式如第五章所示。 

新驗證的發電機轉子繞組開路時間常數應較現有參數在數值上大(現

有參數也是對應于相同的轉子繞組溫度)。如果現有參數對應的是機組滿

載時轉子繞組的溫度，則此測試結果將于現有參數非常接近。 
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圖 7-5 磁場短路(T’do)測試中之發電機端電壓比較圖 

 

2. 利用圖解法求解 

利用圖解法求取發電機激磁繞組時間常數 T′do 如下圖 7-6，可得為 5.1667

秒。註：圖解法的根據其實是充放電時間常數而已，h2 是由滿電位放電

到穩態的電位差(h2=1-0.0203=0.9797)，0.368*h2 中的 0.368 就是放電

時，當 t=RC 時，e
-1

=0.368。 
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圖 7-6 利用圖解法求取激磁繞組時間常數 T′do 

 

7-5 大林#4發電機直軸（D-Axis）試驗(MVar卸載試驗) 

一、 測試說明 

發電機直軸（D-Axis）試驗主要在驗證發電機直軸（D-Axis）電抗值

（Xd、X'd、X"d）及時間常數（T'd0、T"d0）。此一試驗為虛功率卸載試驗，

機組要先並聯入電力系統，調整發電機有效功率輸出接近為 0 MW，並且

大約輸入 30%額定進相無效功率(超前功率因數)，設定激磁系統為手動控

制模式，以維持發電機激磁電壓於斷路器開啟前後一致，然後打開發電機

組主斷路器。這個測試結果將被用來推導發電機 D 軸的穩態、暫態、次

暫態電抗和時間常數。 

二、 求解目的 

此測試結果被用於確定發電機 d 軸的 

1. 穩態電抗 Xd、暫態電抗 X'd、次暫態電抗 X"d 

2. 時間常數 T"do、時間常數 T'do 
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3. 激磁機去磁係數 KD。 

三、 求解過程  

大林電廠四號發電機組在開啟斷路器前之負載狀況如下： 

1. 實功率輸出接近 2.02 MW 

2. 虛功率輸出接近– 72.21 MVAr 

3. 發電機端電壓為 15.54 kV 

圖 7-7 繪出本試驗中發電機機端電壓的變化情形，圖中一併繪出使用

現有參數及新驗證的參數的模擬結果。由圖可見，使用新驗證參數的模擬

結果與現場測量結果符合得非常好。透過此試驗，發電機的直軸電抗值及

時間常數得到了驗證。顯然，新驗證的參數在計算機模擬中提供比現有參

數更爲接近實際測量的模擬結果。 

需要指出的是，在模擬此試驗時，同時用到了發電機與交流激磁機的

模型和參數(不含電壓調節器部分)，因發電機的轉子繞組開路時間常數

T′do 已由前述試驗求得，因此，通過擬合端電壓的衰減過程，可以大致

確定激磁機模型中的去磁係數 KD。此外，在模擬此試驗時，發電機的轉

子繞組開路時間常數假設為 4.65 秒，與磁場短路(T’do)測試一致。模擬驗

證方式如附錄 1 所示。 
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圖 7-7 發電機 d 軸試驗中之發電機端電壓比較圖 
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四、 驗證心得  

1. 調整穩態電抗 Xd 使其如穩態時圖 7-8 (斷路器打開後)。Xd 過大，

模擬之發電機電壓將下降，Xd 過小，模擬之發電機電壓將上升。 

 

0 30
0.6

0.65

0.7

0.75

0.8

0.85

0.9

Time (sec)

V
t 
(p

u
)

 

圖 7-8 發電機直(d)軸試驗中調整穩態電抗 Xd 的變化 

2. 調整時間常數 T"do 使其能符合斷路器剛打開時如圖 7-9，發電機

端電壓最陡的壓降部分。T"do 過大，模擬之發電機電壓將上升，

T"do 過小，模擬之發電機電壓將下降。 
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圖 7-9 發電機直(d)軸試驗中調整時間常數 T"do 的變化 

3. 調整次暫態電抗 X"d 使其符合圖 7-10 的壓降部分。X"d 過大，模

擬之發電機電壓將下降，X"d 過小，模擬之發電機電壓將上升。 
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圖 7-10 發電機直(d)軸試驗中調整電抗 X"d 的變化 

4. 調整時間常數 T'do 使其符合圖 7-11 的壓降部分。T'do 過大，模

擬之發電機電壓將上升，T'do 過小，模擬之發電機電壓將下降。 
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圖 7-11 發電機直(d)軸試驗中調整時間常數 T'do的變化 

5. 調整暫態電抗 X'd 使其符合圖 7-12 的壓降部分。X"d 過大，模擬

之發電機電壓將下降，X"d 過小，模擬之發電機電壓將上升。 
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圖 7-12、發電機直(d)軸試驗中調整電抗 X’d的變化 

6. 調整去磁係數 KD 使其符合圖 7-13 的壓降部分。KD 過大，模擬

之發電機電壓將下降，KD 過小，模擬之發電機電壓將上升。 
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7. 經驗得 T"do、T'do 與發電機端電壓(Vt)下降成反比，X"d、X'd、

Xd, 與 Vt 之下降成正比，但調整 T"do、T'do 時須搭配調整 X"d、

X'd 才有調整功能。 

8. KD 對發電機端電壓下降速度成正比，不影響最後穩態結果。 
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圖 7-13、發電機直(d)軸試驗中調整 KD的變化 

 

7-6 發電機交軸（Q-Axis）試驗 

一、 測試說明 

發電機交軸（Q-Axis）試驗主要在驗證發電機交軸（Q-Axis）時間常

數（T
’
q0、T

’’
q0）及電抗（Xq、X

’
q）。此試驗為發電機部份卸載試驗，通常

為發電機額定出力之 10%~15% MW 進行卸載，試驗所得之數據亦可做為

發電機慣性常數（H）、汽機及調速機模型參數之驗證用。使用準確的機

組慣性常數對設定電力系統穩定器（PSS）參數具有決定性的影響，使機

組面對電網發生低頻振盪現象時，具有準確之相位補償效果，使系統快速
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收斂確保系統之穩定度。 

二、 求解目的 

此測試結果被用於確定發電機的 

1. q 軸的時間常數 T"qo 

2. 阻抗 Xq 

3. 慣性係數 H。 

三、 求解過程  

大林 4 號發電機在開啟斷路器前之負載狀況如下： 

1. 有效功率輸出 55.77 MW 

2. 無效功率輸出 -11.93 MVAr(欠勵) 

3. 發電機端電壓 15.89 kV 

圖 7-14 繪出記錄到的本試驗中發電機機端電壓的變化。圖中一併給

出使用現有參數及新驗證的參數的模擬結果。在模擬此交軸試驗時，應用

了同樣的發電機 Q 軸電抗及時間常數。模擬結果的差異完全是由於不同

的發電機飽和係數和 D 軸參數的不同所致。儘管在現場試驗時，此實驗

按照 Q 軸的要求進行了卸載試驗，並且獲得了類似正確的機端電壓紀錄。

但在模擬此試驗時，應用量測到的激磁機激磁電壓與激磁電流卻得不到與

測量結果相近的模擬曲綫，模擬驗證方式如附錄 2 所示。由於主發電機的

激磁量不可量測，因此，該機組的 Q 軸參數無法進一步驗證。建議不對

該發電機的 Q 軸參數作任何修改。 
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圖 7-14 發電機 q 軸參數測試中之發電機端電壓比較 

1. 將圖 7-14 局部放大如圖 7-15，調整時間常數 T"qo使其能符合斷路

器剛打開時，發電機端電壓最陡的壓降部分如圖 7-14。T"qo過大，

模擬之發電機電壓將上升，T"qo過小，模擬之發電機電壓將下降。 

2. 調整 q 軸的阻抗 Xq使其能符合電壓穩態部分如圖 7-16。Xq過小，

模擬之發電機電壓將上升，Xq 過大，模擬之發電機電壓將下降。 

 

0

0.92

0.922

0.924

0.926

0.928

0.93

0.932

0.934

0.936

0.938

Time (sec)

V
t 
(p

u
)

 

圖 7-15 發電機交(q)軸試驗中調整的變化時間常數 T"qo 的變化 
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圖 7-16 發電機交(q)軸試驗中調整電抗 Xq的變化 
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圖 7-17 發電機交(q)軸試驗中之發電機頻率 
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3. 根據 q 軸試驗中發電機頻率的變化，如圖 7-17 發電機交(q)軸試驗

中之發電機頻率所示，可以利用下列公式求出發電機慣性係數 H。 

mP
dt

d
H =

ω
2  

當穩定時 Pe = Pm，而打開斷路器，進行卸載時，Pe = 0，假設 Pm 仍等

於穩態之 Pe。 

df

dtP

d

dtP

dt

d

P
H eee

22
2

===
ωω

 

366.4

60

94.59807.60
*2

1*
442

77.55

2 )(

)( =
−

==
pu

pue

df

dtP
H  (秒) 

四、 驗證心得  

q 軸阻抗與時間常數對 Vt 之變化特性與 d 軸相同。 

 

 

7-7 電壓調整器步階響應測試 

一、 測試說明 

電壓調整器步階響應測試用於驗證發電機激磁系統的模型及參數。試

驗在發電機運行在無載額定轉速時進行。發電機主斷路器保持在開路狀

態。試驗的核心是在電壓調節器的電壓參考點(無論是虛擬、實際信號還

是數位值) 上施加一步階信號以觀察發電機機端電壓之變化。對於本機組

使用的數位式電壓調節器，步階信號是通過改變控制軟體中的電壓參考值

來實現。 

二、 求解目的 

此測試結果被用於確定激磁機的相關參數。 
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三、 求解過程  

圖 7-18 及圖 7-19 分別示出在 4.5% 和 9%的現場步階響應試驗中，

測量到的發電機機端電壓與計算機模擬結果之比較。如圖所示，新的模型

參數可以非常好地模擬本發電機組的無刷交流激磁機系統，包括其數位式

電壓調節器。模擬驗證方式如附錄 3 所示。 
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圖 7-18 電壓調節器 4.5%步階響應試驗中之發電機端電壓比較 
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圖 7-19 電壓調節器 9%步階響應試驗中之發電機端電壓比較 
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四、 驗證心得  

本節所示測量結果均為對電壓調節器的控制參數做了調整後的最後

試驗結果。 

 

 

7-8 大林#4無效功率電流補償(電壓低垂，線路壓降補償)測試 

一、 測試說明 

線路壓降補償通常用來補償機組昇壓變壓器的部分阻抗並且調節發

電機端之外的某點的電壓。該補償也用於單一發電機經長輸電線接至系統

或幾個並聯發電機共用一台升壓變壓器的系統情形以解決無效功率在機

組間的分配衝突。 

無效功率電流補償(電壓低垂，線路壓降補償)測試通過無效功率卸載

來進行。發電機主要帶無效功率，電壓調節器設置在自動方式。本測試在

打開機組主斷路器前，發電機的實際運行狀況如下： 

1. 有效功率輸出 22.81 MW  

2. 無效功率輸出 -74.86 MVAr(欠勵) 

3. 發電機端電壓 15.53 kV 

二、 求解過程  

圖 7-10 繪出記錄到的發電機機端電壓。計算機模擬結果也標於圖中

供比較。計算機模擬使用中的發電機參數及激磁系統參數，請參考『發電

機組模型參數定期量測與確認作業程序書』，模擬驗證方式如附錄 4 所

示。計算機模擬驗證表明：要使模擬結果與測量到的機端電壓完全吻合，

需要增加不到 2%的無效功率補償係數。考慮到該電壓壓調節器内的實際

設定值為零，並且受汽機最小出力的限制，此試驗並非在理想的條件下(有

效功率輸出為零)進行。因此建議在系統模擬計算時，該機組的線路壓降

補償係數應考慮零。 
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圖 7-20 無效功率電流補償測試中之發電機端電壓比較 

 

7-9 大林#4部分負載卸載試驗 

 

一、 測試說明 

部分負載卸載試驗用於驗證發電機組的慣性時間常數以及部分調速

機模型參數。在發電機帶部分負載，打開機組主斷路器後，發電機轉速的

變化被用來驗證機組的慣量及調速機的響應。由於前述 Q 軸參數試驗可

以完全滿足上述要求。Q 軸參數試驗的結果同時被用來驗證發電機組的慣

性時間常數以及調速機的模型參數，以避免卸載試驗對機組的衝擊。因

此，本節描述的卸載試驗與 Q 軸參數試驗實際上為同一個試驗，其發電

機在打開主斷路器前的運行狀當然也與 Q 軸參數試驗完全相同，圖 7-12

為發電機轉速在此實驗中的變化。 

二、 求解過程  

圖 7-21 為在打開機組主斷路器後約 1 秒内發電機轉速的上昇斜率。

以發電機系統搖擺方程式（Swing Equation），如式 7-5 所示，當系統發生

擾動時，如負載跳脫（卸載）時，可將此方程式簡化為式 7-6 所示，此方

程式反應出發電機卸載時，發電機剛開始之速度反應曲線。當 H 越大(5

秒)頻率上揚斜率越小(向前斜，(慣量大)，如 H 越小(3 秒)頻率直線向上(慣
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量小)。慣性常數 H 值一般介於 1~10 秒之間，視發電機組型態及大小而定

（3600 轉火力機組 H 值介於 2.5~6.0 秒、1800 轉火力機組 H 值則介於

4.0~10 秒、水力機組則介於 2.0~4.0 秒）。 

em PP
t

H −=
∂
∂ω

2             (7-5) 

t
P

H ∆
∆
∆

=
ω2

1
              (7-6) 

圖 7-21 中將計算機模擬結果和現場測量結果畫在一起供比較。利用

TSAT 模擬軟體修改 Talin-G4-PSSE.dyn 檔內發電機參數之慣性常數 H，所

得到之發電機速度與實測值比較，藉以擬合發電機速度之暫態響應進而修

改上述之參數，以反應發電機組之實際狀況。由圖 7-21 可見，用現有發

電機的慣性時間常數已經可以得到與現場測量非常接近的結果(通過比較

發電機轉速的初始上昇斜率)。這樣驗證了現有慣性時間常數的正確性。 

針對卸載試驗發電機速度響應曲線，後段速度之調整，主要係以機組

頻率變化（發電機轉速）與功率變化（汽機或水輪機閥門的開度）的比值

為主要影響因子，此比值與調速機的速降率（Droop）成正比關係，如式

7-7 所示，故利用調整調速機參數的 k 值，即可對發電機速度響應後段曲

線進行擬合。除了前述慣性常數 H 值與調速機參數的 k 值對此試驗頻率

響應曲線的影響外，另一重要參數為調速機的閥門開關速度參數 Uc，此

參數為一負值，當負越大時表示閥門開閉較快，發電機的速度響應較快，

比較不會有過速之現象發生，反之當負越小時表示閥門開閉較慢，發電機

的速度響應較慢，易發生發電機過速之現象。而從圖 7-22 可以看出，現

有的和驗證後的模型參數似乎都不能準確地模擬汽輪機及調速機的離線

特性。但新驗證的模型在機組轉速得到穩態後與測量結果相符，從而表示

所給的調速器模型的放大倍數 K 值是合適的，模擬驗證方式如附錄 5。 

p

f
DroopR

k ∆
∆

∝= )(
1

           (7-7) 

此外，新驗證模型中氣門的開啓與關閉速率也是通過模擬擬合此試驗

而得出。而汽輪機的其它時間常數則由汽輪機時間常數試驗而得到（如下
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節蒸氣室時間常數測試）。圖 7-22 同時表明用新驗證的模型所得到的轉速

下降明顯地滯後于測量結果，這是因爲在此卸載試驗中，接于再熱器出口

的中壓截止閥有動作，從全開到關閉，然後又回到全開的位置，前後持續

數秒鐘（中壓截止閥的動作在試驗時觀察到）。因此大幅度地降低了機組

的超速。此試驗也表明現有調速機模型與實際測量結果有著更大的差異。 
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圖 7-21 部分卸載後發電機轉速上昇趨勢 
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圖 7-22 部分卸載後發電機轉速變化 
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7-10 大林#4蒸氣室(Steam chest)時間常數測試 

 

一、 測試說明 

蒸氣室(Steam Chest)時間常數測試，或稱汽輪機時間常數試驗用於確

定與汽輪機各段相對應的時間常數。當機組在線運行並帶有較重的負載情

況下，通過快速關閉進氣閥開度限制器，測定汽機蒸汽壓力的變化和機組

有效功率出力的響應來推測汽輪機的時間常數 T4 ,T5 和 T6（見 PSS/E 類

別 IEEEG1 汽輪機與調速機模型圖）。 

二、 求解過程  

圖 7-23 繪給出了在此試驗中測量到的有效功率與模擬實驗中所得到

的發電機有效功率變化，模擬驗證方式如附錄 6 所示。由圖可見，所選定

的汽輪機時間常數及調速機模型參數可以較好地模擬實際測量結果。而現

有模型則與實際測量結果有較大的差異。 

需要指出的通過此試驗只能夠保證汽輪機模型的總體響應結果與實

際相符，並不足以分別確定 T4 , T5 和 T6 單個時間常數。 
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圖 7-23 蒸氣室(Steam chest)時間常數測試之發電機有效功率 
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7-11 大林#4V/Hz限制器測試 

V/Hz 限制器測試是在機組運轉在額定轉速無載(主斷路器開啟)，激磁

機設定在 AVR 控制情況下，將原設定值改爲 103%，然後加入 5%步階信

號到 AVR 的參考設定點，圖 7-14 為測量結果。現場試驗時，觀測到此

V/Hz 限制器能夠正確動作。此 V/Hz 限制器為替代性設置，並且一旦動作，

將發電機端電壓維持在設定值直到由控制人員手動確認與解除爲止。 

 

圖 7-24  V/Hz 限制器測量結果 
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7-12 大林#4最低激磁限制器(Minimum Excitation Limiter)測試 

最低激磁限制器 (MEL) 測試試驗選定在機組有效出力大約為 80 

MW 時進行。測試時，首先將發電機的激磁電壓減少直至發電機進相，然

後加入一個負電壓步階信號 (-1.36 V) 到AVR的參考設定點，來檢驗MEL

的動態功能。圖 7-15 為測量結果，最低激磁限制器動作後，將發電機的

進相無效功率限制在約為 -60 MVar。 

 

 

 

圖 7-2 最低激磁限制器測量結果 
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7-13 大林#4最高激磁限制器 (Over Excitation Limiter)測試 

最高激磁限制器 (OEL) 測試試驗也是選定在機組有效出力大約為

80 MW 時進行。測試時，首先將發電機的激磁電壓升高到發電機無效功

率輸出大約為 104 MVAr (滯後功率因數)，然後加入一個電壓步階信號 

(1.32 V) 到 AVR 的參考設定點，來檢驗 OEL 的動態功能。圖 7-16 為測量

結果，當最高激磁限制器動作後，將發電機的無效功率限制在約為 160 

MVar。 

 

 

圖 7-26 最高激磁限制器測量結果 
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7-14 大林#4電力系統穩定器(Power System Stabilizer)測試 

對於數位式的電力系統穩定器（PSS）而言，用戶一般沒有必要測試

軟體的功能與正確性。在大林四號機上僅進行了 PSS 的功效試驗。實際試

驗分別在選定的303 MW和 353 MW (最大負載) 兩種狀況下進行，將PSS

切除與投入，並分別通過在電壓調節器（AVR）的參考設定點上加入 1.47 

V 的步階電壓信號來實現。此 1.47 V 的步階電壓信號大約在上述兩種負載

水平下分別導致 2.5%和 2.6%的機端電壓變化。 

由於在現場試驗期間，對電壓自動調節器的控制參數做了兩項改變，

因此，對電力系統穩定器的參數也作了相應的調整。圖 7-27 為約在 303 

MW 機組出力時 PSS 的作用之比較（此試驗是在電壓調節器的控制參數

改變之後，用原有 PSS 參數之下進行的）。顯然，PSS 的投入並沒有明顯

地改善發電機有效功率振盪的阻尼。PSS 的投入似乎僅有降低功率“噪音”

的作用。圖 7-28 為在機組最大出力時調整參數後的 PSS 作用之比較。可

以看出，調整參數後的 PSS 對降低有效功率的擺動有所幫助，但效果仍然

不十分明顯。其原因是即使在 PSS 退出運行後，該發電機組已經具有足夠

的阻尼。因此，本報告所描述的現場試驗不足以對 PSS 的功效作出結論性

的評估。建議使用驗證後的發電機與激磁系統模型，對四號機組上的 PSS

參數重新進行整定校驗。 
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圖 7-27 參數調整前的PSS在 303 MW負載時功效之比較(2.5%AVR步階
試驗) 
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圖 7-28 參數調整後的 PSS 在最大負載時功效之比較(2.6%AVR 步階試
驗) 
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捌捌捌捌、、、、    明潭電廠明潭電廠明潭電廠明潭電廠#3 發電機參數實測發電機參數實測發電機參數實測發電機參數實測前模擬前模擬前模擬前模擬 

 

8-1 發電機(Generator)參數量測 

一、 開路特性開路特性開路特性開路特性(飽和飽和飽和飽和)測試測試測試測試 

機組必須運轉在額定轉速沒有負載(主斷路器開路)，若為自激式靜態

激磁系統之磁場閃激(Flash)後發電機端電壓(Vt)可能高於額定電壓

的 30 %，可藉由調低機組磁場電壓，使發電機端電壓降至額定電壓

的 30 %，然後機組磁場電壓可以向前調昇，使發電機端電壓逐步上

升(每個步階約 1000 V)，直到機組最大的容忍極限。經由試驗求出

飽和參數 S1.0, S1.2。 

(一) 測試程序 

1. 機組運轉在額定速度。 

2. 發電機斷路器開路。 

3. 發電機電壓(Vt)遞昇加壓從 30 %至 120 %(若不允許可加至

105%)。 

4. 記錄 Vt, Ifd, Efd, f(Hz)。 

5. 經由試驗求出飽和參數 S1, S2。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

二、 磁場短路磁場短路磁場短路磁場短路(T´do)測試測試測試測試 

機組必須運轉在額定轉速且負載為零(主斷路器開路)，在 100%額定

發電機端電壓時，打開激磁場斷路器，移除機組之激磁電壓(Efd)，機

組磁場繞組被切換至去磁回路，因去磁電阻慎小繞組形同短路。T´do

時間常數經由磁場短路試驗來求得，方法是依據放電電阻的 V-I 特性

和轉子繞組溫度決定，但是這個試驗只能在有刷式激磁系統量測，無

刷式激磁系統無引出點，不易進行量測。 
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(一) 測試程序 

1. 機組運轉在額定速度。 

2. 發電機斷路器開路。 

3. 在 100%額定發電機端電壓時，打開磁場斷路器。 

4. 記錄 Vt, Ifd, Efd, f(Hz)。 

(二) 模擬案例 

無激磁場電壓資料，此測試無法進行事前模擬。 

 

三、 d 軸參數測試軸參數測試軸參數測試軸參數測試(MVAr 卸載試驗卸載試驗卸載試驗卸載試驗) 

機組要並聯入電力系統，調整有效功率輸出為 0 MW，並且大約輸

入 30%額定進相超前無效功率(- Q)，激磁系統使用手動控制模式維

持磁場電壓不變，調速機設定在 Speed droop 控制，然後機組斷路器

將被打開，無效功率負載跳脫。本模擬是將激磁機關閉(即激磁機之

輸出固定，如同他激)，所得之模擬結果。這個測試結果將被用來推

導 d 軸的暫態、次暫態阻抗和時間常數。 

(一) 測試程序 

1. 機組運轉在 0 MW 和 -30% 額定 MVAr。 

2. 激磁機使用手動控制維持磁場電壓不變。 

3. 調速機最低負載限制應設定為 0 MW。 

4. 記錄 Vt, Ifd, Efd。 

5. 打開發電機斷路器，無效功率卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構明潭電廠一號發電機組 d 軸參數測試電

力潮流模擬案例 MingTan-G1-DX.raw，在開啟斷路器前之負載狀況如

下，以此利用 PSAT 建立之電力潮流單線圖，如圖 8-1 所示： 

1. 實功率輸出 0 MW 
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2. 虛功率輸出-89.54 MVAr 

3. 發電機端電壓為 16.13 kV 
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圖 8-1  d 軸參數測試電力潮流案例（MingTan-G1-DX.raw） 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構明潭電廠一號發

電機組動態參數檔 MingTan-G1-PSSE.Dyn，利用 TSAT 產生模擬案例

MingTan-G1-DX.tsa 檔，在產生此檔過程同時建立監測檔

MingTan-G1-DX.mon 與開關切換檔 MingTan-G1-DX.swi。 

(三) 模擬結果 

明潭電廠一號發電機組 d 軸參數測試，模擬所得之發電機端電壓及發

電機磁場電流，如圖 8-2~8-3 所示： 
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圖 8-2  d 軸測試發電機端電壓 



 - 102 - 

Generator field current (pu)

Time (sec)
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圖 8-3  d 軸測試發電機磁場電流 

(四) 注意事項 

本模擬如圖 8-4 與圖 8-5 所示調整發電機端電壓，以達改變輸入虛功

Q 之目的。實測驗證模擬時，發電機端電壓須與實測時相同，改由改

變系統電壓，來調整 Q。 
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圖 8-4 不同負載狀況，發電機端電壓之變化(模擬 4 秒) 



 - 103 - 

0 60
0.5

0.55

0.6

0.65

0.7

0.75

0.8

0.85

0.9

0.95

1

Time (sec)

V
t 
(p

u
)

 

圖 8-5 不同負載狀況，發電機端電壓之變化(模擬 60 秒) 

 

四、 q 軸參數測試軸參數測試軸參數測試軸參數測試(部份部份部份部份 MW 卸載試驗一卸載試驗一卸載試驗一卸載試驗一) 

機組並入電力系統，首先調整有效功率輸出為 20% Rated MW，並

且在欠激情況下，激磁系統使用手動控制模式，調速機設定在 Speed 

droop 控制，量測轉子角度(Rotor angle)與負載角度(Load angle)是否

相同，若不相同則可調整磁場電壓使之相同，此時發電機電樞電流

和轉子 q 軸連成一線，機組斷路器必須在此特定情況下打開，完成

卸載試驗，這個測試結果將被用來推導 q 軸發電機參數。 

(一) 測試程序 

1. 機組運轉在 20 % MW 和進相超前-MVAr 情況下。 

2. 激磁機使用手動控制，調整磁場電壓使轉子角度與負載角度相同

(定子電流與轉子 q 軸在同一線上)。 

3. 調速機設定為 Speed droop 控制。 

4. 記錄 Vt, Ifd, Efd。 

5. 打開發電機斷路器，完成卸載試驗。 
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(二) 模擬案例 

利用前述測試程序條件，建構明潭電廠一號發電機組 q 軸參數測試電

力潮流模擬案例 MingTan-G1-QX.raw，在開啟斷路器前之負載狀況如

下，以此利用 PSAT 建立之電力潮流單線圖，如圖 8-6 所示： 

1. 實功率輸出 60 MW 

2. 虛功率輸出-17.41 MVAr 

3. 發電機端電壓為 16.55 kV 
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圖 8-6  q 軸參數測試電力潮流案例（MingTan-G1-QX.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構明潭電廠一號發

電機組動態參數檔 MingTan-G1-PSSE.Dyn，利用 TSAT 產生模擬案例

MingTan-G1-QX.tsa 檔，在產生此檔過程同時建立監測檔

MingTan-G1-QX.mon 與開關切換檔 MingTan-G1-QX.swi。 

(三) 模擬結果 

明潭電廠一號發電機組 q 軸參數測試，模擬所得之發電機端電壓及發

電機磁場電流，如圖 8-7 與圖 8-8 所示： 
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圖 8-7  q 軸測試發電機端電壓 
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圖 8-8  q 軸測試發電機磁場電流 

(四) 注意事項 

由式(8-1)與圖 8-9~圖 8-11 可知，在本模擬中估測的 H 值越大代表卸

除的實功越大，但頻率的變化卻沒成正比增加，推測可能是調速機動

作導致。 

)(

)(

2 pu

pue

df

dtP
H =              (8-1) 
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圖 8-9 不同負載狀況，發電機端電壓之變化 
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圖 8-10 不同負載狀況，發電機端電壓之變化(依照頻率變化修正後) 
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五、 部份負載卸載試驗二 

機組並入電力系統，首先調整有效功率輸出為大約 10%~20% Rated 

MW，並且在欠激情況下，激磁系統使用自動電壓調整(AVR)模式，

調速機設定在 Speed droop 控制，然後機組斷路器在此情況下打開，

完成卸載試驗，這個測試結果可以推導出(1)渦輪機和發電機之慣性

(Inertia)常數，(2)調速機模型參數包括速度低垂(Speed droop)百分比。 

(一) 測試程序 

1. 機組運轉在 10%~20% MW 和進相超前-10% Mvar 情況下。 

2. 激磁機使用自動電壓調整(AVR)模式。 

3. 調速機設定為 Speed droop 控制。 

4. 記錄 Vt, Ifd, Efd, f(Hz), Gate position。 

5. 打開發電機斷路器，完成卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構明潭電廠一號發電機組部份負載卸載試

驗電力潮流模擬案例 MingTan-G1-LR.raw，在開啟斷路器前之負載狀

況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 8-11 所示： 

1. 實功率輸出 60 MW 

2. 虛功率輸出-33.46 MVAr 

3. 發電機端電壓為 16.55 kV 
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圖 8-11  部份負載卸載試驗電力潮流案例（MingTan-G1-LR.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構明潭電廠一號發
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電 機 組 動 態 參 數 檔 MingTan-G1-PSSE.dyn 及 UDM 動 態 檔

Mingtan-G1-EXUDM.dat，利用 TSAT 產生模擬案例 MingTan-G1- 

LR.tsa 檔，在產生此檔過程同時建立監測檔 MingTan-G1-LR.mon 與開

關切換檔 MingTan-G1-LR.swi。 

(三) 模擬結果 

明潭電廠一號發電機組部份負載卸載試驗，模擬所得之發電機端電壓

與發電機頻率，如圖 8-12 與圖 8-13 所示： 
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圖 8-12  部份負載卸載試驗發電機端電壓 
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Generator speed (Hz)
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圖 8-13  部份負載卸載試驗發電機頻率 

8-2 激磁系統(Excitation system)測試 

六、 電壓調整器步階響應測試 

   機組運轉在額定轉速無載(主斷路器開啟)，激磁機必須設定在 AVR

控制(Auto mode)額定電壓情況下，個別加入 5 %和 10 %的步階信號

到 AVR 的參考設定點，此時發電機對應電壓分別為 100 %和 95 %

額定電壓，這個試驗是為了確認激磁機的模型參數。 

(一) 測試程序 

1. 機組運轉在額定速度(AVR mode)。 

2. 發電機斷路器開路。 

3. 在 100 %額定發電機端電壓時，加入 5 %步階信號。 

4. 重複在 95 %額定發電機端電壓時，加入 10 %步階信號，測出極

頂電壓和最低電壓。 

5. 試驗時記錄 Vt, Ifd, Efd, Step signal, AVR 輸出點和可以量測到的

點。 

(二) 模擬案例 
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利用前述測試程序條件，建構明潭電廠一號發電機組電壓調整器步階

響應測試電力潮流模擬案例 MingTan-G1-EX5.raw，在開啟斷路器前

之負載狀況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 8-14

所示： 

1. 實功率輸出 0 MW 

2. 虛功率輸出 0 MVAr 

3. 發電機端電壓為 16.46 kV 
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圖 8-14 步階響應試驗電力潮流案例（MingTan-G1-EX5.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構明潭電廠一號發

電 機 組 動 態 參 數 檔 MingTan-G1-PSSE.dyn 及 UDM 動 態 檔

Mingtan-G1-EXUDM.dat，利用 TSAT 產生模擬案例 MingTan-EX5 

-NL.tsa 檔，在產生此檔過程同時建立監測檔 MingTan-G1-EX5.mon

與開關切換檔 MingTan -EX5.swi。 

 

(三) 模擬結果 

明潭電廠一號發電機組電壓調整器步階響應試驗，模擬所得之發電機

端電壓，如圖 8-15 所示： 
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圖 8-15  步階響應試驗發電機端電壓 
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圖 16 不同 TE 之變化 

 

七、 無效功率電流補償(電壓低垂，線路壓降補償)測試 

機組要並聯入電力系統，調整有效功率輸出為 0 MW，並且大約輸
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入 30%額定 MVAr 進相超前無效功率，激磁系統使用 AVR 模式，然

後機組斷路器將被打開，無效功率負載跳脫，這個測試是為了驗證

電流補償設定和激磁系統模型參數，包含 AVR 增益 KA。 

(一) 測試程序 

1. 機組運轉在 0 MW 和 -30% 額定 MVar。 

2. 激磁機使用 AVR 控制模式。 

3. 調速機最低負載限制應設定為 0 MW。 

4. 記錄 Vt, Ifd, Efd。 

5. 打開發電機斷路器，無效功率卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構明潭電廠一號發電機組無效功率電流補

償測試電力潮流模擬案例 MingTan-G1-QC.raw，在開啟斷路器前之負

載狀況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 8-16 所示： 

甲、 實功率輸出 0 MW 

乙、 虛功率輸出-89.54 MVAr 

丙、 發電機端電壓為 16.13 kV 
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圖 8-16 無效功率電流補償測試電力潮流案例（MingTan-G1-QC.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構明潭電廠一號發

電機組動態參數檔MingTan-G1-PSSE.dyn 及 UDM 動態檔 Mingtan-G1 

-EXUDM.dat，利用 TSAT 產生模擬案例 MingTan-G1-QC.tsa 檔，在產

生此檔過程同時建立監測檔 MingTan-G1-QC.mon 與開關切換檔
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MingTan-G1-QC.swi。 

(三) 模擬結果 

明潭電廠一號發電機組電壓調整器步階響應試驗，模擬所得之發電機

端電壓，如圖 8-17 所示： 

 
Generator terminal voltage (pu)

Time (sec)

0.00 8.99 17.99 26.98 35.97 44.97
0.91

0.92

0.94

0.95

0.97

0.98

 

圖 8-17 無效功率電流補償測試發電機端電壓 

 

八、 V/Hz 限制器測試 

機組運轉在額定轉速無載(主斷路器開啟)，激磁機必須設定在 AVR

控制(auto mode)額定電壓情況下，加入 10%的步階信號到 AVR 的參

考設定點，時間要比限制器延時動作時間長，這樣可以監視 V/Hz

限制器動作反應是否正確。 

(一) 測試程序 

1. 機組運轉在額定速度(AVR mode)。 

2. 發電機斷路器開路。 

3. 在 100%額定發電機端電壓時，加入 10%步階信號。 

4. 加入 10%步階信號，時間要比限制器延時動作時間長。 

5. 試驗時記錄 Vt, Ifd, Efd, f(Hz),Step signal 輸出點和可以量測到的點。 
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(二) 模擬案例 

此測試無法進行事前模擬。 

九、 最低激磁限制器(Under(Minimum) Excitation Limiter)測試 

最低激磁限制器測試時機組並聯入電力系統，機組調整有效功率輸

出分別為 0%, 25%, 50, 75%和 100% MW 負載，並且逐漸減少發電機

磁場電壓直到 UEL 限制器動作，亦可在每個設定的負載情況下，加

入一個負電壓步階信號到 AVR 的參考設定點，來檢驗 UEL 的動態

功能。 

(一) 測試程序 

1. 機組運轉在 0%, 25%, 50,75%和 100% MW 負載。 

2. 激磁機使用 AVR 控制模式。 

3. 根據 1 不同負載，調降激磁電壓直到 UEL 動作。 

4. 記錄 Vt, Ifd, Efd, MW, MVAr。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

一〇、最高激磁限制器(Over(Maximum) Excitation Limiter)測試 

最高激磁限制器測試時機組並聯入電力系統，機組調整有效功率輸

出分別為 0%, 25%, 50 %,75 %和 100% MW 負載，並且逐漸增加發

電機磁場電壓直到 OEL 限制器動作，亦可在每個設定的負載情況

下，加入一個步階信號到 AVR 的參考設定點，來檢驗 OEL 的動態

功能。 

(一) 測試程序 

1. 機組運轉在 0%, 25%, 50, 75%和 100% MW 負載。 

2. 激磁機使用 AVR 控制模式。 

3. 根據 1 不同負載，調升激磁電壓直到 UEL 動作。 

4. 記錄 Vt, Ifd, Efd, MW, MVAr。 
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(二) 模擬案例 

此測試無法進行事前模擬。 

 

一一、電力系統穩定器(Power System Stabilizer)測試 

對數位式的 PSS 而言，頻率響應測試並不是必要的測試，但是從 PSS

輸入端加入步階信號測試其暫態時間響應則是必要的，最後機組並

聯入電力系統，在滿載時測試其動態特性，檢驗 PSS 對小信號穩定

度(系統低頻振盪)的貢獻。 

(一) 測試程序 

1. 機組運轉在 100% MW 負載。 

2. 激磁機使用 AVR 控制模式。 

3. AVR 輸入端加入 3%的步階信號，觀察機組與系統的擾動。 

4. 當 PSS OFF 和 ON 時，個別記錄 Vt, Ifd, Efd, MW, MVar。 

(二) 模擬案例 

利用前述測試程序條件，建構明潭電廠一號發電機組電力系統穩定器

測試電力潮流模擬案例 MingTan-G1-EX5.raw，在開啟斷路器前之負

載狀況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 8-18 所示： 

1. 實功率輸出 250 MW 

2. 虛功率輸出 18.25 MVAr 

3. 發電機端電壓為 15.64 kV 
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圖 8-18 電力系統穩定器測試電力潮流案例（HsiehHo-G4-EX5.raw） 
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利用現有發電機、調速機、勵磁機與 PSS 參數，建構明潭電廠一號發

電 機 組 動 態 參 數 檔 MingTan-G1-PSSE.dyn 及 UDM 動 態 檔

Mingtan-G1-EXUDM.dat，利用 TSAT 產生模擬案例 Mingtan-G1 

-EX5.tsa 檔，在產生此檔過程同時建立監測檔 Mingtan-G1-EX5.mon

與開關切換檔 Mingtan -EX5.swi。 

(三) 模擬結果 

明潭電廠一號發電機組電力系統穩定器測試，模擬所得發電機在 PSS

啟動及關閉之實功率變化，如圖 8-19 所示： 

 
Generator active power (MW)

Time (sec)

0.00 6.17 12.34 18.51 24.68 30.85
243.00

245.80

248.60

251.40

254.20

257.00

PSS ON
0.64Hz, 29%

 

Generator active power (MW)

Time (sec)

0.00 6.17 12.34 18.51 24.68 30.85
236.00

241.60

247.20

252.80

258.40

264.00

PSS OFF

1.39Hz,15.5%

 

 (a) PSS ON         (b) PSS ON 

圖 8-19  PSS 開閉之發電機實功率變化 
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8-3 渦輪與調速機(Governor)測試 

一二、部份負載卸載試驗(同發電機參數量測，但記錄不同參數信號) 

機組並聯入電力系統，首先調整有效功率輸出為大約 10%~20% rated 

MW，並且在欠激情況下，激磁系統使用自動電壓調整(AVR)模式，

調速機設定在 Speed droop 控制，然後機組斷路器在此情況下打開，

完成卸載試驗，這個測試結果可以推導出(1)渦輪機和發電機之慣性

(Inertia)常數，(2)調速機模型參數包括速度低垂(Speed droop)百分

比，用以確認調速機模型參數。 

(一) 測試程序 

機組運轉在 10%~20% MW 和進相超前-10%Mvar 情況下。 

1. 激磁機使用自動電壓調整(AVR)模式。 

2. 調速機設定為 Speed droop 控制。 

3. 記錄 Vt, Ifd, Efd, f(Hz), Gate position。 

4. 打開發電機斷路器，完成卸載試驗。 

(二) 模擬案例 

同發電機部份負載卸載試驗案例。 

 

一三、調速機步階響應測試 

機組並聯入電力系統，首先調整有效功率輸出為大約 80% rated 

MW，激磁系統使用自動電壓調整(AVR)模式，調速機設定在 Speed 

droop 控制，加入頻率步階信號至調速機控制器速度參考點，藉由測

試決定不動帶(Dead band)、速度調整和控制範圍，這個測試結果可

以檢查出調速機速度調整設定，並且建立調速機模型參數。 

(一) 測試程序 

機組運轉在 80% MW。 

1. 激磁機使用自動電壓調整(AVR)模式。 

2. 調速機設定為 Speed droop 控制。 
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3. 測試不同大小的步階信號至調速機控制器速度參考點，決定不動

帶(Dead band)、速度(Droop)調整和其它參數。 

4. 試驗同時記錄 MW, Speed, flow, f(Hz), Gate position 和負載設定。 

(二) 模擬案例 

大部份的調速機很難進行頻率步階響應測試，此測試無法進行事前

模擬。 

 

一四、水始動時間測試(只有水力機組適用) 

機組並聯入電力系統，首先調整有效功率輸出為大約 80% rated 

MW，無效功率輸出相對並不重要，測試時機組負載瞬間由導翼限

制器降至 50%，機組穩定後再由導翼限制器調升至 65%，從這個測

試可以決定水的時間常數和調速機系統的不動帶(Dead band)。 

(一) 測試程序 

1. 機組運轉在 80% MW。 

2. 快速將導翼限制器降負載至 50%。 

3. 試驗同時記錄 MW, Speed, flow, f(Hz), Gate position 和緩衝壺

(dashpot)連桿位移。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

一五、調速機速度低垂(droop)測試(僅適用於水力機組) 

調速機速度調整器之操作可得到導翼位置和負載的對應關係，和導

翼位置和機組速度的特性，這兩組特性互相連結，可以決定整個調

速機操作範圍速度低垂(droop)百分比的設定。 

(一) 測試程序 

1. 依據不同型式調速機實際驗證。 

2. 並聯量測機組出力和速度參考值(例如氣渦輪機組)。 
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3. 量測油壓設定點和機組無載速度及量測油壓設定點和機組負載輸

出之對應關係(例如汽渦輪機組)。 

4. 量測速度調整器和機組無載速度及量測速度調整器和機組負載輸

出之對應關係(例如水輪機組)。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

一六、緩衝壺(Dashpot)時間常數測試(僅適用於水力機組) 

機組運轉在無載額定速度，藉由導翼限制器增加/減少將機組速度快

速改變，同時記錄緩衝壺連桿和導翼的位移。 

(一) 測試程序 

1. 依據不同型式調速機實際驗證。 

2. 量測記錄緩衝壺連桿位移、翼連桿位移和時間之對應關係。 

(二) 模擬案例 

此測試無法進行事前模擬。 
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玖玖玖玖、、、、    協和電廠協和電廠協和電廠協和電廠#4 發電機參數實測前模擬發電機參數實測前模擬發電機參數實測前模擬發電機參數實測前模擬 

9-1 發電機(Generator)參數量測 

一、 開路特性(飽和)測試 

機組必須運轉在額定轉速沒有負載(主斷路器開路)，若為自激式靜態

激磁系統之磁場閃激(Flash)後發電機端電壓(Vt)可能高於額定電壓

的 30 %，可藉由調低機組磁場電壓，使發電機端電壓降至額定電壓

的 30 %，然後機組磁場電壓可以向前調昇，使發電機端電壓逐步上

升(每個步階約 1000 V)，直到機組最大的容忍極限。經由試驗求出

飽和參數 S1, S2。 

(一) 測試程序 

1. 機組運轉在額定速度。 

2. 發電機斷路器開路。 

3. 發電機電壓(Vt)遞昇加壓從 30 %至 120 %(若不允許可加至

105%)。 

4. 記錄 Vt, Ifd, Efd, f(Hz)。 

5. 經由試驗求出飽和參數 S1, S2。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

二、 磁場短路(T´do)測試 

機組必須運轉在額定轉速且負載為零(主斷路器開路)，在 100%額定

發電機端電壓時，打開激磁場斷路器，移除機組之激磁電壓(Efd)，機

組磁場繞組被切換至去磁回路，因去磁電阻慎小繞組形同短路。T´do

時間常數經由磁場短路試驗來求得，方法是依據放電電阻的 V-I 特性

和轉子繞組溫度決定，但是這個試驗只能在有刷式激磁系統量測，無

刷式激磁系統無引出點，不易進行量測。 
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(一) 測試程序 

1. 機組運轉在額定速度。 

2. 發電機斷路器開路。 

3. 在 100 %額定發電機端電壓時，打開磁場斷路器。 

4. 記錄 Vt, Ifd, Efd, f(Hz)。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

三、 d 軸參數測試(MVAr 卸載試驗) 

機組要並聯入電力系統，調整有效功率輸出為 0 MW，並且大約輸

入 30%額定進相超前無效功率，激磁系統使用手動控制模式，然後

機組斷路器將被打開，無效功率負載跳脫，這個測試結果將被用來

推導 d 軸的暫態、次暫態阻抗和時間常數。 

(一) 測試程序 

1. 機組運轉在 0 MW 和 -30% 額定 MVAr。 

2. 激磁機使用手動控制維持磁場電壓不變。 

3. 調速機最低負載限制應設定為 0 MW。 

4. 記錄 Vt, Ifd, Efd。 

5. 打開發電機斷路器，無效功率卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構協和電廠四號發電機組 d 軸參數測試電

力潮流模擬案例 HsiehHo-G4-DX.raw，在開啟斷路器前之負載狀況如

下，以此利用 PSAT 建立之電力潮流單線圖，如圖 9-1 所示： 

1. 實功率輸出 0 MW 

2. 虛功率輸出-162.78 MVAr 

3. 發電機端電壓為 17.24 kV 
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圖 9-1 d 軸參數測試電力潮流案例（HsiehHo-G4-DX.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構協和電廠四號發

電機組動態參數檔 HsiehHo-G4-PSSE.dyn，利用 TSAT 產生模擬案例

HsiehHo-G4-DX.tsa 檔，在產生此檔過程同時建立監測檔

HsiehHo-G4-DX.mon 與開關切換檔 HsiehHo-G4-DX.swi。 

(三) 模擬結果 

協和電廠四號發電機組 d 軸參數測試，模擬所得之發電機端電壓及發

電機磁場電流，如圖 9-2~3 所示： 

 
Generator terminal voltage (pu)

Time (sec)

0.00 8.99 17.99 26.98 35.97 44.97
0.40

0.52

0.64

0.76

0.88

1.00

 

圖 9-2  d 軸測試發電機端電壓 
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Generator field current (pu)

Time (sec)

0.00 8.99 17.99 26.98 35.97 44.97
0.40

0.50

0.60

0.70

0.80

0.90

 

圖 9-3  d 軸測試發電機磁場電流 

 

四、 q 軸參數測試(部份 MW 卸載試驗一) 

機組並入電力系統，首先調整有效功率輸出為 20% Rated MW，並

且在欠激情況下，激磁系統使用手動控制模式，調速機設定在 Speed 

droop 控制，量測轉子角度(Rotor angle)與負載角度(Load angle)是否

相同，若不相同則可調整磁場電壓使之相同，此時發電機電樞電流

和轉子 q 軸連成一線，機組斷路器必須在此特定情況下打開，完成

卸載試驗，這個測試結果將被用來推導 q 軸發電機參數。 

(一) 測試程序 

1. 機組運轉在 20 % MW 和進相超前-MVAr 情況下。 

2. 激磁機使用手動控制，調整磁場電壓使轉子角度與負載角度相

同(定子電流與轉子 q 軸在同一線上)。 

3. 調速機設定為 Speed droop 控制。 

4. 記錄 Vt, Ifd, Efd。 

5. 打開發電機斷路器，完成卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構協和電廠四號發電機組 q 軸參數測試電
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力潮流模擬案例 HsiehHo-G4-QX.raw，在開啟斷路器前之負載狀況如

下，以此利用 PSAT 建立之電力潮流單線圖，如圖 9-4 所示： 

1. 實功率輸出 60 MW 

2. 虛功率輸出-17.41 MVAr 

3. 發電機端電壓為 18.05 kV 
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圖 9-4  q 軸參數測試電力潮流案例（HsiehHo-G4-QX.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構協和電廠四號發

電機組動態參數檔 HsiehHo-G4-PSSE.dyn，利用 TSAT 產生模擬案例

HsiehHo-G4-QX.tsa 檔，在產生此檔過程同時建立監測檔

HsiehHo-G4-QX.mon 與開關切換檔 HsiehHo-G4-QX.swi。 

(三) 模擬結果 

協和電廠四號發電機組 q 軸參數測試，模擬所得之發電機端電壓及發

電機磁場電流，如圖 9-5~6 所示： 
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Generator terminal voltage (pu)
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圖 9-5  q 軸測試發電機端電壓 

 
Generator field current (pu)
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圖 9-6  q 軸測試發電機磁場電流 
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五、 部份負載卸載試驗二 

機組並入電力系統，首先調整有效功率輸出為大約 10%~20% Rated 

MW，並且在欠激情況下，激磁系統使用自動電壓調整(AVR)模式，

調速機設定在 Speed droop 控制，然後機組斷路器在此情況下打開，

完成卸載試驗，這個測試結果可以推導出(1)渦輪機和發電機之慣性

(Inertia)常數，(2)調速機模型參數包括速度低垂(Speed droop)百分比。 

(一) 測試程序 

6. 機組運轉在 10%~20% MW 和進相超前-10% Mvar 情況下。 

7. 激磁機使用自動電壓調整(AVR)模式。 

8. 調速機設定為 Speed droop 控制。 

9. 記錄 Vt, Ifd, Efd, f(Hz), Gate position。 

10. 打開發電機斷路器，完成卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構協和電廠四號發電機組部份負載卸載試

驗電力潮流模擬案例 HsiehHo-G4-LR.raw，在開啟斷路器前之負載狀

況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 9-7 所示： 

1. 實功率輸出 60 MW 

2. 虛功率輸出-33.46 MVAr 

3. 發電機端電壓為 18.05 kV 
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圖 9-7  部份負載卸載試驗電力潮流案例（HsiehHo-G4-LR.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構協和電廠四號發
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電機組動態參數檔 HsiehHo-G4-PSSE.dyn，利用 TSAT 產生模擬案例

HsiehHo-G4-LR.tsa 檔，在產生此檔過程同時建立監測檔

HsiehHo-G4-LR.mon 與開關切換檔 HsiehHo-G4-LR.swi。 

(三) 模擬結果 

協和電廠四號發電機組部份負載卸載試驗，模擬所得之發電機端電壓

與發電機頻率，如圖 9-8~9 所示： 
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圖 9-8  部份負載卸載試驗發電機端電壓 

 



 - 128 - 

Generator speed (Hz)

Time (sec)
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圖 9-9  部份負載卸載試驗發電機頻率 

9-2 激磁系統(Excitation system)測試 

六、 電壓調整器步階響應測試 

   機組運轉在額定轉速無載(主斷路器開啟)，激磁機必須設定在 AVR

控制(Auto mode)額定電壓情況下，個別加入 5 %和 10 %的步階信號

到 AVR 的參考設定點，此時發電機對應電壓分別為 100 %和 95 %

額定電壓，這個試驗是為了確認激磁機的模型參數。 

(四) 測試程序 

6. 機組運轉在額定速度(AVR mode)。 

7. 發電機斷路器開路。 

8. 在 100 %額定發電機端電壓時，加入 5 %步階信號。 

9. 重複在 95 %額定發電機端電壓時，加入 10 %步階信號，測出極

頂電壓和最低電壓。 

10. 試驗時記錄 Vt, Ifd, Efd, Step signal, AVR 輸出點和可以量測到的
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點。 

(五) 模擬案例 

利用前述測試程序條件，建構協和電廠四號發電機組電壓調整器步階

響應測試電力潮流模擬案例 HsiehHo-G4-EX5-NL.raw，在開啟斷路器

前之負載狀況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 9-10

所示： 

1. 實功率輸出 0 MW 

2. 虛功率輸出 0 MVAr 

3. 發電機端電壓為 17.77 kV 
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圖 9-10 步階響應試驗電力潮流案例（HsiehHo-G4-EX5-NL.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構協和電廠四號發

電機組動態參數檔 HsiehHo-G4-PSSE.dyn，利用 TSAT 產生模擬案例

HsiehHo-G4-EX5-NL.tsa 檔，在產生此檔過程同時建立監測檔

HsiehHo-G4-EX5-NL.mon 與開關切換檔 HsiehHo-G4-EX5-NL.swi。 

(六) 模擬結果 

協和電廠四號發電機組電壓調整器步階響應試驗，模擬所得之發電機

端電壓，如圖 9-11 所示： 
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圖 9-11  步階響應試驗發電機端電壓 

 

七、 無效功率電流補償(電壓低垂,線路壓降補償)測試 

機組要並聯入電力系統，調整有效功率輸出為 0 MW，並且大約輸

入 30%額定 MVAr 進相超前無效功率，激磁系統使用 AVR 模式，然

後機組斷路器將被打開，無效功率負載跳脫，這個測試是為了驗證

電流補償設定和激磁系統模型參數，包含 AVR 增益 KA。 

(一) 測試程序 

6. 機組運轉在 0 MW 和 -30% 額定 MVar。 

7. 激磁機使用 AVR 控制模式。 

8. 調速機最低負載限制應設定為 0 MW。 

9. 記錄 Vt, Ifd, Efd。 

10. 打開發電機斷路器，無效功率卸載試驗。 

(二) 模擬案例 

利用前述測試程序條件，建構協和電廠四號發電機組無效功率電流補

償測試電力潮流模擬案例 HsiehHo-G4-QC.raw，在開啟斷路器前之負

載狀況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 9-12 所示： 
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1. 實功率輸出 0 MW 

2. 虛功率輸出-162.78 MVAr 

3. 發電機端電壓為 17.24 kV 
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圖 9-12 無效功率電流補償測試電力潮流案例（HsiehHo-G4-QC.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構協和電廠四號發

電機組動態參數檔 HsiehHo-G4-PSSE.dyn，利用 TSAT 產生模擬案例

HsiehHo-G4-QC.tsa 檔 ， 在 產 生 此 檔 過 程 同 時 建 立 監 測 檔

HsiehHo-G4-QC.mon 與開關切換檔 HsiehHo-G4-QC.swi。 

(三) 模擬結果 

協和電廠四號發電機組電壓調整器步階響應試驗，模擬所得之發電機

端電壓，如圖 9-13 所示： 
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圖 9-13 無效功率電流補償測試發電機端電壓 

 

八、 V/Hz 限制器測試 

機組運轉在額定轉速無載(主斷路器開啟)，激磁機必須設定在 AVR

控制(auto mode)額定電壓情況下，加入 10%的步階信號到 AVR 的參

考設定點，時間要比限制器延時動作時間長，這樣可以監視 V/Hz

限制器動作反應是否正確。 

(一) 測試程序 

1. 機組運轉在額定速度(AVR mode)。 

2. 發電機斷路器開路。 

3. 在 100%額定發電機端電壓時，加入 10%步階信號。 

4. 加入 10%步階信號，時間要比限制器延時動作時間長。 

5. 試驗時記 Vt, Ifd, Efd, f(Hz),Step signal 輸出點和可以量測到的點。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

九、 最低激磁限制器(Under(Minimum) Excitation Limiter)測試 

最低激磁限制器測試時機組並聯入電力系統，機組調整有效功率輸
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出分別為 0%, 25%, 50, 75%和 100% MW 負載，並且逐漸減少發電機

磁場電壓直到 UEL 限制器動作，亦可在每個設定的負載情況下，加

入一個負電壓步階信號到 AVR 的參考設定點，來檢驗 UEL 的動態

功能。 

(一) 測試程序 

1. 機組運轉在 0%, 25%, 50,75%和 100% MW 負載。 

2. 激磁機使用 AVR 控制模式。 

3. 根據 1 不同負載，調降激磁電壓直到 UEL 動作。 

4. 記錄 Vt, Ifd, Efd, MW, MVAr。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

一〇、 最高激磁限制器(Over(Maximum) Excitation Limiter)測試 

最高激磁限制器測試時機組並聯入電力系統，機組調整有效功率輸

出分別為 0%, 25%, 50 %,75 %和 100% MW 負載，並且逐漸增加發

電機磁場電壓直到 OEL 限制器動作，亦可在每個設定的負載情況

下，加入一個步階信號到 AVR 的參考設定點，來檢驗 OEL 的動態

功能。 

(一) 測試程序 

1. 機組運轉在 0%, 25%, 50, 75%和 100% MW 負載。 

2. 激磁機使用 AVR 控制模式。 

3. 根據 1 不同負載，調升激磁電壓直到 UEL 動作。 

4. 記錄 Vt, Ifd, Efd, MW, MVAr。 

(二) 模擬案例 

此測試無法進行事前模擬。 

 

一一、 電力系統穩定器(Power System Stabilizer)測試 
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對數位式的 PSS 而言，頻率響應測試並不是必要的測試，但是從 PSS

輸入端加入步階信號測試其暫態時間響應則是必要的，最後機組並

聯入電力系統，在滿載時測試其動態特性，檢驗 PSS 對小信號穩定

度(系統低頻振盪)的貢獻。 

(一) 測試程序 

5. 機組運轉在 100% MW 負載。 

6. 激磁機使用 AVR 控制模式。 

7. AVR 輸入端加入 3%的步階信號，觀察機組與系統的擾動。 

8. 當 PSS OFF 和 ON 時，個別記錄 Vt, Ifd, Efd, MW, MVar。 

(二) 模擬案例 

利用前述測試程序條件，建構協和電廠四號發電機組電力系統穩定器

測試電力潮流模擬案例 HsiehHo-G4-EX5-full-load.raw，在開啟斷路器

前之負載狀況如下，以此利用 PSAT 建立之電力潮流單線圖，如圖 9-14

所示： 

1. 實功率輸出 560 MW 

2. 虛功率輸出-15.09 MVAr 

3. 發電機端電壓為 17.60 kV 
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圖 9-14 電力系統穩定器測試電力潮流案例

（HsiehHo-G4-EX5-full-load.raw） 

 

利用現有發電機、調速機、勵磁機與 PSS 參數，建構協和電廠四號發

電機組動態參數檔 HsiehHo-PSS-on-PSSE-EXBAS.dyn，利用 TSAT 產
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生模擬案例 HsiehHo-G4-PSS-ON-EX5.tsa 檔，在產生此檔過程同時建

立監測檔 HsiehHo-G4-EX5.mon 與開關切換檔 HsiehHo-G4-EX5.swi。 

(三) 模擬結果 

協和電廠四號發電機組電力系統穩定器測試，模擬所得發電機在 PSS

啟動及關閉之實功率變化，如圖 9-15 所示： 
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      (a) PSS ON            (b) PSS ON 

圖 9-15  PSS 開閉之發電機實功率變化 
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if = ：the frequency (Hz) of the ith mode. 
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22 ωσ

σ
ς

+
= i  the damping ratio of the ith mode. 

θi ：The phase (rad) of the ith mode in the signal. 

9-3 渦輪與調速機(Governor)測試 

一二、 部份負載卸載試驗(同發電機參數量測，但記錄不同參數信號) 

機組並聯入電力系統，首先調整有效功率輸出為大約 10%~20% rated 

MW，並且在欠激情況下，激磁系統使用自動電壓調整(AVR)模式，

調速機設定在 Speed droop 控制，然後機組斷路器在此情況下打開，

完成卸載試驗，這個測試結果可以推導出(1)渦輪機和發電機之慣性

(Inertia)常數，(2)調速機模型參數包括速度低垂(Speed droop)百分

比，用以確認調速機模型參數。 

(一) 測試程序 

機組運轉在 10%~20% MW 和進相超前-10%Mvar 情況下。 

1. 激磁機使用自動電壓調整(AVR)模式。 

2. 調速機設定為 Speed droop 控制。 

3. 記錄 Vt, Ifd, Efd, f(Hz), Gate position。 

4. 打開發電機斷路器，完成卸載試驗。 

(二) 模擬案例 

同發電機部份負載卸載試驗案例。 

 

一三、 調速機步階響應測試 

機組並聯入電力系統，首先調整有效功率輸出為大約 80% rated 

MW，激磁系統使用自動電壓調整(AVR)模式，調速機設定在 Speed 

droop 控制，加入頻率步階信號至調速機控制器速度參考點，藉由測

試決定不動帶(Dead band)、速度調整和控制範圍，這個測試結果可

以檢查出調速機速度調整設定，並且建立調速機模型參數。 
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(一) 測試程序 

機組運轉在 80% MW。 

3. 激磁機使用自動電壓調整(AVR)模式。 

4. 調速機設定為 Speed droop 控制。 

5. 測試不同大小的步階信號至調速機控制器速度參考點，決定不動

帶(Dead band)、速度(Droop)調整和其它參數。 

6. 試驗同時記錄 MW, Speed, flow, f(Hz), Gate position 和負載設定。 

(二) 模擬案例 

大部份的調速機很難進行頻率步階響應測試，此測試無法進行事前

模擬。 

 

一四、 蒸氣室(Steam chest)時間常數測試(僅適用於汽渦輪機組) 

機組並聯入電力系統，首先調整有效功率輸出為大約 80% rated 

MW，無效功率輸出相對並不重要，機組負載瞬間由蒸氣閥開度限

制器降至 75%，當穩定之後，再由蒸氣閥開度限制器將負載提升至

80%，從這個測試可以決定蒸氣室的時間常數。 

(一) 測試程序 

1. 機組運轉在 80 % MW。 

2. 快速將蒸氣閥開度限制器降至 75 %負載，穩定後再提升至 80 %

負載。 

3. 試驗同時記錄蒸氣閥開度和時間之對應關係。 

(二) 模擬案例 

此測試無法進行事前模擬。 
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壹拾壹拾壹拾壹拾、、、、    發電機線上發電機線上發電機線上發電機線上(on line)量測研習心得量測研習心得量測研習心得量測研習心得與與與與建議建議建議建議 

 

10-1 研習心得 

本次前往 PLI研習的重點之一就是借助 PLI的經驗評估台灣電力系統

建構 On-line 發電機參數測量之技術與可行性，依據 PLI 馮博士的說明，

PLI 目前並無執行發電機 On-line 參數測量之經驗，但是他們也有注意其

相關技術之發展。發電機組量測最主要的三個部分:發電機、激磁機及原

動機，On-line 參數測量也是相同，由於這三個部分其時間響應速度不同，

因此必須分開考慮。 

激磁機 On-line 參數測量是目前論文較多的部分，主要是於 AVR 參考

端輸入不同的波形並觀察發電機輸出電壓之改變來求取激磁機參數，因為

這部份是三者中響應最快的而且輸入的波形可以依據激磁機的種類決

定，所以求取參數的難度較低，可行性較高，至於輸入哪些波形可以有效

將參數求出是研究重點。 

發電機 On-line 參數測量主要是求取穩態參數，如 Xd, Xq等。利用一

般日常在不同時間點上其不同的工作點調整穩態參數使模擬的激磁電流

與現實量測到的激磁電流誤差最小，這樣的量測雖然無法求的暫態及次暫

態方面之參數，但是穩態參數是在日常的工作點求得，故其代表性比在特

殊狀態下(Off-line 量測)求得之參數更佳。至於暫態及次暫態方面參數則有

論文利用長時間系統擾動去做微調參數進行擬合而得到。 

原動機 On-line 參數測量主要是求取慣量及其響應時間常數，可以利

用系統事故造成之擾動來測得，但前提是擾動要夠大，比設定的死區(dead 

band)更大，同時發電機組的工作點不是在最大出力時才有用，此外，量

測器需要具備有同步量測(廠內及廠外)的能力才能比較出其響應時間常

數。此部分求取參數的難度不高，難的是等待系統發生足夠大事故的時

間，因此利用 On-line 調速機步階響應是較為可行的方法。 

雖然目前 On-line 參數測量技術尚不足已取代 Off-line 參數測量，但

是 On-line 量測具有許多執行量測上的優點，是值得投入研究的一個領域。 

 



 - 139 - 

10-2 建議事項 

就台灣電力系統建構On-line 發電機參數測量之技術與可行性評估之

討論主題提出幾項 Q & A，如下面說明：. 

一、 電力系統建構 On-line 發電機參數測量之國外實例。  

解答解答解答解答：：：：目前大陸做得最多，其它如印度、美國也有。 

二、 On-line 發電機參數測量之測試項目與參數。 

解答解答解答解答：：：：On-line 發電機參數測量沒有測試項目，反正就是等有擾

動時調整參數，但是我也有看到一篇論文刻意於激磁機的參考

點加入步階訊號進行量測。至於模型中的參數我想幾乎都可以

調整，除了 S1.0及 S1.2。 

三、 On-line 發電機參數測量之暫態與事件類型。 

解答解答解答解答：只要是較大的擾動都可以，當然擾動越大效果越好。 

四、 On-line 發電機參數測量之設備與監測位置。 

解答解答解答解答：量測設備上無特殊需求，我想歐華的 ADX7000 系列就

可以，主要是可以設定需要的觸發條件，以及資料傳輸要方便，

因為 On-Line 量測需要反覆調整及模擬驗證，驗證需要 PSSE

或 DSAtool 等軟體，所以另外準備一台電腦與量測設備連接是

必要的，除非您希望歐華開發出內建 PSSE 或 DSAtool 等軟體

的量測設備。至於監測位置與 Off-Line 相似，收得到所有訊號

及方便大家工作就可以了。 

五、 On-line 發電機參數測量之最佳時段與季節。 

解答解答解答解答：前面有提過目前我看到的 On-Line 量測都只是 On- Line

調整，所以可能無法希望一台從未量測過的發電機利用 On-Line

量測後，模型及參數就全得到了，而是將已經模型確定但很久

沒確認過參數的機組來 On-Line 量測較好。所以您說台電有一

堆發電機有更新過激磁機或其它部分，那這些發電可能都不適

合，除非廠商提供相當接近的模型及參數。 
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捌捌捌捌、、、、附錄附錄附錄附錄 

附錄附錄附錄附錄 1 大林大林大林大林 4 號發電機號發電機號發電機號發電機 D 軸卸載測試軸卸載測試軸卸載測試軸卸載測試 

 

發電機直軸（D-Axis）試驗主要在驗證發電機直軸（D-Axis）電抗值（Xd、X
’
d、X

’’
d）

及時間常數（T
’
d0、T

’’
d0）。此一試驗為虛功率卸載試驗，機組要先並聯入電力系統，

調整發電機有效功率輸出接近為 0 MW，並且大約輸入 30%額定進相無效功率(超前功

率因數)，設定激磁系統為手動控制模式，以維持發電機激磁電壓於斷路器開啟前後一

致，然後打開發電機組主斷路器。這個測試結果將被用來推導發電機 D 軸的穩態、暫

態、次暫態電抗和時間常數。 

大林 4 號發電機 D 軸參數試驗在實際打開機組主斷路器前，發電機的實際運行狀況如

下： 

• 有效功率輸出 2.02 MW  

• 無效功率輸出 -72.21 MVAr(欠勵) 

• 發電機端電壓 15.54 kV ( 15.54/17 = 0.9142 p.u.) 

 

Step 1. 先利用 PSAT 建立單機無限匯流排的基本架構 

（1）先建立單機無限匯流排 

 

（2）再建立單機匯流排 

發電機輸出及端電壓資料如實際打開機組主斷路器前之機組狀況進行設定。 
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（3）輸入單機及無限匯流排間的變壓器 

但變壓器之電阻及電抗值則如下之設定。 

 
 

（4）建立電力潮流單線圖 

或直接開啟 Open Diagram -> Talin-G4.pfd 將電力潮流單線圖開啟。 
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（5）執行電力潮流計算 

Solution->Solve 執行電力潮流計算，調整無限匯流排之電壓，使發電機之虛功輸出符

合主斷路器開啟前之狀態。 

計算完後，File->Save Powerflow 儲存 Talin-G4-DX.pfb 檔或 Export 成 PTI 之電力潮流

格式 Talin-G4-DX.raw 檔，完成潮流基本案例。 

 

電力潮流基本案例檔案（Talin-G4-DX.raw） 
0, 100.0/RAWD VER 30 

THIS CASE WAS SETUP FOR MODELING Talin-G4-DX 

 

 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.9142,8.199487E-02,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.9635645,   0.0000,  1 

 0 

 0 
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 1104,'4 ',     2.017,     -72.205,   999.00,  -999.00,0.9142,8.199487E-02,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  
1, 1.0 

 20000,'1 ',     -2.017,     76.10685,   999.00,  -999.00,0.9635645,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     
0.00,  1, 1.0 

 0 

 0 

 20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 

  0.0,  0.0625 

1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 

 1.00000, 0. 

 0 

    1,     0,     0.00,     1.00,'Area 1      ' 

 0 / END OF AREA DATA 

 0 

 0 / END OF VSC 
 0 

 0 
 0 

 0 
    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 
0 

  1, 'Owner1      ' 
 0 /END OF OWNER DATA 

0 / 

 

Step2. 建立大林 4 號機 dyn 檔 

建立大林 4 號機 Talin-G4-PSSE.dyn 檔。 

TSAT 模擬所用之動態檔（Talin-G4-PSSE.dyn） 
/             I    T'do   T"do  T'qo  T"qo  H     D     Xd    Xq     X'd    X'q    X"d    Xl    S1.0    S1.2 

1104,'GENROU',4,   4.65,  0.06, 1.5,  .112, 4.45, 1.0,  1.62  1.42   .346,  .65,   .245,  .21,   0.167,  0.387 /Talin 4 Validating 

/1104,'GENROU',4,  4.17, .06,   1.5,  .112, 4.45, 1,     1.56, 1.42,  .393,  .8,   .306,  .21,  .07,    .28 /Talin 4 Existing 

/ 

/               Tr  Ka   Ta  Vrm   Vrn    Ke  Te     Kf   Tf 0  E1      S1  E2      S2 

/1104,'IEEET1',4,0, 400, .03, 3.5, -3.5, -.17, 1.025, .04, 1, 0, 3.365, .22, 4.487, .95/ Talin 4 Existing 

/ 

/             i j m k    t1  t2  t3  uo       uc      pmax pmin  t4   k1     k2  t5  k3     k4   t6  k5      k6  t7  k7  k8  

/1104 'IEEEG1' 4 0 0 9.3  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 4.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0   /Talin 4 - 

TurbineGovernor  Based on LR Test  

1104 'IEEEG1' 4 0 0 9.0  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 10.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0  /Talin 4 - 

TurbineGovernor  Based on Steam Chest TC Test  

/ 

/            I  IC1 IC2 M N Tw1 Tw2 T6  Tw3 Tw4 T7   Ks2   Ks3  T8    T9   Ks1  T1   T2   T3   T4   Vsmax  Vsmin 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.6   1   0.2  0.1   17.5 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as found settings (3 lead-lag blocks) 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.561 1   0.5  0.1   15.0 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as left settings  (3 lead-lag blocks) 

20000  'GENCLS'  1  9999.6   99.2 / 

/ 

/1104,'IEEET1',4,0,400,.03,3.5,-3.5,-.17,1.025,.04,1,0,3.365,.22,4.487,.95 / Existing 

/ 

/1104,'IEESGO',4,.22,0,.2,.2,5,.05,17,.75,1,.85,0 / Talin 4 Existing 

/ 

/                   TR     KA    TA    TK   TB     TC     Vamax   Vamin  Vrmax   Vrmin  TE    VFelim   KH    KHmax   

TH   TJ   KC     KD    KE    E1    SE1    E2    SE2               

/1104 'ESAC6A'  4    0.36   76   20.0  1.5  0.0167 0.75  7.1     -7.1   7.1   -7.1     0.75  40.0     0.0   75.0    0.0  0.0  0.173   

0.38  1.0   5.55  0.044  7.4   0.214 /  Model before AVR tuning 

/ 

1104 'ESAC6A'   4   0.02   165  20.0  1.5  0.0667  1.0   7.1    -6.1   7.1   -6.1    1.0   99.0     0.0   99.0    0.0  0.0  0.173   

0.39  1.0   5.55  0.044    7.4   0.214 / Model after tuning 5% and 10% 

/ 

/1104 'COMP'   4   -0.02 / 

/ 

/   TR    Kvp    Kvi  Vimax  TA    TB1   TC1  TB2   TC2    Vrmax   Vrmin  Kf   Tf   Tf1  Tf2 Fbf  KIP   KII  TP      

VFMAX   VFMIN   KH   KE   TE   KC     KD   E1   SE1    E2   SE2    FIMF      

/1104 'REXSYS'  4 0.02  165.0  0.0  999.0  0.05  20.0  1.5  0.01  0.75   7.1    -6.1    0.0  1.0  0.0  0.0 1.0  1.0   0.0  0.0067  7.1     

-6.1    0.0  1.0  0.85  0.173  0.39 5.55 0.044  7.4  0.214  0.0   / 

 

Step3. 利用 UDM 建立 DX 測試 Vf 之 UDM 檔 

建立 DX 測試 Vf 之 Talin-G4-DX-EXUDM.dat 檔。 

TSAT 模擬使用之 UDM 動態檔（Talin-G4-DX-EXUDM.dat） 
[DSA 7.0 UDM] 

/UD EXC STARTS 

1104,'EXCUDM','4 '/DEVICE IDENTIFICATION 

0/REMOTE BUS 

0 0 0/REMOTE BRANCH 

/BLOCK DATA STARTS 

1,'YREAD','DLB','udmyread','Talin-G4-DX-VF.txt'/ 
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2,'EMESOUT','E34',999.0,-999.0,1.0,0.0,0.0/ 

/BLOCK DATA ENDS 

1,2/BLOCK INTERCONNECTION 

1,'REF',1.0, 1,'TIME',1.0/BLOCK INPUT 

/UD ENDS 

 

Step4. 建立 TSA 執行檔 

建立大林 4 號機 Talin-G4.mon 檔、Talin-G4-DX.swi 檔及 Talin-G4-DX.tsa 檔。 

模擬所用之監測參數檔（Talin-G4.mon） 
[TSAT 7.X Monitor] 

 

{Additional Quantities} 

generator, Mechanical torque 

generator, Field current 

{End Additional Quantities} 

{Generator} 

1104, '4' 

{End Generator} 

 

{Bus} 

1104 

{End Bus} 

 

{UDM} 

1104, 'GOVUDM', '4', 'Gain' 

1104, 'GOVUDM', '4', 'YREAD' 

1104, 'GOVUDM', '4', 'T20' 

1104, 'PSSUDM', '4', 'YREAD' 

1104, 'PSSUDM', '4', 'TW1' 

1104, 'PSSUDM', '4', 'KS2  T7' 

1104, 'PSSUDM', '4', 'TW2' 

1104, 'PSSUDM', '4', 'TW3' 

1104, 'PSSUDM', '4', 'KS3' 

1104, 'PSSUDM', '4', 'T8 T9' 

1104, 'PSSUDM', '4', 'T9-2' 

1104, 'PSSUDM', '4', 'T9-3' 

1104, 'PSSUDM', '4', 'T9-4' 

1104, 'PSSUDM', '4', 'T9-5' 

1104, 'PSSUDM', '4', 'SUM2' 

1104, 'PSSUDM', '4', 'KS1' 

1104, 'PSSUDM', '4', 'T1 T2' 

1104, 'PSSUDM', '4', 'T3 T4' 

1104, 'PSSUDM', '4', 'VSTLIM' 

1104, 'EXCUDM', '4', 'SUM' 

1104, 'EXCUDM', '4', 'END E6' 

{End UDM} 

 

TSAT 模擬使用之開關檔（Talin-G4-DX.swi） 
DESCRIPTION DX TEST / 

SIMULATION FOR 35.71667 SECONDS / 

PLOT           4 STEPS / 

REPORT         10 STEPS / 

STEP SIZE      0.25 CYCLES / 

INTEGRATION    RK4 / 

At Time 2   Seconds 

Remove Line ; 20000; 1104 ;1  

NOMORE / 

END / 

 

TSAT 模擬之檔案（Talin-G4-DX.tsa） 
[TSAT 7.0] 

 

Output Files = Talin-G4-DX 

 

[Base Scenario] 
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{Scenario Description} 

Title = Talin-G4-DX 

Author = Liao Ching-Jung 

{End Scenario Description} 

 

{Scenario Parameters} 

Max generator speed deviation allowed = 0.5 

{End Scenario Parameters} 

 

{Powerflow Data} 

File = Talin-G4-DX.raw 

Format = PSS/E RAWD 30  

Solve Base Powerflow = YES 

{End Powerflow Data} 

 

{Dynamic Data} 

Format = PSS/E 

File =  Talin-G4-PSSE.dyn 

{End Dynamic Data} 

 

{Monitor Data} 

File = Talin-G4.mon 

{End Monitor Data} 

 

{Switching Data} 

File = Talin-G4-DX.swi 

{End Switching Data} 

 

[End Base Scenario] 

 

Step5. 執行模擬與擬合 

按 Run->Basecase Analysis 後執行模擬，並對模擬所得之發電機端電壓與實測之端電壓

進行擬合， 
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附錄附錄附錄附錄 2 大林大林大林大林 4 號發電機號發電機號發電機號發電機 Q 軸卸載測試軸卸載測試軸卸載測試軸卸載測試 

 

發電機交軸試驗用於驗證發電機交軸電抗值及時間常數。機組要先並聯入電力系統，

調整有效功率輸出及無效功率輸出使發電機電流與 Q 軸對準。在這種運行方式下發電

機電流僅有 Q 軸分量。在激磁系統使用手動控制模式時打開發電機組的主斷路器，發

電機機端電壓的變化受 Q 軸發電機電抗及時間常數的影響。這個測試結果要被用來推

導 Q 軸的暫態、次暫態阻抗和時間常數。 

大林 4 號發電機 Q 軸參數測試在實際打開機組主斷路器前，發電機的實際運行狀況如

下： 

• 有效功率輸出 55.77 MW  

• 無效功率輸出 -11.93 MVAr(欠勵) 

• 發電機端電壓 15.89 kV（15.89/17=0.9347 p.u.） 

Step 1. 先利用 PSAT 建立單機無限匯流排的基本架構 

（1）先建立單機無限匯流排 

（2）再建立單機匯流排 

發電機輸出及端電壓資料如實際打開機組主斷路器前之機組狀況進行設定。 

 

（3）輸入單機及無限匯流排間的變壓器 
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但變壓器之電阻及電抗值則如下之設定。 

 
 

（4）建立電力潮流單線圖 

直接開啟 Open Diagram -> Talin-G4.pfd 將電力潮流單線圖開啟。 
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（5）執行電力潮流計算 

Solution->Solve 執行電力潮流計算，調整無限匯流排之電壓，使發電機之虛功輸出符

合主斷路器開啟前之狀態。 

計算完後，File->Save Powerflow 儲存 Talin-G4-QX.pfb 檔或 Export 成 PTI 之電力潮流

格式 Talin-G4-QX.raw 檔，完成潮流基本案例。 

 

電力潮流基本案例檔案（Talin-G4-QX.raw） 
0, 100.0/RAWD VER 30 

THIS CASE WAS SETUP FOR MODELING Talin-G4-QX 

 

 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.93462,2.265649,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.9433339,   0.0000,  1 

 0 

 0 

 1104,'4 ',     55.767,     -11.928,   999.00,  -999.00,0.93462,2.265649,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  

1, 1.0 

 20000,'1 ',     -55.767,     14.25498,   999.00,  -999.00,0.9433339,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     

0.00,  1, 1.0 
 0 

 0 
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 20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 
  0.0,  0.0625 

1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 
 1.00000, 0. 

 0 

    1,     0,     0.00,     1.00,'Area 1      ' 

 0 / END OF AREA DATA 

 0 

 0 / END OF VSC 

 0 

 0 

 0 

 0 

    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 
0 

  1, 'Owner1      ' 
 0 /END OF OWNER DATA 

0 / 

 

Step2. 建立大林 4 號機 dyn 檔 

建立大林 4 號機 Talin-G4-PSSE.dyn 檔。 

TSAT 模擬所用之動態檔（Talin-G4-PSSE.dyn） 
/             I    T'do   T"do  T'qo  T"qo  H     D     Xd    Xq     X'd    X'q    X"d    Xl    S1.0    S1.2 

1104,'GENROU',4,   4.65,  0.06, 1.5,  .112, 4.45, 1.0,  1.62  1.42   .346,  .65,   .245,  .21,   0.167,  0.387 /Talin 4 Validating 

/1104,'GENROU',4,  4.17, .06,   1.5,  .112, 4.45, 1,     1.56, 1.42,  .393,  .8,   .306,  .21,  .07,    .28 /Talin 4 Existing 

/ 

/               Tr  Ka   Ta  Vrm   Vrn    Ke  Te     Kf   Tf 0  E1      S1  E2      S2 

/1104,'IEEET1',4,0, 400, .03, 3.5, -3.5, -.17, 1.025, .04, 1, 0, 3.365, .22, 4.487, .95/ Talin 4 Existing 

/ 

/             i j m k    t1  t2  t3  uo       uc      pmax pmin  t4   k1     k2  t5  k3     k4   t6  k5      k6  t7  k7  k8  

/1104 'IEEEG1' 4 0 0 9.3  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 4.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0   /Talin 4 - 

TurbineGovernor  Based on LR Test  

1104 'IEEEG1' 4 0 0 9.0  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 10.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0  /Talin 4 - 

TurbineGovernor  Based on Steam Chest TC Test  

/ 

/            I  IC1 IC2 M N Tw1 Tw2 T6  Tw3 Tw4 T7   Ks2   Ks3  T8    T9   Ks1  T1   T2   T3   T4   Vsmax  Vsmin 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.6   1   0.2  0.1   17.5 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as found settings (3 lead-lag blocks) 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.561 1   0.5  0.1   15.0 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as left settings  (3 lead-lag blocks) 

20000  'GENCLS'  1  9999.6   99.2 / 

/ 

/1104,'IEEET1',4,0,400,.03,3.5,-3.5,-.17,1.025,.04,1,0,3.365,.22,4.487,.95 / Existing 

/ 

/1104,'IEESGO',4,.22,0,.2,.2,5,.05,17,.75,1,.85,0 / Talin 4 Existing 

/ 

/                   TR     KA    TA    TK   TB     TC     Vamax   Vamin  Vrmax   Vrmin  TE    VFelim   KH    KHmax   

TH   TJ   KC     KD    KE    E1    SE1    E2    SE2               

/1104 'ESAC6A'  4    0.36   76   20.0  1.5  0.0167 0.75  7.1     -7.1   7.1   -7.1     0.75  40.0     0.0   75.0    0.0  0.0  0.173   

0.38  1.0   5.55  0.044  7.4   0.214 /  Model before AVR tuning 

/ 

1104 'ESAC6A'   4   0.02   165  20.0  1.5  0.0667  1.0   7.1    -6.1   7.1   -6.1    1.0   99.0     0.0   99.0    0.0  0.0  0.173   

0.39  1.0   5.55  0.044    7.4   0.214 / Model after tuning 5% and 10% 

/ 

/1104 'COMP'   4   -0.02 / 

/ 

/   TR    Kvp    Kvi  Vimax  TA    TB1   TC1  TB2   TC2    Vrmax   Vrmin  Kf   Tf   Tf1  Tf2 Fbf  KIP   KII  TP      

VFMAX   VFMIN   KH   KE   TE   KC     KD   E1   SE1    E2   SE2    FIMF      

/1104 'REXSYS'  4 0.02  165.0  0.0  999.0  0.05  20.0  1.5  0.01  0.75   7.1    -6.1    0.0  1.0  0.0  0.0 1.0  1.0   0.0  0.0067  7.1     

-6.1    0.0  1.0  0.85  0.173  0.39 5.55 0.044  7.4  0.214  0.0   / 

 

Step3. 利用 UDM 建立 DX 測試 Vf 之 UDM 檔 

建立 DX 測試 Vf 之 Talin-G4-QX-EXUDM.dat 檔。 

TSAT 模擬使用之 UDM 動態檔（Talin-G4-QX-EXUDM.dat） 
[DSA 7.0 UDM] 

/UD EXC STARTS 

1104,'EXCUDM','4 '/DEVICE IDENTIFICATION 

0/REMOTE BUS 

0 0 0/REMOTE BRANCH 

/BLOCK DATA STARTS 

1,'END E6','E6',1,1,0.214,0.044,7.4,0.173,0.39,0,20,0,1/ 

2,'YREAD','DLB','udmyread','Talin-G4-QX-VEF.txt'/ 

3,'SUM','SUM'/ 

/BLOCK DATA ENDS 

3,1, 2,3/BLOCK INTERCONNECTION 
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3,'REF',1.0, 2,'PT',1.0, 2,'TIME',1.0/BLOCK INPUT 

/UD ENDS 

 

Step4. 建立 TSA 執行檔 

建立大林 4 號機 Talin-G4.mon 檔、Talin-G4-DX.swi 檔及 Talin-G4-DX.tsa 檔。 

模擬所用之監測參數檔（Talin-G4.mon） 
[TSAT 7.X Monitor] 

 

{Additional Quantities} 

generator, Mechanical torque 

generator, Field current 

{End Additional Quantities} 

{Generator} 

1104, '4' 

{End Generator} 

 

{Bus} 

1104 

{End Bus} 

 

{UDM} 

1104, 'GOVUDM', '4', 'Gain' 

1104, 'GOVUDM', '4', 'YREAD' 

1104, 'GOVUDM', '4', 'T20' 

1104, 'PSSUDM', '4', 'YREAD' 

1104, 'PSSUDM', '4', 'TW1' 

1104, 'PSSUDM', '4', 'KS2  T7' 

1104, 'PSSUDM', '4', 'TW2' 

1104, 'PSSUDM', '4', 'TW3' 

1104, 'PSSUDM', '4', 'KS3' 

1104, 'PSSUDM', '4', 'T8 T9' 

1104, 'PSSUDM', '4', 'T9-2' 

1104, 'PSSUDM', '4', 'T9-3' 

1104, 'PSSUDM', '4', 'T9-4' 

1104, 'PSSUDM', '4', 'T9-5' 

1104, 'PSSUDM', '4', 'SUM2' 

1104, 'PSSUDM', '4', 'KS1' 

1104, 'PSSUDM', '4', 'T1 T2' 

1104, 'PSSUDM', '4', 'T3 T4' 

1104, 'PSSUDM', '4', 'VSTLIM' 

1104, 'EXCUDM', '4', 'SUM' 

1104, 'EXCUDM', '4', 'END E6' 

{End UDM} 

 

TSAT 模擬使用之開關檔（Talin-G4-DX.swi） 
DESCRIPTION QX TEST / 

SIMULATION FOR 30.98333 SECONDS / 

PLOT           4 STEPS / 

REPORT         10 STEPS / 

STEP SIZE      0.25 CYCLES / 

INTEGRATION    RK4 / 

At Time 0.96666   Seconds 

Remove Line ; 20000; 1104 ;1  

NOMORE / 

END / 

 

TSAT 模擬之檔案（Talin-G4-DX.tsa） 
[TSAT 7.0] 

 

Output Files = Talin-G4-QX 

 

[Base Scenario] 

 

{Scenario Description} 

Title = Talin-G4-QX 
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Author = Qiang Han 

{End Scenario Description} 

 

{Scenario Parameters} 

Max generator speed deviation allowed = 0.5 

{End Scenario Parameters} 

 

{Powerflow Data} 

File = Talin-G4-QX.raw 

Format = PSS/E RAWD 30  

Solve Base Powerflow = YES 

{End Powerflow Data} 

 

{Dynamic Data} 

Format = PSS/E 

File =  Talin-G4-PSSE.dyn 

File =  Talin-G4-QX-EXUDM.dat 

{End Dynamic Data} 

 

{Monitor Data} 

File = Talin-G4.mon 

{End Monitor Data} 

 

{Switching Data} 

File = Talin-G4-QX.swi 

{End Switching Data} 

 

[End Base Scenario] 

 

Step5. 執行模擬與擬合 

按 Run->Basecase Analysis 後執行模擬，並對模擬所得之發電機端電壓與實測之端電壓

進行擬合，藉由調整發電機交軸參數（T
’
q0、T

’’
q0）時間常數及電抗（Xq、X

’
q）使其

與實測曲線擬合。 
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附錄附錄附錄附錄 3 大林大林大林大林 4 號機電壓調整器步階響應測試號機電壓調整器步階響應測試號機電壓調整器步階響應測試號機電壓調整器步階響應測試 

 

電壓調整器步階響應測試用於驗證發電機激磁系統的模型及參數。試驗在發電機運行

在無載額定轉速時進行。發電機主斷路器保持在開路狀態。試驗的核心是在電壓調節

器的電壓參考點上施加一步階信號以觀察發電機機端電壓之變化。 

 

Step 1. 先利用 PSAT 建立單機無限匯流排的基本架構 

（1）先建立單機無限匯流排 

 

（2）再建立單機匯流排 

 

（3）輸入單機及無限匯流排間的變壓器 

 

（4）建立電力潮流單線圖 

或直接開啟 Open Diagram -> Talin-G4.pfd 將電力潮流單線圖開啟。 
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（5）執行電力潮流計算 

計算完後，File->Save Powerflow 儲存 Talin-G4-EX5.pfb 檔或 Export 成 PTI 之電力潮

流格式 Talin-G4-EX5.raw 檔，完成潮流基本案例。 

 

電力潮流基本案例檔案（Talin-G4-EX5.raw） 
0, 100.0/RAWD VER 30 

THIS CASE WAS SETUP FOR MODELING Talin-G4-EX5 

 

 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.936824,0,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.936824,   0.0000,  1 

 0 

 0 

 1104,'4 ',     0,     0,   999.00,  -999.00,0.936824,0,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  1, 1.0 

 20000,'1 ',     0,     0,   999.00,  -999.00,0.936824,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  1, 

1.0 

 0 
 0 

 20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 
  99.00000,9999.00000 

1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 
 1.00000, 0. 

 0 
    1,     0,     0.00,     1.00,'Area 1      ' 

 0 / END OF AREA DATA 
 0 

 0 / END OF VSC 

 0 
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 0 
 0 

 0 
    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 

0 

  1, 'Owner1      ' 

 0 /END OF OWNER DATA 

0 / 

 

Step2. 建立大林 4 號機 dyn 檔 

建立大林 4 號機 Talin-G4-PSSE.dyn 檔。 

TSAT 模擬所用之動態檔（Talin-G4-PSSE.dyn） 
/             I    T'do   T"do  T'qo  T"qo  H     D     Xd    Xq     X'd    X'q    X"d    Xl    S1.0    S1.2 

1104,'GENROU',4,   4.65,  0.06, 1.5,  .112, 4.45, 1.0,  1.62  1.42   .346,  .65,   .245,  .21,   0.167,  0.387 /Talin 4 Validating 

/1104,'GENROU',4,  4.17, .06,   1.5,  .112, 4.45, 1,     1.56, 1.42,  .393,  .8,   .306,  .21,  .07,    .28 /Talin 4 Existing 

/ 

/               Tr  Ka   Ta  Vrm   Vrn    Ke  Te     Kf   Tf 0  E1      S1  E2      S2 

/1104,'IEEET1',4,0, 400, .03, 3.5, -3.5, -.17, 1.025, .04, 1, 0, 3.365, .22, 4.487, .95/ Talin 4 Existing 

/ 

/             i j m k    t1  t2  t3  uo       uc      pmax pmin  t4   k1     k2  t5  k3     k4   t6  k5      k6  t7  k7  k8  

/1104 'IEEEG1' 4 0 0 9.3  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 4.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0   /Talin 4 - 

TurbineGovernor  Based on LR Test  

1104 'IEEEG1' 4 0 0 9.0  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 10.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0  /Talin 4 - 

TurbineGovernor  Based on Steam Chest TC Test  

/ 

/            I  IC1 IC2 M N Tw1 Tw2 T6  Tw3 Tw4 T7   Ks2   Ks3  T8    T9   Ks1  T1   T2   T3   T4   Vsmax  Vsmin 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.6   1   0.2  0.1   17.5 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as found settings (3 lead-lag blocks) 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.561 1   0.5  0.1   15.0 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as left settings  (3 lead-lag blocks) 

20000  'GENCLS'  1  9999.6   99.2 / 

/ 

/1104,'IEEET1',4,0,400,.03,3.5,-3.5,-.17,1.025,.04,1,0,3.365,.22,4.487,.95 / Existing 

/ 

/1104,'IEESGO',4,.22,0,.2,.2,5,.05,17,.75,1,.85,0 / Talin 4 Existing 

/ 

/                   TR     KA    TA    TK   TB     TC     Vamax   Vamin  Vrmax   Vrmin  TE    VFelim   KH    KHmax   

TH   TJ   KC     KD    KE    E1    SE1    E2    SE2               

/1104 'ESAC6A'  4    0.36   76   20.0  1.5  0.0167 0.75  7.1     -7.1   7.1   -7.1     0.75  40.0     0.0   75.0    0.0  0.0  0.173   

0.38  1.0   5.55  0.044  7.4   0.214 /  Model before AVR tuning 

/ 

1104 'ESAC6A'   4   0.02   165  20.0  1.5  0.0667  1.0   7.1    -6.1   7.1   -6.1    1.0   99.0     0.0   99.0    0.0  0.0  0.173   

0.39  1.0   5.55  0.044    7.4   0.214 / Model after tuning 5% and 10% 

/ 

/1104 'COMP'   4   -0.02 / 

/ 

/   TR    Kvp    Kvi  Vimax  TA    TB1   TC1  TB2   TC2    Vrmax   Vrmin  Kf   Tf   Tf1  Tf2 Fbf  KIP   KII  TP      

VFMAX   VFMIN   KH   KE   TE   KC     KD   E1   SE1    E2   SE2    FIMF      

/1104 'REXSYS'  4 0.02  165.0  0.0  999.0  0.05  20.0  1.5  0.01  0.75   7.1    -6.1    0.0  1.0  0.0  0.0 1.0  1.0   0.0  0.0067  7.1     

-6.1    0.0  1.0  0.85  0.173  0.39 5.55 0.044  7.4  0.214  0.0   / 

 

Step3. 建立 TSA 執行檔 

建立大林 4 號機 Talin-G4.mon 檔、Talin-G4-EX5.swi 檔及 Talin-G4-EX5.tsa 檔。 

模擬所用之監測參數檔（Talin-G4.mon） 
[TSAT 7.X Monitor] 

 

{Additional Quantities} 

generator, Mechanical torque 

generator, Field current 

{End Additional Quantities} 

{Generator} 

1104, '4' 

{End Generator} 

 

{Bus} 

1104 

{End Bus} 

 

{UDM} 

1104, 'GOVUDM', '4', 'Gain' 

1104, 'GOVUDM', '4', 'YREAD' 

1104, 'GOVUDM', '4', 'T20' 

1104, 'PSSUDM', '4', 'YREAD' 
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1104, 'PSSUDM', '4', 'TW1' 

1104, 'PSSUDM', '4', 'KS2  T7' 

1104, 'PSSUDM', '4', 'TW2' 

1104, 'PSSUDM', '4', 'TW3' 

1104, 'PSSUDM', '4', 'KS3' 

1104, 'PSSUDM', '4', 'T8 T9' 

1104, 'PSSUDM', '4', 'T9-2' 

1104, 'PSSUDM', '4', 'T9-3' 

1104, 'PSSUDM', '4', 'T9-4' 

1104, 'PSSUDM', '4', 'T9-5' 

1104, 'PSSUDM', '4', 'SUM2' 

1104, 'PSSUDM', '4', 'KS1' 

1104, 'PSSUDM', '4', 'T1 T2' 

1104, 'PSSUDM', '4', 'T3 T4' 

1104, 'PSSUDM', '4', 'VSTLIM' 

1104, 'EXCUDM', '4', 'SUM' 

1104, 'EXCUDM', '4', 'END E6' 

{End UDM} 

 

TSAT 模擬使用之開關檔（Talin-G4-EX5.swi） 
DESCRIPTION EX5 TEST / 

SIMULATION FOR 31.98333 SECONDS / 

PLOT           4 STEPS / 

REPORT         10 STEPS / 

STEP SIZE      0.25 CYCLES / 

INTEGRATION    RK4 / 

At Time 2.1   Seconds 

Change AVR Reference ;1104 ;4 0.044376 

At Time 14.016666   Seconds 

Change AVR Reference ;1104 ;4 -0.044376 

NOMORE / 

END / 

 

TSAT 模擬之檔案（Talin-G4-EX5.tsa） 
[TSAT 7.0] 

 

Output Files = Talin-G4-EX5 

 

[Base Scenario] 

 

{Scenario Description} 

Title = Talin-G4-EX5 

Author = Qiang Han 

{End Scenario Description} 

 

{Scenario Parameters} 

Max generator speed deviation allowed = 0.5 

{End Scenario Parameters} 

 

{Powerflow Data} 

File = Talin-G4-EX5.raw 

Format = PSS/E RAWD 30  

Solve Base Powerflow = YES 

{End Powerflow Data} 

 

{Dynamic Data} 

Format = PSS/E 

File =  Talin-G4-PSSE.dyn 

{End Dynamic Data} 

 

{Monitor Data} 

File = Talin-G4.mon 

{End Monitor Data} 

 

{Switching Data} 

File = Talin-G4-EX5.swi 

{End Switching Data} 

 

[End Base Scenario] 
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Step4. 執行模擬 

按 Run->Basecase Analysis 後執行模擬，並對模擬所得之發電機端電壓與實測之端電壓

進行比對。 
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附錄附錄附錄附錄 4 大林大林大林大林 4 號機號機號機號機無效功率電流補償測試無效功率電流補償測試無效功率電流補償測試無效功率電流補償測試 

 

線路壓降補償通常用來補償機組昇壓變壓器的部分阻抗並且調節發電機端之外的

某點的電壓。該補償也用於單一發電機經長輸電線接至系統或幾個並聯發電機共用一

台升壓變壓器的系統情形以解決無效功率在機組間的分配衝突。 

無效功率電流補償(電壓低垂，線路壓降補償)測試通過無效功率卸載來進行。發

電機主要帶無效功率，電壓調節器設置在自動方式。本測試在打開機組主斷路器前，

發電機的實際運行狀況如下： 

• 有效功率輸出 22.81 MW  

• 無效功率輸出 -74.86 MVAr(欠勵) 

• 發電機端電壓 15.53 kV 

 

Step 1. 先利用 PSAT 建立單機無限匯流排的基本架構 

（1）先建立單機無限匯流排 

 

 

（2）再建立單機匯流排 

發電機輸出及端電壓資料如實際打開機組主斷路器前之機組狀況進行設定。 

 

 

（3）輸入單機及無限匯流排間的變壓器 
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但變壓器之電阻及電抗值則如下之設定。 

 
 

（4）建立電力潮流單線圖 

或直接開啟 Open Diagram -> Talin-G4.pfd 將電力潮流單線圖開啟。 

 

 

（5）執行電力潮流計算 

Solution->Solve 執行電力潮流計算，調整無限匯流排之電壓，使發電機之虛功輸出符

合主斷路器開啟前之狀態。 

計算完後，File->Save Powerflow 儲存 Talin-G4-LDC.pfb 檔或 Export 成 PTI 之電力潮

流格式 Talin-G4-LDC.raw 檔，完成潮流基本案例。 

 

電力潮流基本案例檔案（Talin-G4-LDC.raw） 
0, 100.0/RAWD VER 30 

THIS CASE WAS SETUP FOR MODELING Talin-G4-LDC 



 - 160 - 

 
 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.9134,0.9270625,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.9647504,   0.0000,  1 
 0 

 0 

 1104,'4 ',     22.812,     -74.861,   999.00,  -999.00,0.9134,0.9270625,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  

1, 1.0 

 20000,'1 ',     -22.812,     79.4491,   999.00,  -999.00,0.9647504,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     

0.00,  1, 1.0 

 0 

 0 

 20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 

  0.0,  0.0625 

1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 

 1.00000, 0. 
 0 

    1,     0,     0.00,     1.00,'Area 1      ' 
 0 / END OF AREA DATA 

 0 
 0 / END OF VSC 

 0 
 0 

 0 
 0 

    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 

0 

  1, 'Owner1      ' 

 0 /END OF OWNER DATA 

0 / 

 

Step2. 建立大林 4 號機 dyn 檔 

建立大林 4 號機 Talin-G4-PSSE.dyn 檔。 

TSAT 模擬所用之動態檔（Talin-G4-PSSE.dyn） 
/             I    T'do   T"do  T'qo  T"qo  H     D     Xd    Xq     X'd    X'q    X"d    Xl    S1.0    S1.2 

1104,'GENROU',4,   4.65,  0.06, 1.5,  .112, 4.45, 1.0,  1.62  1.42   .346,  .65,   .245,  .21,   0.167,  0.387 /Talin 4 Validating 

/1104,'GENROU',4,  4.17, .06,   1.5,  .112, 4.45, 1,     1.56, 1.42,  .393,  .8,   .306,  .21,  .07,    .28 /Talin 4 Existing 

/ 

/               Tr  Ka   Ta  Vrm   Vrn    Ke  Te     Kf   Tf 0  E1      S1  E2      S2 

/1104,'IEEET1',4,0, 400, .03, 3.5, -3.5, -.17, 1.025, .04, 1, 0, 3.365, .22, 4.487, .95/ Talin 4 Existing 

/ 

/             i j m k    t1  t2  t3  uo       uc      pmax pmin  t4   k1     k2  t5  k3     k4   t6  k5      k6  t7  k7  k8  

/1104 'IEEEG1' 4 0 0 9.3  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 4.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0   /Talin 4 - 

TurbineGovernor  Based on LR Test  

1104 'IEEEG1' 4 0 0 9.0  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 10.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0  /Talin 4 - 

TurbineGovernor  Based on Steam Chest TC Test  

/ 

/            I  IC1 IC2 M N Tw1 Tw2 T6  Tw3 Tw4 T7   Ks2   Ks3  T8    T9   Ks1  T1   T2   T3   T4   Vsmax  Vsmin 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.6   1   0.2  0.1   17.5 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as found settings (3 lead-lag blocks) 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.561 1   0.5  0.1   15.0 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as left settings  (3 lead-lag blocks) 

20000  'GENCLS'  1  9999.6   99.2 / 

/ 

/1104,'IEEET1',4,0,400,.03,3.5,-3.5,-.17,1.025,.04,1,0,3.365,.22,4.487,.95 / Existing 

/ 

/1104,'IEESGO',4,.22,0,.2,.2,5,.05,17,.75,1,.85,0 / Talin 4 Existing 

/ 

/                   TR     KA    TA    TK   TB     TC     Vamax   Vamin  Vrmax   Vrmin  TE    VFelim   KH    KHmax   

TH   TJ   KC     KD    KE    E1    SE1    E2    SE2               

/1104 'ESAC6A'  4    0.36   76   20.0  1.5  0.0167 0.75  7.1     -7.1   7.1   -7.1     0.75  40.0     0.0   75.0    0.0  0.0  0.173   

0.38  1.0   5.55  0.044  7.4   0.214 /  Model before AVR tuning 

/ 

1104 'ESAC6A'   4   0.02   165  20.0  1.5  0.0667  1.0   7.1    -6.1   7.1   -6.1    1.0   99.0     0.0   99.0    0.0  0.0  0.173   

0.39  1.0   5.55  0.044    7.4   0.214 / Model after tuning 5% and 10% 

/ 

/1104 'COMP'   4   -0.02 / 

/ 

/   TR    Kvp    Kvi  Vimax  TA    TB1   TC1  TB2   TC2    Vrmax   Vrmin  Kf   Tf   Tf1  Tf2 Fbf  KIP   KII  TP      

VFMAX   VFMIN   KH   KE   TE   KC     KD   E1   SE1    E2   SE2    FIMF      

/1104 'REXSYS'  4 0.02  165.0  0.0  999.0  0.05  20.0  1.5  0.01  0.75   7.1    -6.1    0.0  1.0  0.0  0.0 1.0  1.0   0.0  0.0067  7.1     

-6.1    0.0  1.0  0.85  0.173  0.39 5.55 0.044  7.4  0.214  0.0   / 

 

Step3. 建立 TSA 執行檔 

建立大林 4 號機 Talin-G4.mon 檔、Talin-G4-LDC.swi 檔及 Talin-G4-LDC.tsa 檔。 

模擬所用之監測參數檔（Talin-G4.mon） 
[TSAT 7.X Monitor] 

 

{Additional Quantities} 
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generator, Mechanical torque 

generator, Field current 

{End Additional Quantities} 

{Generator} 

1104, '4' 

{End Generator} 

 

{Bus} 

1104 

{End Bus} 

 

{UDM} 

1104, 'GOVUDM', '4', 'Gain' 

1104, 'GOVUDM', '4', 'YREAD' 

1104, 'GOVUDM', '4', 'T20' 

1104, 'PSSUDM', '4', 'YREAD' 

1104, 'PSSUDM', '4', 'TW1' 

1104, 'PSSUDM', '4', 'KS2  T7' 

1104, 'PSSUDM', '4', 'TW2' 

1104, 'PSSUDM', '4', 'TW3' 

1104, 'PSSUDM', '4', 'KS3' 

1104, 'PSSUDM', '4', 'T8 T9' 

1104, 'PSSUDM', '4', 'T9-2' 

1104, 'PSSUDM', '4', 'T9-3' 

1104, 'PSSUDM', '4', 'T9-4' 

1104, 'PSSUDM', '4', 'T9-5' 

1104, 'PSSUDM', '4', 'SUM2' 

1104, 'PSSUDM', '4', 'KS1' 

1104, 'PSSUDM', '4', 'T1 T2' 

1104, 'PSSUDM', '4', 'T3 T4' 

1104, 'PSSUDM', '4', 'VSTLIM' 

1104, 'EXCUDM', '4', 'SUM' 

1104, 'EXCUDM', '4', 'END E6' 

{End UDM} 

 

TSAT 模擬使用之開關檔（Talin-G4-LDC.swi） 
DESCRIPTION LDC TEST / 

SIMULATION FOR 37.85 SECONDS / 

PLOT           4 STEPS / 

REPORT         10 STEPS / 

STEP SIZE      0.25 CYCLES / 

INTEGRATION    RK4 / 

At Time 7   Seconds 

Remove Line ; 20000; 1104 ;1  

NOMORE / 

END / 

 

TSAT 模擬之檔案（Talin-G4-LDC.tsa） 
[TSAT 7.0] 

 

Output Files = Talin-G4-LDC 

 

[Base Scenario] 

 

{Scenario Description} 

Title = Talin-G4-LDC 

Author = Qiang Han 

{End Scenario Description} 

 

{Scenario Parameters} 

Max generator speed deviation allowed = 0.5 

{End Scenario Parameters} 

 

{Powerflow Data} 

File = Talin-G4-LDC.raw 

Format = PSS/E RAWD 30  

Solve Base Powerflow = YES 

{End Powerflow Data} 

 

{Dynamic Data} 
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Format = PSS/E 

File =  Talin-G4-PSSE.dyn 

{End Dynamic Data} 

 

{Monitor Data} 

File = Talin-G4.mon 

{End Monitor Data} 

 

{Switching Data} 

File = Talin-G4-LDC.swi 

{End Switching Data} 

 

[End Base Scenario] 

 

Step4. 執行模擬 

按 Run->Basecase Analysis 後執行模擬，並對模擬所得之發電機端電壓與實測之端電壓

進行比對。 
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附錄附錄附錄附錄 5 部分負載卸載試驗部分負載卸載試驗部分負載卸載試驗部分負載卸載試驗 

 

部分負載卸載試驗用於驗證發電機組的慣性時間常數以及部分調速機模型參數。

在發電機帶部分負載，打開機組主斷路器後，發電機轉速的變化被用來驗證機組的慣

量及調速機的響應。由於前述 Q 軸參數試驗可以完全滿足上述要求。Q 軸參數試驗的

結果同時被用來驗證發電機組的慣性時間常數以及調速機的模型參數，以避免卸載試

驗對機組的衝擊。因此，本節描述的卸載試驗與 Q 軸參數試驗實際上為同一個試驗，

其發電機在打開主斷路器前的運行狀當然也與 Q 軸參數試驗完全相同。 

大林 4 號發電機 Q 軸參數測試在實際打開機組主斷路器前，發電機的實際運行狀

況如下： 

• 有效功率輸出 55.77 MW  

• 無效功率輸出 -11.93 MVAr(欠勵) 

• 發電機端電壓 15.89 kV（15.89/17=0.9347 p.u.） 

Step 1. 先利用先利用先利用先利用 PSAT 建立單機無限匯流排的基本架構建立單機無限匯流排的基本架構建立單機無限匯流排的基本架構建立單機無限匯流排的基本架構 

（1）先建立單機無限匯流排 

 

 

（2）再建立單機匯流排 

發電機輸出及端電壓資料如實際打開機組主斷路器前之機組狀況進行設定。 
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（3）輸入單機及無限匯流排間的變壓器 

但變壓器之電阻及電抗值則如下之設定。 

 
 

（4）建立電力潮流單線圖 

或直接開啟 Open Diagram -> Talin-G4.pfd 將電力潮流單線圖開啟。 

 

 

（5）執行電力潮流計算 

Solution->Solve 執行電力潮流計算，調整無限匯流排之電壓，使發電機之虛功輸出符

合主斷路器開啟前之狀態。 

計算完後，File->Save Powerflow 儲存 Talin-G4-LR.pfb 檔或 Export 成 PTI 之電力潮流

格式 Talin-G4-LR.raw 檔，完成潮流基本案例。 

 

電力潮流基本案例檔案（Talin-G4-LR.raw） 
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0, 100.0/RAWD VER 30 
THIS CASE WAS SETUP FOR MODELING Talin-G4-LR 

 
 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.935328,2.262253,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.9440342,   0.0000,  1 

 0 

 0 

 1104,'4 ',     55.767,     -11.928,   999.00,  -999.00,0.935328,2.262253,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  

1, 1.0 

 20000,'1 ',     -55.767,     14.25145,   999.00,  -999.00,0.9440342,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     

0.00,  1, 1.0 

 0 

 0 

 20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 

  0.0,  0.0625 
1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 

 1.00000, 0. 
 0 

    1,     0,     0.00,     1.00,'Area 1      ' 
 0 / END OF AREA DATA 

 0 
 0 / END OF VSC 

 0 
 0 

 0 

 0 

    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 

0 

  1, 'Owner1      ' 

 0 /END OF OWNER DATA 

0 / 

 

Step2. 建立大林建立大林建立大林建立大林 4 號機號機號機號機 dyn 檔檔檔檔 

建立大林 4 號機 Talin-G4-PSSE.dyn 檔。 

TSAT 模擬所用之動態檔（Talin-G4-PSSE.dyn） 
/             I    T'do   T"do  T'qo  T"qo  H     D     Xd    Xq     X'd    X'q    X"d    Xl    S1.0    S1.2 

1104,'GENROU',4,   4.65,  0.06,  1.5,   .112, 4.45, 1.0,  1.62  1.42   .346,  .65,   .245,  .21,   0.167,  0.387 /Talin 4 Validating 

/1104,'GENROU',4,  4.17,  .06,    1.5,  .112, 4.45, 1,     1.56, 1.42,  .393,  .8,   .306,  .21,  .07,    .28 /Talin 4 Existing 

/ 

/               Tr  Ka   Ta  Vrm   Vrn    Ke  Te     Kf   Tf 0  E1      S1  E2      S2 

/1104,'IEEET1',4,0, 400, .03, 3.5, -3.5, -.17, 1.025, .04, 1, 0, 3.365, .22, 4.487, .95/ Talin 4 Existing 

/ 

/             i j m k    t1  t2  t3  uo     uc      pmax pmin  t4   k1     k2  t5  k3     k4   t6  k5      k6  t7  k7  k8  

/1104 'IEEEG1' 4 0 0 9.3  0.1 0.0  0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 4.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0   /Talin 4 - 

TurbineGovernor  Based on LR Test  

1104 'IEEEG1' 4 0 0 9.0  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 10.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0  /Talin 4 - 

TurbineGovernor  Based on Steam Chest TC Test  

/ 

/            I  IC1 IC2 M N Tw1 Tw2 T6  Tw3 Tw4 T7   Ks2   Ks3  T8    T9   Ks1  T1   T2   T3   T4   Vsmax  Vsmin 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.6   1   0.2  0.1   17.5 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as found settings (3 lead-lag blocks) 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.561 1   0.5  0.1   15.0 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as left settings  (3 lead-lag blocks) 

20000  'GENCLS'  1  9999.6   99.2 / 

/ 

/1104,'IEEET1',4,0,400,.03,3.5,-3.5,-.17,1.025,.04,1,0,3.365,.22,4.487,.95 / Existing 

/ 

/1104,'IEESGO',4,.22,0,.2,.2,5,.05,17,.75,1,.85,0 / Talin 4 Existing 

/ 

/                   TR     KA    TA    TK   TB     TC     Vamax   Vamin  Vrmax   Vrmin  TE    VFelim   KH    KHmax   

TH   TJ   KC     KD    KE    E1    SE1    E2    SE2               

/1104 'ESAC6A'  4    0.36   76   20.0  1.5  0.0167 0.75  7.1     -7.1   7.1   -7.1     0.75  40.0     0.0   75.0    0.0  0.0  0.173   

0.38  1.0   5.55  0.044  7.4   0.214 /  Model before AVR tuning 

/ 

1104 'ESAC6A'   4   0.02   165  20.0  1.5  0.0667  1.0   7.1    -6.1   7.1   -6.1    1.0   99.0     0.0   99.0    0.0  0.0  0.173   

0.39  1.0   5.55  0.044    7.4   0.214 / Model after tuning 5% and 10% 

/ 

/1104 'COMP'   4   -0.02 / 

/ 

/   TR    Kvp    Kvi  Vimax  TA    TB1   TC1  TB2   TC2    Vrmax   Vrmin  Kf   Tf   Tf1  Tf2 Fbf  KIP   KII  TP      

VFMAX   VFMIN   KH   KE   TE   KC     KD   E1   SE1    E2   SE2    FIMF      

/1104 'REXSYS'  4 0.02  165.0  0.0  999.0  0.05  20.0  1.5  0.01  0.75   7.1    -6.1    0.0  1.0  0.0  0.0 1.0  1.0   0.0  0.0067  7.1     

-6.1    0.0  1.0  0.85  0.173  0.39 5.55 0.044  7.4  0.214  0.0   / 

 

Step3. 建立建立建立建立 TSA 執行檔執行檔執行檔執行檔 

建立大林 4 號機 Talin-G4.mon 檔、Talin-G4-LR.swi 檔及 Talin-G4-LR.tsa 檔。 

模擬所用之監測參數檔（Talin-G4.mon） 
[TSAT 7.X Monitor] 
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{Additional Quantities} 

generator, Mechanical torque 

generator, Field current 

{End Additional Quantities} 

{Generator} 

1104, '4' 

{End Generator} 

 

{Bus} 

1104 

{End Bus} 

 

{UDM} 

1104, 'GOVUDM', '4', 'Gain' 

1104, 'GOVUDM', '4', 'YREAD' 

1104, 'GOVUDM', '4', 'T20' 

1104, 'PSSUDM', '4', 'YREAD' 

1104, 'PSSUDM', '4', 'TW1' 

1104, 'PSSUDM', '4', 'KS2  T7' 

1104, 'PSSUDM', '4', 'TW2' 

1104, 'PSSUDM', '4', 'TW3' 

1104, 'PSSUDM', '4', 'KS3' 

1104, 'PSSUDM', '4', 'T8 T9' 

1104, 'PSSUDM', '4', 'T9-2' 

1104, 'PSSUDM', '4', 'T9-3' 

1104, 'PSSUDM', '4', 'T9-4' 

1104, 'PSSUDM', '4', 'T9-5' 

1104, 'PSSUDM', '4', 'SUM2' 

1104, 'PSSUDM', '4', 'KS1' 

1104, 'PSSUDM', '4', 'T1 T2' 

1104, 'PSSUDM', '4', 'T3 T4' 

1104, 'PSSUDM', '4', 'VSTLIM' 

1104, 'EXCUDM', '4', 'SUM' 

1104, 'EXCUDM', '4', 'END E6' 

{End UDM} 

 

TSAT 模擬使用之開關檔（Talin-G4-LR.swi） 
DESCRIPTION LR TEST / 

SIMULATION FOR 45.98333 SECONDS / 

PLOT           4 STEPS / 

REPORT         10 STEPS / 

STEP SIZE      0.25 CYCLES / 

INTEGRATION    RK4 / 

At Time 0.95   Seconds 

Remove Line ; 20000; 1104 ;1  

NOMORE / 

END / 

 

TSAT 模擬之檔案（Talin-G4-LR.tsa） 
[TSAT 7.0] 

 

Output Files = Talin-G4-LR 

 

[Base Scenario] 

 

{Scenario Description} 

Title = Talin-G4-LR 

Author = Qiang Han 

{End Scenario Description} 

 

{Scenario Parameters} 

Max generator speed deviation allowed = 0.5 

{End Scenario Parameters} 

 

{Powerflow Data} 

File = Talin-G4-LR.raw 

Format = PSS/E RAWD 30  

Solve Base Powerflow = YES 

{End Powerflow Data} 
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{Dynamic Data} 

Format = PSS/E 

File =  Talin-G4-PSSE.dyn 

{End Dynamic Data} 

 

{Monitor Data} 

File = Talin-G4.mon 

{End Monitor Data} 

 

{Switching Data} 

File = Talin-G4-LR.swi 

{End Switching Data} 

 

[End Base Scenario] 

 

Step4. 執行模擬執行模擬執行模擬執行模擬 

按 Run->Basecase Analysis 後執行模擬，並對模擬所得之發電機轉速與實測之發電機轉

速進行比對，利用 TSAT 模擬軟體修改 Talin-G4-PSSE.dyn 檔內發電機參數之慣性常數

H、調速機參數 k 值及調速機閥門之開關速度 Uc，所得到之發電機速度與實測值比較，

藉以擬合發電機速度之暫態響應進而修改上述之參數，以反應發電機組之實際狀況。

一般以先調整慣性常數 H 值，使其與發電機因卸載導致剛開始之速度反應曲線擬合

後；再進行調速機 k 值參數的調整，使其與發電機速度響應後段曲線進行擬合；最後

再對調速機的閥門開關速度參數 Uc 進行調整，使其與實測之響應曲線一致。 
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附錄附錄附錄附錄 6 蒸氣室蒸氣室蒸氣室蒸氣室(Steam chest)時間常數測試時間常數測試時間常數測試時間常數測試 

 

蒸氣室(Steam Chest)時間常數測試，或稱汽輪機時間常數試驗用於確定與汽輪機

各段相對應的時間常數。當機組在線運行並帶有較重的負載情況下，通過快速關閉進

氣閥開度限制器，測定汽機蒸汽壓力的變化和機組有效功率出力的響應來推測汽輪機

的時間常數 T4 ,T5 和 T6（見錯誤錯誤錯誤錯誤! 找不到參照來源找不到參照來源找不到參照來源找不到參照來源。。。。）。 

大林 4 號發電機蒸氣室(Steam Chest)時間常數測試在通過快速關閉進氣閥開度限

制器前，發電機的實際運行狀況如下： 

• 有效功率輸出 303 MW  

• 無效功率輸出 -5.55 MVAr(欠勵) 

• 發電機端電壓 15.897 kV（15.897/17=0.9351 p.u.） 

Step 1. 先利用 PSAT 建立單機無限匯流排的基本架構 

（1）先建立單機無限匯流排 

 

 

（2）再建立單機匯流排 

發電機輸出及端電壓資料如實際打開機組主斷路器前之機組狀況進行設定。 
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（3）輸入單機及無限匯流排間的變壓器 

但變壓器之電阻及電抗值則如下之設定。 

 
 

（4）建立電力潮流單線圖 

或直接開啟 Open Diagram -> Talin-G4.pfd 將電力潮流單線圖開啟。 

 

 

（5）執行電力潮流計算 

Solution->Solve 執行電力潮流計算，調整無限匯流排之電壓，使發電機之虛功輸出符

合快速關閉進氣閥開度限制器前之狀態。 

計算完後，File->Save Powerflow 儲存 Talin-G4-SCTC.pfb 檔或 Export 成 PTI 之電力潮

流格式 Talin-G4-SCTC.raw 檔，完成潮流基本案例。 

 

電力潮流基本案例檔案（Talin-G4-SCTC.raw） 
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0, 100.0/RAWD VER 30 
THIS CASE WAS SETUP FOR MODELING Talin-G4-SCTC 

 
 1104,'GEN         ',  13.80,2,     0.000,     0.000,   1,   1,0.93506,12.17426,  1 

 20000,'INF BUS     ', 230.00,3,     0.000,     0.000,   1,   1,0.9603649,   0.0000,  1 

 0 

 0 

 1104,'4 ',     303,     -5.546,   999.00,  -999.00,0.93506,12.17426,    442,   0.00150,   0.19200,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     0.00,  1, 

1.0 

 20000,'1 ',     -303,     71.19555,   999.00,  -999.00,0.9603649,  0.0000,   99999.00,   0.00000,   0.00100,   0.00000,   0.00000,1.00000,1,  100.0,   999.00,     

0.00,  1, 1.0 

 0 

 0 

 20000, 1104, 0,'1 ',1,1,1,   0.00000,   0.00000, 2,' ', 1,  1,1.0 

  0.0,  0.0625 
1.00000, 0,   0.000,   32.60,   32.60,   32.60,-1,   20000, 1.10000, 0.90000, 1.50000, 0.50000, 33,  0, 0., 0. 

 1.00000, 0. 
 0 

    1,     0,     0.00,     1.00,'Area 1      ' 
 0 / END OF AREA DATA 

 0 
 0 / END OF VSC 

 0 
 0 

 0 

 0 

    1,'ZONE-001    ' 

 0 / END OF ZONE DATA 

0 

  1, 'Owner1      ' 

 0 /END OF OWNER DATA 

0 / 

 

Step2. 建立大林 4 號機 dyn 檔 

建立大林 4 號機 Talin-G4-PSSE.dyn 檔。 

TSAT 模擬所用之動態檔（Talin-G4-PSSE.dyn） 
/             I    T'do   T"do  T'qo  T"qo  H     D     Xd    Xq     X'd    X'q    X"d    Xl    S1.0    S1.2 

1104,'GENROU',4,   4.65,  0.06, 1.5,  .112, 4.45, 1.0,  1.62  1.42   .346,  .65,   .245,  .21,   0.167,  0.387 /Talin 4 Validating 

/1104,'GENROU',4,  4.17, .06,   1.5,  .112, 4.45, 1,     1.56, 1.42,  .393,  .8,   .306,  .21,  .07,    .28 /Talin 4 Existing 

/ 

/               Tr  Ka   Ta  Vrm   Vrn    Ke  Te     Kf   Tf 0  E1      S1  E2      S2 

/1104,'IEEET1',4,0, 400, .03, 3.5, -3.5, -.17, 1.025, .04, 1, 0, 3.365, .22, 4.487, .95/ Talin 4 Existing 

/ 

/             i j m k    t1  t2  t3  uo       uc      pmax pmin  t4   k1     k2  t5  k3     k4   t6  k5      k6  t7  k7  k8  

/1104 'IEEEG1' 4 0 0 9.3  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 4.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0   /Talin 4 - 

TurbineGovernor  Based on LR Test  

1104 'IEEEG1' 4 0 0 9.0  0.1 0.0 0.2 0.025  -0.025   1.0   0.0   0.4  0.3811  0.0 10.5 0.1632 0.0  0.4 0.4557 0.0 0.0 0.0 0.0  /Talin 4 - 

TurbineGovernor  Based on Steam Chest TC Test  

/ 

/            I  IC1 IC2 M N Tw1 Tw2 T6  Tw3 Tw4 T7   Ks2   Ks3  T8    T9   Ks1  T1   T2   T3   T4   Vsmax  Vsmin 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.6   1   0.2  0.1   17.5 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as found settings (3 lead-lag blocks) 

/1104 'PSS2A' 4  1 0 3 0 5 1 5.0 5.0 0.0 5.0 0.0 4.99 0.561 1   0.5  0.1   15.0 0.2 0.04  0.2  0.04 0.1   -0.1   / Talin 4 - Stabilizer   T10 =0.16, 

T11 = 0.04  as left settings  (3 lead-lag blocks) 

20000  'GENCLS'  1  9999.6   99.2 / 

/ 

/1104,'IEEET1',4,0,400,.03,3.5,-3.5,-.17,1.025,.04,1,0,3.365,.22,4.487,.95 / Existing 

/ 

/1104,'IEESGO',4,.22,0,.2,.2,5,.05,17,.75,1,.85,0 / Talin 4 Existing 

/ 

/                   TR     KA    TA    TK   TB     TC     Vamax   Vamin  Vrmax   Vrmin  TE    VFelim   KH    KHmax   

TH   TJ   KC     KD    KE    E1    SE1    E2    SE2               

/1104 'ESAC6A'  4    0.36   76   20.0  1.5  0.0167 0.75  7.1     -7.1   7.1   -7.1     0.75  40.0     0.0   75.0    0.0  0.0  0.173   

0.38  1.0   5.55  0.044  7.4   0.214 /  Model before AVR tuning 

/ 

1104 'ESAC6A'   4   0.02   165  20.0  1.5  0.0667  1.0   7.1    -6.1   7.1   -6.1    1.0   99.0     0.0   99.0    0.0  0.0  0.173   

0.39  1.0   5.55  0.044    7.4   0.214 / Model after tuning 5% and 10% 

/ 

/1104 'COMP'   4   -0.02 / 

/ 

/   TR    Kvp    Kvi  Vimax  TA    TB1   TC1  TB2   TC2    Vrmax   Vrmin  Kf   Tf   Tf1  Tf2 Fbf  KIP   KII  TP      

VFMAX   VFMIN   KH   KE   TE   KC     KD   E1   SE1    E2   SE2    FIMF      

/1104 'REXSYS'  4 0.02  165.0  0.0  999.0  0.05  20.0  1.5  0.01  0.75   7.1    -6.1    0.0  1.0  0.0  0.0 1.0  1.0   0.0  0.0067  7.1     

-6.1    0.0  1.0  0.85  0.173  0.39 5.55 0.044  7.4  0.214  0.0   / 

 

Step3. 建立 TSA 執行檔 

建立大林 4 號機 Talin-G4.mon 檔、Talin-G4-SCTC.swi 檔及 Talin-G4-SCTC.tsa 檔。 

模擬所用之監測參數檔（Talin-G4.mon） 
[TSAT 7.X Monitor] 
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{Additional Quantities} 

generator, Mechanical torque 

generator, Field current 

{End Additional Quantities} 

{Generator} 

1104, '4' 

{End Generator} 

 

{Bus} 

1104 

{End Bus} 

 

{UDM} 

1104, 'GOVUDM', '4', 'Gain' 

1104, 'GOVUDM', '4', 'YREAD' 

1104, 'GOVUDM', '4', 'T20' 

1104, 'PSSUDM', '4', 'YREAD' 

1104, 'PSSUDM', '4', 'TW1' 

1104, 'PSSUDM', '4', 'KS2  T7' 

1104, 'PSSUDM', '4', 'TW2' 

1104, 'PSSUDM', '4', 'TW3' 

1104, 'PSSUDM', '4', 'KS3' 

1104, 'PSSUDM', '4', 'T8 T9' 

1104, 'PSSUDM', '4', 'T9-2' 

1104, 'PSSUDM', '4', 'T9-3' 

1104, 'PSSUDM', '4', 'T9-4' 

1104, 'PSSUDM', '4', 'T9-5' 

1104, 'PSSUDM', '4', 'SUM2' 

1104, 'PSSUDM', '4', 'KS1' 

1104, 'PSSUDM', '4', 'T1 T2' 

1104, 'PSSUDM', '4', 'T3 T4' 

1104, 'PSSUDM', '4', 'VSTLIM' 

1104, 'EXCUDM', '4', 'SUM' 

1104, 'EXCUDM', '4', 'END E6' 

{End UDM} 

 

TSAT 模擬使用之開關檔（Talin-G4-SCTC.swi） 
Description SCTC TEST 

Simulation 50.033001 Seconds 

Plot 4 Steps 

Report 10 Steps 

Step Size 0.25 Cycles 

Integration RK4 

At Time 11.8 Seconds 

Change Governor Reference ;1104 ; 4  -0.038 

Nomore 

/ 

END 

 

TSAT 模擬之檔案（Talin-G4-SCTC.tsa） 
[TSAT 8.0] 

 

Output Files = Talin-G4-SCTC-IEESGO 

 

[Base Scenario] 

 

{Scenario Description} 

Title = Talin-G4-SCTC  

Author = Qiang Han  

Date = Wednesday, December 09, 2009 10:48:07  

{End Scenario Description} 

 

{Scenario Parameters} 

Common MVA base = 100.000000  

Common frequency base = 60.000000  

Lower threshold voltage of nonlinear load = 0.700000  

upper threshold voltage of nonlinear load = 0.700000  

threshold value of zero impedance line = 0.000100  

Damping Threshold = 3.000000  
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Transient voltage drop threshold = 0.800000  

Transient voltage drop duration = 0.330000  

Transient voltage rise threshold = 2.000000  

Transient voltage rise duration = 10.000000  

Max generator speed deviation allowed = 0.500000  

Early termination check threshold = 1.000000  

Power limit search threshold = 20.000000  

FTD Convergence Tolerance for State Derivatives = 0.050000  

FTD Max time step length = 1000.000000  

FTD Min time between automatic switching events = 5.000000  

Contingency Ranking Tuning Parameter = 0.000000  

Lower frequency threshold for damping estimate = 0.200000  

Upper frequency threshold for damping estimate = 2.000000  

Trim threshold for damping estimate = 5.000000  

Damping Window Length = 5.000000  

Transient frequency drop threshold = 59.000000  

Transient frequency drop duration = 1.000000  

Transient frequency rise threshold = 61.000000  

Transient frequency rise duration = 1.000000  

Minimum rate of change of frequency = -3.000000  

Default Zone 1 Reach = 80.000000  

Default Zone 1 Center Distance = 40.000000  

Default Zone 2 Reach = 120.000000  

Default Zone 2 Center Distance = 60.000000  

Centerline Angle = 75.000000  

Zone 1 Relay Margin Threshold = 0.000000  

Zone 2 Relay Margin Threshold = 0.000000  

Lower Base KV for transient voltage checking = 1.000000  

Upper Base KV for transient voltage checking = 999.000000  

Minimum CCT Search Value = 0.500000  

Maximum CCT Search Value = 30.000000  

CCT Security Criterion = 5.000000  

CCT Search Threshold = 0.500000  

Unstable early termination check threshold = -20.000000  

Time Window Start For Early Termination = 1.000000  

Time Window End For Early Termination = 2.500000  

Simulation Length Override = 0.000000  

Integration Step Override = 0.000000  

Swing Margin Threshold For Stable Early Termination = 1.000000  

Swing Margin Threshold For Unstable Early Termination = -1.000000  

Solution option for generator swing equation = Power  

Automatic dynamic data correction = Yes  

Contingency Ranking Method = Margin PU  

Transient voltage violation checking = No  

FTD Max no. of iterations for Equation Solution = 40  

Sequence Network Computation Method = Classical  

Primary Source for Generator Impedance = Sequence Data  

Damping Calculation Enabled = No  

Transaction Analysis Search Method = Automatic  

Transient frequency violation checking = No  

Rate of change of frequency violation checking = No  

Default load model for real power = Current  

Default load model for reactive power = Impedance  

Use Relay Data For Relay Characteristic = No  

Use Impedance Angle As Centerline Angle = Yes  

Relay Margin Enabled = No  

Enforce Transient Stability For Transaction = Yes  

Enforce Damping For Transaction = Yes  

Enforce Voltage Violation For Transaction = Yes  

Enforce Frequency Violation For Transaction = Yes  

Enforce Rate Of Change Of Frequency For Transaction = Yes  

Enforce Relay Margin For Transaction = Yes  

Transient voltage checking as percentage of prefault voltage = No  

Per Contingency Transaction Limit Search = No  

Unit For CCT Calculation Parameters = Cycles  

Reverse Transfer Search = No  

Data Error Correction Level = 0  

Transient Stability Margin Algorithm = ANGLE  

Integration Method Override = NONE  

Island Count Threshold = 0  

Stability margin threshold = 0.000000  

Transient security index for base case analysis = MARGIN 

Early termination for base case analysis = No  

Early termination for transaction analysis = No  

Stability margin threshold for ranking = 0.000000 PU  

Stability margin threshold for ranking = 1 NUMBER  



 - 173 - 

CCT threshold for ranking = 0.100000 SECONDS  

CCT threshold for ranking = 1 NUMBER  

{End Scenario Parameters} 

 

{Powerflow Data} 

File = Talin-G4-SCTC.raw 

Format = PSS/E RAWD 30  

Parameter File =  

Solution File =  

Control Mode File =  

Solve Base Powerflow = YES 

{End Powerflow Data} 

 

{Dynamic Data} 

Format = PSS/E 

File = Talin-G4-PSSE.dyn 

{End Dynamic Data} 

 

{Dynamic Representation Data} 

File =  

{End Dynamic Representation Data} 

 

{Monitor Data} 

File = Talin-G4.mon 

{End Monitor Data} 

 

{Switching Data} 

File = Talin-G4-SCTC.swi 

Must-run File =  

Don't-run File =  

{End Switching Data} 

 

{Relay Data} 

File =  

{End Relay Data} 

 

{Transaction Data} 

Transfer File =  

Parameter File =  

Interface And Circuit File =  

Generator Capability File =  

Generator Coupling File =  

{End Transaction Data} 

 

{Sequence Network Data} 

File =  

Format = PSS/E 

{End Sequence Network Data} 

 

[End Base Scenario] 

 

 

Step4. 執行模擬 

按 Run->Basecase Analysis 後執行模擬，並對模擬所得之發電機實功輸出與實測之實功

輸出進行比對，擬合汽輪機的時間常數 T4 ,T5 和 T6。
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